
Administration

To Do List
The To Do List scans all M.Y.O.B. Accounting records looking for seven things:

1. Receivables due or overdue
2. Payables due or overdue
3. Recurring transactions (Checks, Deposits, G/J Transactions, or Paychecks) due or 

overdue
4. Recurring Sales
5. Recurring Purchase Orders
6. Expiring discounts on purchases
7. Pending sales and purchase orders
8. Items to be reordered or built
9. Overdue Contacts

Jobs List
A job is anything for which you want to produce a separate profit & loss statement.    It could be a simple 
project or a full-blown profit center.    Whenever you make an accounting entry to an income, cost of sales,
or expense account, you may (but are not required to) assign the amount to a job.

At any time, M.Y.O.B. Accounting can produce a profit & loss statement for a specific job.

Business Calendar
Note on your Business Calendar the days your office is closed.    Entries on your To Do List are moved up 
to the nearest previous business day.

To help you set your calendar, M.Y.O.B. Accounting notes the important dates for every month.    You can 
change this list.

Company Information
You are required to complete the company information before being allowed to use M.Y.O.B. Accounting

Note:    Make sure your fiscal year, last month in fiscal year, conversion month and number of accounting 
periods are correct before accepting the information.

Customize M.Y.O.B.
Use Customize M.Y.O.B. if you:

1. Want to switch the changeability status of your data file
2. Want to "lock" a period to prevent accidental posting
3. Want to decide when to print a session report
4. Want to show currency signs in screens and reports
5. Want to print invoices when recorded or purchase orders when placed in the pending file
6. Wish to save the location of your windows
7. Have a modem
8. Want your contact logs automatically updated
9. Want to use Timeslips Accounting Link with M.Y.O.B. Accounting
10. Want to change the fonts used in windows, reports, or forms
11. Want to add or edit passwords.

Set Up M.Y.O.B.
Set Up M.Y.O.B. is a helpful, interactive checklist of the steps needed to set up your General Ledger, 
Receivables and/or Payables.



To Do List

Note:    M.Y.O.B. Accounting looks at your Business Calendar when preparing the To Do List.    If a 
reminder (except for overdue receivables) falls on a non-business day, it is moved up to the previous 
business day. 

Receivables

M.Y.O.B. Accounting displays all your unpaid sales showing the Customers Name, the Invoice number 
(Inv. #), and the Balance Due.    Then it checks the original date of the sale, compares it to todays date, 
looks at the customers credit terms and calculates a Due Date.    A positive number of days in the 
Overdue column tells you how many days the receivable is overdue, a negative number means its not yet
due.

Click in the Action column to select an invoice to be included in the Mail Merge file (so that you can send 
Notices) created when you click Mail Merge.    Regardless of how many overdue invoices the customer 
has, only one Mail Merge record is created (with the total of all overdue invoices in the Overdue field.    
For more information on Mail Merge files see Chapter 7: Card File    Personalized Letters.

Click the arrow next to the Customer's name to zoom to the invoice.

Payables
M.Y.O.B. Accounting displays all your unpaid purchases showing the Vendors Name, the P.O. #, and the 
Balance Due.    Then it checks the original date of the purchase, compares it to todays date, then looks at
your credit terms with the vendor and calculates a Due Date.    A positive number in the Overdue column 
tells how long the payable is overdue.    A negative number means not yet due.
 
Click in the Action column to select any or all purchases.    When you click Pay Bills, M.Y.O.B. 
Accounting writes checks to pay those bills.

Click the arrow next to the vendor's name to go directly to Make a Payment. 

Recurring Transactions
This is a list of all your Recurring Transactions (Checks, Deposits, General Journal entries,    and 
Paychecks).    

For each Recurring Transaction, M.Y.O.B. Accounting lists the transactions Name, the Frequency, the 
date Last Posted, and calculates the date Next Due, adjusted for business holidays listed on the 
Business Calendar.

A negative number of days in the Overdue column    means the transaction is not yet due.    A positive 
number means its overdue.

Click in the Action column to select any or all transactions.    When you click Record, M.Y.O.B. 
Accounting records those transactions.

Click the arrow next to the transaction name to zoom to the transaction, readied for recording.    See 
recurring transactions

Recurring Sales
For each recurring invoice, M.Y.O.B. Accounting lists the customers Name, the Frequency, the date Last
Posted, and calculates the date the invoice is Next Due.

A negative number of days in the Overdue column    means the transaction is not yet due.    A positive 
number means its overdue.



Click in the Action column to select any or all invoices.    When you click Record, M.Y.O.B. Accounting 
records the selected invoices. 

Click the arrow next to the customer's name to go to the recurring invoice.    See recurring transactions

Recurring P.O.s
For each recurring purchase order, M.Y.O.B. Accounting lists the vendors Name, the Frequency, the date
Last Posted, and calculates the date the P.O. is Next Due.

A negative number of days in the Overdue column    means the transaction is overdue.    A positive 
number is the number of days until the P.O. should be written.

Click in the Action column to select any or all P.O.s.    When you click Record, M.Y.O.B. Accounting 
records the selected purchases. 

Click the arrow next to the vendor's name to go to the recurring P.O.    See recurring transactions

Expiring Discounts
If youve listed credit terms for any vendors which give you a discount for early payment, M.Y.O.B. 
Accounting searches your purchases and displays the Vendors Name, P.O. #, Due Date and the Balance
Due of any outstanding Payables that are within the discount days.

Click in the Action column to select any or all Expiring Discounts.    When you click Pay Bills, M.Y.O.B. 
Accounting will write checks to pay all the selected bills. 

Click the arrow next to the vendor's name to go directly to the Make a Paymentwindow.

Pending Sales or Purchase Orders
This is a list of all your Pending Sales and Purchases sorted by Shipping Date.    

If the transaction is a pending sale, the arrow is before the Name (under Inv.).    If its a pending purchase, 
the arrow is after the Name and before the Inv/P.O. # (under P.O.).    The Promised Date is the Shipping 
Date from each invoice or purchase.

Click in the Action column to select any or all pending sales or purchase orders.    When you click 
Record as Actual, M.Y.O.B. Accounting will record the sales or purchase orders. 

Click the arrow next to the Name to zoom to the pending invoice or purchase order.

Items to Order/Build
In the item information for an inventory item, you can enter a minimum desired Inventory level.    After 
every sale, M.Y.O.B. Accounting    calculates whether your Inventory has fallen below that minimum (the 
number of the item you have on hand plus the number already on order less the number promised to 
customers).    If the result is less than the Items Minimum Level, the Items Name, On Hand amount, on 
order amount and Committed amount are displayed on the To Do List.

Click the arrow to the left of the Item's name to zoom to a purchase order.    Click the arrow to the right of 
the Item's name to zoom to Auto-Build Inventory.

If youve set the Item as I Buy This Item in the Items List, the arrow is to the left of the Name (under 
Order).    If you auto-build this Item,    the arrow is to the right of Name (under Build).    For some items, 
you may, at times, both Buy the Item and Auto-Build it.    In this case, clicking the Action column has no 
effect.



If youve entered a Primary Vendor and Reorder Quantity in the Item information for I Buy This Item, 
M.Y.O.B. Accounting prepares most of the Purchase Order for you.    If you do not have a Primary Vendor,
clicking the arrow under Order zooms to Purchase Orders, but does not prepare the order.

Click in the Action column to select any or all items.    If an item is marked as only Order (and has a 
Primary Vendor listed) or only Build (and you have enough of the required components) when you click 
Order/Build, M.Y.O.B. Accounting will order, or build, those items.    Some items    in your items list may be 
marked as both Order and Build marked and will be ignored.

M.Y.O.B. Accounting scans the Pending File and displays the name, ID number, promised date and 
balance due.    Click the arrow next to the name to zoom to the pending invoice or purchase. 

Overdue Contacts
When you enter a Contact in your Contact Log, you may enter a Recontact date.    M.Y.O.B. Accounting 
displays the Name, Card Type, last Contact Date and the Recontact Date of anyone with a recontact 
date on or before today.

Click in the Action column to select any or all cards.    When you click Remove, M.Y.O.B. Accounting will 
erase the Recontact Date from the card.

Click the arrow next to the name to zoom to your Contact Log.



Jobs List

This is your list of jobs.    It shows the revenue, expenses and net profit or loss for the life of the job.    At 
any time you may print a profit and loss statement for any job.
Note:    If you have "profit centers", that is, parts of your business that have separate profit and loss 
responsibility, you can use the job list to track them.    To add a job to the list, click New Job.    To view or 
edit job information, double-click the job or single click it and click Edit Job.



Enter or Edit Jobs

Job Number
Enter a five character job number.    You can use numbers or letters to identify this job.    If you use letters, 
you should remember that they are case-sensitive; that is, a capital A is a different letter than a lower case
a.    So, job A1 is a different job than job a1. 

Job Name
Use up to 25 characters to name this job. 

Job Description
Use up to 255 characters to describe this job. 

Beginning Revenue
If you started this job before you began using M.Y.O.B. Accounting, enter the total revenue received up to 
your conversion month. 

Beginning Expense
If you started this job before you began using M.Y.O.B. Accounting, enter the total expenses incurred up 
to your conversion month. 

Deleting a Job
While the Job Information window is displayed, select Delete Job from the Edit menu. 

Note:    You cannot delete a job that has had transactions assigned to it, until those transactions are 
purged.



Business Calendar

The Business Calendar has three functions:
1. Reminders on your To Do List that would fall on a day your business is closed are moved 

up to the previous open day.
2. It provides an easy way to set your holidays for the upcoming year.
3. It provides space (Important Dates) to note important company events. 

Selecting a Month
The business calendar contains three calendar years - the year that contains the end of your current fiscal
year, the year before it and the year after it.    Use the arrows to select a month.    The left arrow moves 
back in time one month.    The right arrow moves one month ahead. 

Important Dates
M.Y.O.B. Accounting provides a list of holidays, etc.    It is for your information only.    You may edit this list.

Changing the Status of a Day
Closed days are shaded; open days are not.    Click on a day to change its status. 

Shortcut for Setting Average Business Week
The shortcut panel displays the days of the week.    Changing the status of a day in the shortcut panel 
changes the status of that day throughout the 3-year business calendar.    You are warned, and have the 
opportunity to back out, before M.Y.O.B. Accounting executes the change. 



Company Information

Company Information can be found in the Administration Menu or in Set Up M.Y.O.B.

Company Name
Enter your company's name, up to 40 characters.    It is displayed on the Command Centers, and (at your 
option) printed atop M.Y.O.B. reports. 

Address
Enter your company's address.    It is used by M.Y.O.B. Accounting on invoices and purchase orders.

Phone Number
Enter your company's phone number. 

Federal Tax ID
Enter your company's federal tax identification number. 

State Tax ID
Enter your company's state tax identification number. 

Current Fiscal Year
Current Fiscal Year is your current accounting year.    M.Y.O.B. Accounting sets the default current fiscal 
year to the current calendar year (most are) and sets the last month of your fiscal year to December.    If 
yours are different, change them.    If you're not sure what they are, check with your accountant before 
continuing. 
Note:    The first time you click Record in Company Information, the current fiscal year is set and cannot 
be changed.    

Last Month in Fiscal Year
This tells M.Y.O.B. Accounting how to organize the months in your fiscal year.    Your fiscal year probably 
ends in December, but if you're not sure, check with your accountant. 
Note:    The first time you click Record in Company Information, the last month of your fiscal year is set 
and cannot be changed.      

Conversion Month
The Conversion Month is the month for which you want to start entering data.    It does not have to be the 
current month.    If, for example, you set the conversion month to May, M.Y.O.B. Accounting will ask you 
for the Opening Balances of your accounts as of the start of business May 1 (which are the same as the 
ending balances on April 30 financial statements). 
Note:    You will not be able to enter any transactions dated before your conversion month.    
Note:    The first time you click Record in Company Information , the conversion month is set and cannot 
be changed.    If youve entered an incorrect conversion month and have recorded the company 
information, you must start a new data file to correct it. 

Accounting Periods per Year
Most people use only 12 accounting periods.    A few businesses use a 13th period to make year-end 
adjustments, so their adjustments will not affect any one period.    Most just enter their year-end 
adjustments on the last day of their fiscal year.    If you select 13 periods, M.Y.O.B. Accounting still 
segregates your data by the 12 calendar months, and then adds an extra period.    To enter a transaction 
in the 13th period put an asterisk (*) before the date.    Example:    A date of 1/1/90 places the transaction 
in January.    A date of *1/1/90 places the transaction in the 13th period.    January's financial reports 
remain unaffected by the entry.    This feature allows you to use the actual date of the transaction for audit 
purposes, yet have it accounted for in the 13th period. 
Note:    If you accidentally select 13 periods and then record your Company Information, you cannot 
change it back until you start a new fiscal year.    But remember, having 13 periods is not a serious 
problem, because youre not required to record any transactions in that period.    When you're satisfied 



with the information you've entered for your company click Record. 

Select Set Up M.Y.O.B. from the Administration command center.    Click the radio button next to Set Up 
General Ledger.

Click the arrow to the left of Company Information and enter your company information, using the 
instructions that follow.



Customize M.Y.O.B.

This Data File is...
Choose whether your records are Unchangeable or Changeable.

Unchangeable.    Saved entries cannot be changed, they must be reversed.    Reversing is the process of
creating a new entry that is the exact opposite of an original, mistaken entry.    The reversing entry offsets 
the original entry thereby canceling out its effect on your books.    Some people prefer to keep their 
records unchangeable so they can see a trail (sometimes called an "audit trial") of their mistakes and 
corrections.

(Remember, even if you choose Unchangeable, prior to saving your changes to your hard disk, they are 
changeable.)

Changeable.
Entries - whether saved or not - are changeable.

Note:    Inventory entries - adjustments and transfers - are not changeable.    To correct a mistaken 
inventory entry you must enter an adjusting entry.

Lock Periods
This is one more helpful feature of M.Y.O.B. Accounting    Select a period from the popup menu, and 
M.Y.O.B. Accounting prevents you from mistakenly entering a transaction dated in or before that period.

This selection does not close the period, erase transactions or prevent you from ever recording a 
transaction.    It just helps prevent mistakes.    You may change this selection at any time.

If you are prevented from entering a valid transaction, select Customize M.Y.O.B. Accounting and change 
the selected period to an earlier period.

Note:    If you record a transaction in a prior period, your financial statements (balance sheet, income 
statement, trial balance, etc.) for that month and all succeeding months may be affected.    You may want 
to reprint them.

Prompt for a Session Report...
M.Y.O.B. Accounting produces a session report.    It is a report of your journal activity during the current 
session.    You can choose when to be prompted for a session report.

Upon Saving.    This selection prompts you for a session report every time you choose Save from the File
menu.

Note:    If you choose the session report upon saving, the save function is aborted.      The report will show 
all journal activity since you last saved.      After the report is printed, again choose Save from the File 
menu, and this time click Save, No Report.

Upon Quitting.    This selection waits until you choose Quit, Open or New from the File menu before 
prompting for a session report.

Note:    If you choose the session report upon quitting, your selection (Quit, Open or New) is aborted.      
The report will show all journal activity since opening the data file.      After the report is printed, again 
choose Quit, Open or New from the File menu, and this time click Quit (Open, New), No Report.

Show Currency Signs in Screens
Check this selection to display the currency ($, £, etc.) sign when entering or displaying currency data on 
the screen.



Show Currency Signs in Reports
Check this selection to display the currency ($, £, etc.) sign in printed or displayed reports and forms.

Print Invoice Upon Recording
If you are using M.Y.O.B. Accounting as a point of sale system, check this selection.    Make sure you 
have your invoice forms in your printer.    Whenever you click Record as an Actual Sale, M.Y.O.B. 
Accounting prints the invoice.

Print PO When Placed in Pending
If you send purchase orders to your vendors, check this selection and M.Y.O.B. Accounting automatically 
prints your purchase order whenever you click Pending File.

Save Window Sizes and Locations
Check this selection and M.Y.O.B. Accounting remembers where you last positioned every window on 
your screen.    Dialog boxes, however, are always centered.

I Have a Modem for Autodialing

Check this selection if you have a modem and wish to use M.Y.O.B. Accounting's phone icon for 
autodialing (see Phone Icon in Card File Entry).    Select to which COM port your modem is connected.    
M.Y.O.B. Accounting supports COM1 through COM4.

Make a Contact Log for Every...
Check.    Check this selection and whenever you write a check that is linked to a card, a record is written 
in that card's contact log.

Deposit.    Check this selection and whenever you make a deposit that is linked to a card, a record is 
written in that card's contact log.

Sale.    Check this selection and whenever you record a sale (Other Sales, Invoice Sales) that is linked to 
a card, a record is written in that card's contact log.

Note:    Records are written for actual sales, not pending sales.

Purchase.    Check this selection and whenever you record a purchase (Other Purchases, Purchase 
Orders) that is linked to a card, a record is written in that card's contact log.

Note:    Records are written for actual purchases, not pending purchases.

Default Fonts
You can change the default font for every report or form in M.Y.O.B. Accounting    You also may change 
the font used when displaying an M.Y.O.B. Accounting window.    Choose Default Fonts from the File 
menu or click the Fonts button at the bottom of the Customize M.Y.O.B. Accounting window.

Note:    Previously customized reports or forms are NOT affected by the Default Fonts function.    

When you choose a default font, every field is changed to the default font.    If, for example, you want the 
report headers in a different font than the body of the report, you must customize the report individually.

When you choose a default font, M.Y.O.B. Accounting displays the font and calculates the approximate 
number of columns that will fit on a printed page (using your current Page Setup selections).    The widest 
M.Y.O.B. Accounting report is 106 columns.    If the calculated number of columns is less than 106, some 
reports may not fit on a printed page.    If a report does not fit, you must either change your Page Setup to 
a wider page or choose a narrower (or smaller) font.

Passwords



If you wish to protect your M.Y.O.B. Accounting data with passwords, you may create one master 
password and an unlimited number of sub-passwords.    The owner of the master password assigns and 
changes sub-passwords. Owners of sub-passwords are not allowed to access selected functions.    The 
disallowed functions are selected by the owner of the master password.    See Password Access.



Password Access

Choose Customize M.Y.O.B. from the Administration command center and click on the Password button.

Master Password.    If you do not yet have a master password, you can enter one.    If you've previously 
entered a master password, you are asked to enter your existing password before continuing.

The first password on the list is the master password.    It has access to all M.Y.O.B. Accounting functions. 
The master password may not have any restricted functions.    To change the master password, select it 
from the list and click Edit.    To delete the master password, select it from the list and click Delete.    You 
must delete all sub-passwords before you may delete the master password.    The New button applies 
only to sub-passwords.    You may have only one master password.

Sub-password.    To add a new sub-password, click New.    The password may be up to 10 characters.    
M.Y.O.B. Accounting does not distinguish between upper and lower case when checking passwords.

To restrict a sub-password's access, select it from the list and click in the Not Allowed column next to the 
restricted function.    Notice that the restricted functions are displayed in a 3-level list.    The levels are 
provided as a short-cut feature.    Restricting    a level 1 function restricts all level 2 and level 3 functions 
underneath it.    For example, if you wish to prevent someone from accessing every function in the 
General Ledger command center, simply click General Ledger at level one.

See Also
Customize M.Y.O.B.



Enter Password

If you wish to protect your M.Y.O.B. Accounting data with passwords, you may create one master 
password and an unlimited number of sub-passwords.    The owner of the master password assigns and 
changes sub-passwords. Owners of sub-passwords are not allowed to access selected functions.    The 
disallowed functions are selected by the owner of the master password.    If access to a protected function
is attempted, you will be prompted to enter a passowrd.    You are required to enter your password before 
continuing.

See Also
Password Access
Customize M.Y.O.B.



Set Up M.Y.O.B.

Set Up M.Y.O.B. is an interactive checklist for getting started in M.Y.O.B. Accounting    It can be found in 
the Administration Command Center. 

Note:    The file called "readme.txt" contains a list of Late-Breaking Changes - improvements in the 
program, and changes (if any) to the document.    Open it in the Windows Notepad to read it before 
getting started.

For more information on setting up M.Y.O.B. Accounting, see Chapter 3 of the Getting Started booklet.



Card File

Card File Entry
Use Card File Entry to enter new information about your customers, vendors, employees and personal 
contacts.

View Card File
Use View Card File to view and edit your customers, vendors, employees and personal contacts.

Contact Log Entry
The Contact Log in M.Y.O.B. Accounting is designed to handle your client support needs.    Use it to note 
every time you call, meet, bill or otherwise contact someone from your card file.

The contact log tracks elapsed time.    If you bill your time, you'll find it especially useful.

View Contact Log
Use View Contact Log to display your contacts for a selected card.

Identifiers
An identifier is a letter you can assign to your cards.    For example, give all prospects a "P", or use "C" for
your Christmas card list.    M.Y.O.B. Accounting's Identifiers selection lets you give names to these one-
letter identifiers to help you remember what they mean.

Mailing Labels
Use Mailing Labels to print mailing labels for selected cards.

Personalized Letters
Use Personalized Letters to create a mail merge file with information taken from selected cards.



Card File Entry

Card Type
Use the pop-up menu to choose the card type.    The card type must be Customer, Vendor, Employee or 
Personal.    Before you can record a sale in the Sales & Receivables Command Center, you must have 
the customer's card on file.    Likewise, before you can record a purchase in the Purchases & Payables 
Command Center, you must have the vendor's card on file. 

Note:    If you do not track individual customers, create customer cards called "Cash", "MasterCard", etc.   
If you do not track individual vendors, create vendor cards with similar names.

Name
The card file is kept in alphabetical order by company name for companies and by last name for 
individuals.    Click the appropriate radio button, enter the name, and press Tab. 

Address
This is the address for mailing labels.    It is also the address on checks sent to vendors and the billing 
address for customers.    Enter it and press Tab. 

Zip Code
Enter the zip code for this address.    When displaying or reporting on your cards, you can select by zip 
code.

Residence Code (Employee)
You must enter the employee's Residence Code before writing a Paycheck with M.Y.O.B. Payroll.    The 
Residence Code is used to determine the employee's state and/or local income tax.    A list allows you to 
select the proper tax code for the employee's State and (if applicable) Local residence.

Work Code (Employee)
You must enter the employee's Work Code before writing a Paycheck with M.Y.O.B. Payroll.    The Work 
code is used to determine the work state for State Unemployment and/or Disability taxes (and Employer 
Expenses, if any). 

For more information on Employee cards and M.Y.O.B. Payroll see Employee Payroll Information.
Ship to or Second Address (Customers and Vendors)
Enter the Ship to Address and M.Y.O.B. Accounting prints it on the customer's invoice.    In the invoice 
window you have the opportunity to override this address (if, for example, the customer has more than 
one shipping address).    Enter the Second Address for a vendor.    This is for your information only. 

Note:    If the Ship To address is the same as the Billing address don't enter it.    M.Y.O.B. Accounting uses
the Billing address if the Ship To address is blank. 

Phone Number (#1, #2 and Fax)
Enter the phone number.    If you have a modem and are using M.Y.O.B. Accounting's auto-dial feature, 
enter a comma for a 2-second delay.    Enter a 'P' before the number if you need pulse dialing. 

Note:    When autodialing the modem, M.Y.O.B. Accounting ignores hyphens and parentheses.    You may 
enter "(201)-555-1212".    The extra characters do not affect autodialing. 

Identifiers
There are 26 one-letter identifiers - A to Z.    You may assign any meaning to an identifier.    All those on 
your Christmas card list could be 'C'.    Clients that love golf could be 'G'.    M.Y.O.B. Accounting allows you
to select and report (including mailing labels) by identifier.    Click the arrow to enter identifier descriptions. 
The descriptions do not affect M.Y.O.B. Accounting's records; theyre for your information only. 



Salutation
If you plan to use M.Y.O.B. Accounting's mail-merge capabilities, the salutation field helps you personalize
your correspondence.    Enter "Bill" for Mr. William T. Smith III and your letters will begin, "Dear Bill...".

Contact Name (Customer and Vendors)
If there's a particular person with whom you correspond, enter him as the contact.    If youre using 
M.Y.O.B. Accounting's mail-merge capabilities, you can direct a letter to the contact's attention. 

Notes
Use this field to enter additional information about this card. 

The Phone Icon
In Customize M.Y.O.B. ( in the Administration Command Center), you can note that you have a modem 
connected to your computer.    If you do, when you click the phone icon, M.Y.O.B. Accounting uses your 
modem to get a dial tone and dial the phone number of the selected card. 

A/R Balance (Customer)
This is the current total of outstanding receivables for this customer.    Click the arrow and M.Y.O.B. 
Accounting zooms to Analyze Receivables with this customer already selected. 

A/P Balance (Vendor)
This is the current total of outstanding payables due to this vendor.    Click the arrow and M.Y.O.B. 
Accounting zooms to Analyze Payables with this vendor already selected. 

Track Sales History (Customer and Employee)
Check Track Sales History if you want M.Y.O.B. Accounting to keep monthly sales totals for this customer 
(or by this salesperson).    Totals are collected for both last year and this year.    Use Analyze Sales in the 
Sales & Receivables Command Center to review the collected totals.    If the box is checked, the Sales 
History button is black.    Click it to enter historical sales figures. 
Note:    Tracking sales history takes up considerable disk space.    If you do not care to track sales for a 
particular card, make sure the box is unchecked. 

Tax and Credit Terms (Customer)

Payment is Due...    Choose C.O.D., Prepaid, In a Given Number of Days, or On a Day of the Month.    If 
you choose In a Given Number of Days, M.Y.O.B. Accounting calculates the due date and prompt 
payment discount date (if any) based on the number of days since the invoice date.    If you choose On a 
Day of the Month, M.Y.O.B. Accounting calculates the due date and prompt payment discount date (if 
any) by combining the month of the invoice date with the day of the month specified in the next two 
selections.

Note:    You can set default credit terms in Set Up Receivables (see Set Up Receivables in Chapter 3 of 
the Getting Started pamphlet).    All new cards assume the default terms. You can override them on a 
card-by-card basis.

Discount Days/Date.    If you specified that payment is due in a given number of days, enter the number 
of days for which the discount applies.    If, for example, the customers terms are 2% 10 days, net 30 
days, the discount days are 10.    If payment is recorded in Discount Days or less, M.Y.O.B. Accounting 
calculates the discount.    Remember, you can override the calculated discount.
If you specified that payment is due on a day of the month, choose the day of the month.    M.Y.O.B. 
Accounting calculates the discount if payment is entered on or before this date.    EOM stands for "end of 
month."

Balance Due Days/Date.    If you specified that payment is due in a given number of days, enter the 
number of days (from the day of the sale) allowed for the payment of the balance.    If you post finance 



charges, M.Y.O.B. Accounting calculates them beginning [Balance Due Days + 1].    When the balance 
becomes due, an overdue receivable reminder appears in your To Do List.
If you specified that payment is due on a day of the month, choose the day of the month.    M.Y.O.B. 
Accounting calculates the finance charge beginning the day after the due date.    EOM stands for "end of 
month."

Tax and Credit Terms (Vendor)

Payment is Due...    Choose C.O.D., Prepaid, In a Given Number of Days, or On a Day of the Month.    If 
you choose In a Given Number of Days, M.Y.O.B. Accounting calculates the due date and prompt 
payment discount date (if any)    based on the number of days since the purchase date.    If you choose 
On a Day of the Month, M.Y.O.B. Accounting calculates the due date and prompt payment discount date 
(if any) by combining the month of the purchase date with    the day of the month specified in the next two 
selections.

Discount Days/Date.    If you specified that payment is due in a given number of days, enter the number 
of days for which the discount applies.    If, for example, the vendors terms are 2% 10 days, net 30 days, 
the discount days are 10.    If payment is recorded in Discount Days or less, M.Y.O.B. Accounting 
calculates the discount.    Remember, you can override the calculated discount.
If you specified that payment is due on a day of the month, choose the day of the month.    M.Y.O.B. 
Accounting calculates the discount if payment is entered on or before this date.    EOM stands for "end of 
month."
An alert for expiring discounts is given in the To Do List.

Balance Due Days/Date.    If you specified that payment is due in a given number of days, enter the 
number of days (from the day of the purchase) allowed for the payment of the balance.    When the 
balance becomes due, an overdue payable reminder appears in your To Do List.
If you specified that payment is due on a day of the month, choose the day of the month.    EOM stands 
for "end of month."



Card File Display

Search for a Card
Use this field for to search for a specific card in the displayed list.    Type in a few characters of the card 
name and press Tab.    M.Y.O.B. Accounting searches the displayed list of cards and selects the card that 
most closely matches . 

Note:    M.Y.O.B. Accounting searches the list of displayed cards.    If you cannot find the card you're 
searching for, check the selection criteria at the bottom of the window. 

Display Criteria
Your cards are displayed alphabetically.    There are five criteria you can use to customize your card 
display:

1. Card Type.    Use the Card Type popup menu to display all cards or limit your display to just 
customers, vendors, employees or personal cards.

2. Identifier.    Enter up to 26 identifiers and press Tab.    M.Y.O.B. Accounting displays any card
that has every identifier entered.    Take, for example, a card that has the identifiers AB.    If 
you enter A and press Tab, it is included in the list.    Enter AB and it is included again.    
Enter ABC and it is not included.

3. Last Contact Date.    This is the date of the most current contact log entry.    Enter a date and
press Tab.    All entries in your card file that have not been contacted since that date are 
displayed in alphabetical order.

4. Recontact Date On or Before.    Enter a date and press Tab.    M.Y.O.B. Accounting looks 
through your contact log and displays all cards with recontact dates on or before the date 
entered.    Note:    To get the best use out of this feature, when you recontact the person, 
remember to delete the recontact date from the contact log entry.    If you leave old recontact
dates in your contact log, the card will always match this selection criterion. 

5. Zip Code.    M.Y.O.B. Accounting searches the zip codes for the card's primary (first) 
address.    You may enter a partial zip code search.    If you need, for example, to search for 
cards in northern New Jersey, enter \07.\    All cards with zip codes beginning with \07\ are 
displayed.

New Card
Click New Card to go to Card File Entry. 

Edit a Card
Click the white arrow or double-click the line to zoom to the card. 

Delete a Card
Single click a line to select a card.    The line is inversed.    Choose Delete Card from the Edit menu to 
remove the selected card from your card file. 

Note:    If a card has been linked to a transaction (invoice, check, etc.), you may not delete it until all 
linked transactions have been removed.



Contact Log Entry

Name
Enter the name of the individual/company contacted. 

Date
Enter the date of this contact.    All contacts are kept in reverse chronological order by card. 

Notes
Use up to 255 characters to describe this contact and press Tab. 

Elapsed Time
Enter an elapsed time and M.Y.O.B. Accounting totals it for a selected time period on the contact log 
report.    This can be very useful for time billing.    Enter elapsed time in HH:MM format.    That is, enter the 
number of hours and number of minutes separated by a colon.    Enter a single digit for hours and/or 
minutes and M.Y.O.B. Accounting inserts a zero before the number.    The maximum elapsed time is 99 
hours and 59 minutes (99:59). 

Recontact Date
Enter a recontact date and M.Y.O.B. Accounting's To Do List reminds you beginning on that day or the 
nearest previous business day. 

The Phone Icon
In Customize M.Y.O.B. (in the Administration Command Center), you can note that you have a modem 
connected to your computer.    If you do, when you click the phone icon, M.Y.O.B. Accounting uses your 
modem to get a dial tone and dial the phone number of the selected card.



Contact Log Display

Name
Enter the last name or company name of a card and press Tab.    The card type and all previous contacts 
are displayed.    Click the white arrow next to the name to zoom to the card. 

Display Contacts
The contacts are listed in reverse chronological order - most recent first.    Click the white arrow in the 
beginning of the line to zoom to Contact Log Entry 

The Phone Icon
In Customize M.Y.O.zB. (in the Administration Command Center), you can note that you have a modem 
connected to your computer.    If you do, when you click the phone icon, M.Y.O.B. Accounting uses your 
modem to get a dial tone and dial the phone number of the selected card.



Identifiers

There are 26 one-letter identifiers - A to Z.    Identifiers are used to group entries in your card file.    You 
may assign any meaning to an identifier.    All those on your Christmas card list could be 'C'.    Clients that 
love golf could be 'G'.    M.Y.O.B. Accounting allows you to select and report (including mailing labels) by 
identifier.    The descriptions do not affect M.Y.O.B. Accounting's records; theyre for your information only.   
Enter up to 30 characters to describe each identifier and press Tab.



Mailing Labels

M.Y.O.B. Accounting prints mailing labels for any or all of your cards.

Card Type
You may print labels for all cards, or just your customers, vendors, employees or personal cards.

All vs. Selected
Choose All and labels are printed for all cards (that match the other selection criteria).    Choose Selected 
and you can print a label for a single card.

Note:    The selected card must be of the selected card type.

Identifiers
Check this to limit your labels by identifier.    You may enter up to 26 identifiers.    Only those cards with 
every identifier are included.    If, for example, you enter "AB" as your identifiers, only those cards 
assigned both A and B are included.

Note:    If you print labels for the same subset of cards every month, assign them a unique identifier and 
use this identifier option to select them.

Last Contact Before
M.Y.O.B. Accounting looks at your contact log and selects cards that were last contacted prior to the date 
entered (and that match the other selection criteria).

This is useful, for example, when you want to send a note to customers you haven't contacted in the last 
month.

Recontact On/Before
M.Y.O.B. Accounting looks at the contact log and selects any card (that also matches the other selection 
criteria) that has a contact log entry with a recontact date on or earlier than the date entered.

Note:    If you use the recontact date field, after you recontact the person, remember to delete the 
recontact date from the contact log entry.    If you leave old recontact dates in your contact log, the card 
will always match this selection criterion.

Zip Code
M.Y.O.B. Accounting searches the zip codes for the card's primary (first) address.    You may enter a 
partial zip code search.    If you need, for example, to select cards in northern New Jersey, enter "07."    All
cards with zip codes beginning with "07" are displayed.

Form Currently Used for Mailing Labels
M.Y.O.B. Accounting supports two types of labels, 2.875" X 1" (sometimes called "3up" labels because 
there are 3 labels per row) and 1.5" X 4" (also called "2up" labels).    If your labels are a different size, 
select the format that most closely matches your labels and click Customize. 

See Also
Customizing Mailing Labels



Customizing Mailing Labels

1. Select Mailing Labels
2. Choose the format (2.875" X 1" or 1.5" X 4") that most closely matches your labels.    The 

2.875" X 1" has 3 labels per row and the 1.5" X 4" has 2 labels per row.
3. Click Customize.

See How to Customize Forms for customization instructions.

Changing the size of your labels.    While in the Customization window, choose Forms Info from the Form 
menu.    Enter the dimensions of your labels.

Note:    If your printer cannot print at the very top of the sheet of labels, use the Top Margin setting to skip 
the first row of labels.

Saving Your Customized Mailing Labels.    When you click OK in the Customize window, the format 
you're working on is saved as the UserCustomized Labels.    If you've saved a customized format 
previously, you're warned that this version will replace the previous version.

Note:    The 2.875" X 1" and 1.5" X 4" label formats are not changed.    Regardless of which format you 
originally selected to customize, the customized format is always saved as the UserCustomized Labels.

See Also
Mailing Labels



Personalized Letters

M.Y.O.B. Accounting creates tabdelimited mail merge files from your card file information.    This file 
should work with most word processors.    Check your word processor user's guide to see if yours 
supports the M.Y.O.B. Accounting merge file format.

Merge File Format
The first record in the mail merge file is the header record.    It contains the name of each field.    Field 
names are separated by tabs and each record ends with a carriage return.    

After the header record, a record is created for each selected card.    There is a tab between each field.    
A carriage return ends each record.    The mail merge file contains the following fields for each selected 
card:

Field Name Description

Name This is the company name or the individual's name.    If it is an 
individual's name, it is the first name followed by a space and then the 
last name.

Add1 The first line of the First Address field
Add2 The second line of the First Address field
Add3 The third line of the First Address field
Add4 The fourth line of the First Address field
Add5 The fifth line of the First Address field
Zip1 The zip code for the First Address field
2Add1 The first line of the Second Address
2Add2 The second line of the Second Address
2Add3 The third line of the Second Address
2Add4 The fourth line of the Second Address
2Add5 The fifth line of the Second Address
Zip2 The zip code for the Second Address field
Phone1 The first phone number
Phone 2 The second phone number
Fax The fax number
Salutation The salutation 
Contact The contact name
Balance The current accounts payable (vendors) or accounts receivable 

(customers) balance.
Overdue The amount of the payable or receivable balance that is overdue 

given the customer's or vendor's credit terms.

Sample Mail Merge Letter
Check your word processor user's guide for instructions on creating a mail merge letter.

Here's how it looks when you prepare the letter:

«Contact»
«Name»
«Add1»
«Add2»
«Add3»
«Add4»

Dear «Salutation»:
You now owe me «Balance».    If I don't receive payment by Friday, your service will be discontinued.



Sincerely,

Your Bookie 

Here's how it looks after you merge it with a M.Y.O.B. Accounting card:

John Q. Public
Mega Corporation
Suite #123
Mega Towers
100 Main Street
Anytown, USA    10938

Dear John:
You now owe me $123,987.98.    If I don't receive payment by Friday, your service will be discontinued.

Sincerely,

Your Bookie 

Card Type
You may create a mail merge file for all cards, or just your customers, vendors, employees or personal 
cards.

All vs. Selected
Choose All and a merge file is created for all cards (that match the other selection criteria).    Choose 
Selected and you can create a merge file for a single card.

Note:    The selected card must be of the selected card type.

Identifiers
Check this to limit your merge file by identifier.    You may enter up to 26 identifiers.    Only those cards with
every identifier are included.    If, for example, you enter "AB" as your identifiers, only those cards 
assigned both A and B are included.

Last Contact Before
M.Y.O.B. Accounting looks at your contact log and selects cards that were last contacted prior to the date 
entered (and that match the other selection criteria).

This is useful, for example, when you want to send a note to customers you haven't contacted in the last 
month.

Recontact On/Before
M.Y.O.B. Accounting looks at the contact log and selects any card (that also matches the other selection 
criteria) that has a contact log entry with a recontact date on or earlier than the date entered.

Note:    If you use the recontact date field, after you recontact the person, remember to delete the 
recontact date from the contact log entry.    If you leave old recontact dates in your contact log, the card 
will always match this selection criterion.

Zip Code
M.Y.O.B. Accounting searches the zip codes for the card's primary (first) address.    You may enter a 
partial zip code search.    If you need, for example, to select cards in northern New Jersey, enter "07."    All
cards with zip codes beginning with "07" are displayed.

Saving the Merge File



Once you click OK in the selection dialog, M.Y.O.B. Accounting displays the selected cards in the Review 
Cards Before Exporting window.    You have an opportunity to delete specific cards from the merge file by 
clicking their checkmark.    When you click Export you get the standard file dialog and the checked cards 
will be exported.



Checkbook

Write Checks
Use Write Checks to automate your checkbook for faster check printing, easier account reconciliation and
more efficient cash management.

Make a Deposit
Use Make a Deposit to record your checking deposits for easier account reconciliation and efficient cash 
management.

Print Checks
Select Print Checks to have M.Y.O.B. Accounting print your checks.

Reconcile Accounts
Reconcile Accounts is a real time saver.    Just check those transactions that have cleared the bank.    
Click Reconcile and M.Y.O.B. Accounting checks to see if your balance agrees with the bank balance.    
Although most of the time Reconcile Accounts is used for checking accounts, you can use it to reconcile 
your credit card or loan statements.

Analyze Cash Flow
Leaving too much money in your (0% interest) checking account is costly, but so is bouncing checks.    
Use the Cash Flow Worksheet to estimate your nearterm cash needs.    M.Y.O.B. Accounting starts you 
out by including recurring transactions, known payables, and known receivables within the look ahead 
range.    You can add to or change the list.    Click Analyze Cash Needs and M.Y.O.B. Accounting 
displays a report of your checking account's future.    



Write Checks

Selecting a Checking Account
In the upper left of the Write Checks window is a pop-up menu containing all accounts with checking 
privileges.    If you do not see your checking account in the list, choose Chart of Accounts from the 
General Ledger Command Center and assign checking privileges to the account. 

Balance
Balance is the current balance of the selected checking account.    Click the arrow to zoom to Account 
Inquiry to see all the activity in this account. 

Handwritten
If the check is not going to be printed by M.Y.O.B. Accounting, check Handwritten. M.Y.O.B. Accounting 
then considers the check as already printed.    When you print your checks, select All Unprinted Checks 
and the "handwritten" check is not included. 

Check Number
M.Y.O.B. Accounting provides a default check number using the Last Check Number field from the 
account information entered in Chart of Accounts.    If you change the check number, it resets the Last 
Check Number field. 

Note:    When you print checks, M.Y.O.B. Accounting (at your option) renumbers your check transactions 
to match the printed checks.    So, if your printer eats some of your checks, dont worry. 

Date
All checks are sorted by date.    You may not enter a date prior to the conversion month or in a prior fiscal 
year.    If you enter a future date, M.Y.O.B. Accounting accepts it, but only after warning you that the date 
is probably in error.    See Also Data Entry in M.Y.O.B.. 

Amount
Enter the amount of the check.    See Also Data Entry in M.Y.O.B..    The checking account balance is 
credited (decreased) by the amount of the check. 

Card
The small Card File icon means that you may (optionally) link this check to an entry in your card file.    If 
you do not want to link to a card, simply press Tab.    There are two reasons why you should consider 
linking this check to a card:

1. The payee field fills in automatically with the name and address from the card.
2. In addition to including this check with all the other transactions for this account, M.Y.O.B.

cross references it by card.    Youll be able to use Inquiry - Search by Card to access and 
report on all transactions by selected card.    Knowing what you did in the checking 
account is important; being able to list all checks written to, for example, the Tenant's 
Association is real computing power!    To select a card, See Also Navigating in M.Y.O.B.. 

Payee
The Payee is what is printed next to "Pay to the Order of" on the check.    If you use window envelopes, 
the payee field is what shows through the window.    It usually contains the payee's name and address.    If
you linked the check to a card, the card's name and address appears here.    Feel free to change it.    
Remember, if you link the check to a card, changing the payee field will change what is printed on the 
check, but the check will remain linked to the original card. 

Memo
Enter whatever youd like.    Memos can be up to 255 characters, but because of report display limitations, 
it is most useful to limit your memos to 40 or 50 characters. 



Note:    When you look at this check transaction in the Cash Disbursements journal, the memo field is 
displayed.    If the memo field is left blank, the first line of the payee field is displayed. 

Allocation Accounts
To balance the transaction, you must allocate the check amount to the proper accounts.    Since the check
amount is a credit, the allocation amounts are considered debits.    (If you enter a negative allocation 
amount, it becomes a credit.)    Select the first allocation account (See Also Navigating in M.Y.O.B..).    The
allocation amount defaults to whatever is needed to balance the transaction.    If this is the only allocation, 
click Record (or press Enter).    If youre allocating to more than one account, change the displayed 
amount, press Tab and continue the allocation process. 

Job
If the allocation account is an income, expense, cost of sales, other income or other expense account, 
you can assign the amount to a job (see Jobs List).    Type the job number and press Tab.    If youre 
unsure of the job number, press Ctrl-L to see the job list.    Select a job from the job list or click New Job to
create a new one. 

Note:    If you need to assign an amount from a single allocation account to more than one job, enter the 
allocation account more than once.    Say, for example, you    have $100 of office expenses and you need 
to assign $30 to job 12 and $70 to job    43.    Allocate to Office Expenses twice, once for $30 and again for
$70. 

Recurring Check Transactions
See Recurring Check Transactions

Record
Total allocations must equal the check amount before you can record the check. 

Non-Check Withdrawals - Bank Fees, ATMs, and Transfers
There are two ways to record withdrawals from your checking account that are not checks: General 
Journal Entry or Write a Check.    Either way, the transaction    appears in your Inquiry - Search by Account
display and checkbook    reconciliation.    The only major differences are that check transactions appear in 
the Cash Disbursements Journal and can be linked to a card, whereas general journal transactions 
appear in the General Journal and are unlinked.

1. General Journal Entry.    Credit your checking account for the amount of the withdrawal.    
Debit the destination account (Bank fees expense, your savings account, etc.).    The 
transaction is placed in the General Journal.

2. Write Checks.    Be sure to use a unique check number (or a non-number like the word 
"Fee" or "ATM") to separate your non-checks from your real checks. 

Note:    When printing, you can select a range of checks by check number. Be sure    to use a unique 
check number (or a non-number like the word "Fee" or "ATM") so    it's easy to omit non-checks before 
printing.



Recurring Check Transactions

Use Write Checks to record recurring check transactions.    Checks that must be written time and again - 
like payroll or rent - are best saved    as recurring transactions.    When you save a check as recurring, 
M.Y.O.B. Accounting puts a    copy of it in a separate list of recurring transactions.    Anytime you need to 
write one, just click Use Recurring, verify the date, check number, and amount and post it.    There is no 
need to reenter the transaction detail (although you may if    you wish). 

Save as Recurring
Every recurring check needs a name.    M.Y.O.B. Accounting enters the first line of the memo field as a 
default name.    The list of recurring transactions is kept in alphabetical    order.    Use the default name or 
enter your own, up to 30 characters.    Additionally, you should specify the frequency of the transaction.    If
you do,    M.Y.O.B. Accounting includes a reminder in your To-Do list and adjusts for it on your Cash Flow 
Worksheet. 

Note:    If you save a check as recurring with the incorrect name or frequency, do not re-save it.    Click 
Use Recurring, select the transaction and click Edit. 
Note:    Any recurring transaction with a frequency of 'Other' is not included in your To-Do List or Cash 
Flow Worksheet. 

Use Recurring
Click Use Recurring and your recurring check transactions are displayed    alphabetically by name.    
M.Y.O.B. Accounting lists every transaction frequency, date last    recorded and due date.    Due date is 
calculated by taking the date last recorded and    adding the number of days in the frequency (adjusted 
forward if the day is a non- business day).    If there is an asterisk after the due date, it means that the    
transaction is currently overdue.    It is for your information only.    M.Y.O.B. Accounting    doesnt care if you
record it or not.    To search for a transaction, type a few letters of its name and press Tab.    Double-click 
the desired transaction or select it (with a single click) and press    Return.    The transaction is displayed, 
ready to be modified (if needed) and recorded. 

Note:    The payee and transaction detail (accounts, amounts, etc.) of a recurring check are the same as 
the last time it was recorded.    The date and check number are changed to their current default values.    
Feel free to change any entry before    recording. 
Note:    You need only save a transaction as recurring once.    You should not save it    as recurring every 
time you record it. 

Changing a Recurring Transaction
To change a recurring transaction's name or frequency, click Use Recurring,    select the transaction and 
click Edit.    To change the detail (payee, accounts,    amounts, etc.) of a transaction, wait until the next 
time you need to use it.    When    it is displayed, change it before recording.    The next time you use it, the
new    detail will be displayed. 

Deleting a Recurring Transaction
To delete a recurring transaction from your list, click Use Recurring, select it    and click Delete. 

Note:    Deleting a recurring transaction only deletes it from your list of    recurring transactions.    All actual 
transactions recorded previously using this    recurring transaction are not affected. }



Make a Deposit

Selecting a Checking Account
In the upper left of the Make a Deposit window is a pop-up menu containing all    accounts with checking 
privileges.    If you do not see your checking account in the    list, choose Chart of Accounts from the 
General Ledger Command Center and assign checking privileges to the account. 

Balance
Balance is the current balance of the selected checking account.    Click the arrow    to zoom to the Inquiry 
- Search by Account window.    See Finding, Changing, Deleting, and Reversing Deposits for instructions 
on correcting a mistaken entry.    

ID Number
The ID Number helps you to identify this deposit in the Cash Receipts Journal, Search by Account 
display, and Reconciliation.    M.Y.O.B. Accounting provides a default ID number; feel free to change it. 

Note:    If you group multiple M.Y.O.B. Accounting deposit transactions on a single bank    deposit slip, use
the same ID number for the M.Y.O.B. Accounting deposits.    If your bank does    not itemize deposits on 
your statement, having the same ID number makes    reconciliation easier. 

Date
All deposits are sorted by date.    You may not enter a date prior to the conversion    date or in a prior fiscal
year.    If you enter a future date, M.Y.O.B. Accounting accepts it, but only after warning you that the date 
is probably in error.    See Also Data Entry in M.Y.O.B.. 

Amount
Enter the amount of the deposit.    See Also Data Entry in M.Y.O.B..    The checking account is debited 
(increased) by the amount of the deposit.    If you enter a negative deposit amount, the account is 
credited.

Payor
The small card file icon means that you may (optionally) link this deposit to an entry in your card file.    If 
you do not want to link to a card, simply press Tab.    You should consider linking this deposit to a card.    
In addition to including this    deposit with all the other transactions for this account, M.Y.O.B. Accounting 
cross references    it by card.    Youll be able to use the Inquiry - Search by Card window to access and    
report on all transactions by selected card.    To select a card, type the first few characters of the person's 
last name.    If it's a company, type a few characters of the company's name.    Press Tab.    If you    type a 
unique match, the card is selected and you are taken to the memo field.    If    you type a non-unique 
match your card file is displayed (See Also Navigating in M.Y.O.B..).    Alternatively, you may click the card
file icon or press Ctrl-L. 

Memo
Enter whatever youd like.    Memos can be up to 255 characters, but because of    report display 
limitations, it is most useful to limit your memos to 40 or 50    characters. 

Allocation Accounts
To balance the transaction, you must allocate the deposit amount to the proper    (usually income) 
accounts.    Since the deposit amount is a debit, the allocation    amounts are considered credits.    (If you 
enter a negative allocation amount, it    becomes a debit.)    Select the first allocation account (See Also 
Navigating in M.Y.O.B..).    The allocation amount defaults to whatever is needed to balance the    
transaction.    If this is the only allocation, click Record (or press Enter).    If youre allocating to more than 
one account, change the displayed amount,    press Tab and continue the allocation process. 

Job
If the allocation account is an income, expense, cost of sales, other income or    other expense account, 
you can assign the amount to a job (see Jobs List).    Type the job number and press Tab.    If you are 



unsure of the job number, press Ctrl-L to see the job list.    Select a job from the job list or click New Job to
create a new one. 

Note:    If you need to assign an amount from a single allocation account to more    than one job, enter the 
allocation account more than once.    Say, for example, you    have $100 of Widget Income and you need 
to assign $30 to job 12 and $70 to job    43.    Allocate to Widget Income twice, once for $30 and again for 
$70. 

Recurring Deposit Transactions
See Recurring Deposit Transactions

Record
Total allocations must equal the deposit amount before you can record the    deposit.



Recurring Deposit Transactions

Use Make a Deposit to record recurring deposits.    Deposits that are received time and again - like a 
monthly royalty check - are best saved as recurring transactions.    When you save a deposit as recurring, 
M.Y.O.B. Accounting puts a copy of it in a separate list of recurring transactions.    Anytime    you need to 
record the deposit, just click Use Recurring, choose the desired    transaction, verify the date, ID number 
and amount and record it.    There is no    need to reenter the transaction detail (although you may if you 
wish).

Save as Recurring
Every recurring deposit needs a name.    Enter a name, up to 30 characters.    The    list of recurring 
transactions is kept in alphabetical order.    Additionally, you    should specify the frequency of the 
transaction.    If you do, M.Y.O.B. Accounting includes a    reminder in your To-Do list and adjusts for it on 
your Cash Flow Worksheet. 

Note:    If you save a deposit as recurring with the incorrect name or frequency,    do not re-save it.    Click 
Use Recurring, select the transaction and click Edit. 
Note:    Any recurring transaction with a frequency of 'Other' is not included in    your To-Do List or Cash 
Flow Worksheet. 

Use Recurring
Click Use Recurring and your recurring deposit transactions are displayed    alphabetically by name.    
M.Y.O.B. Accounting lists every transaction frequency, date last    recorded and due date (adjusted 
forward if the day is a non-business day).    Due    date is calculated by taking the date last recorded and 
adding the number of days in    the frequency.    If there is an asterisk after the due date, it means that the  
transaction is currently overdue.    It is for your information only.    M.Y.O.B. Accounting    doesnt care if you
record it or not.    To search for a transaction, type a few letters of its name and press Tab.      Double-click 
the desired transaction or select it (with a single click) and press    Return.    The transaction is displayed, 
ready to be modified (as needed) and    recorded. 

Note:    The memo and transaction detail (accounts, amounts, etc.) of a recurring    deposit are the same 
as the last time it was recorded.    The date and ID number are    changed.    Feel free to change any entry 
before recording.    
Note:    You need only save a transaction as recurring once.    You should not save it    as recurring every 
time you record it. 

Changing a Recurring Transaction
To change a recurring transaction's name or frequency, click Use Recurring,    select the transaction and 
click Edit.    To change the detail (memo, accounts,    amounts, etc.) of a transaction, wait until the next 
time you need to use it.    When    it is displayed, change it before recording.    The next time you use it, the
new    detail is displayed. 

Deleting a Recurring Transaction
To delete a recurring transaction from your list, click Use Recurring, select it    and click Delete. 
Note:    Deleting a recurring transaction only deletes it from your list of    recurring transactions.    All actual 
transactions recorded previously using this    recurring transaction are not affected. 



Reconcile Accounts

Account
Choose the account to reconcile (See Also Navigating in M.Y.O.B..).
Note:    Most people use Reconcile Accounts to reconcile their checking account.    
Some find it useful for reconciling other accounts that have periodic statements    such as loans, charge 
accounts, and expense accounts.    After choosing an account, the Current Balance, Last Reconciled 
Date, Date of    Bank Statement and New Balance from Statement fields are displayed. 
Note:    Only transactions that have been saved to your disk appear in the    reconciliation window. 

Current Balance
Click the Current Balance arrow to zoom to the Inquiry - Search by Account    window.    This shows all the 
credits and debits to the account (for the selected    journal within the selected date range). 

Last Reconciled Date
This field is updated with the Date of Bank Statement every time you accept a    successful reconciliation. 

Date of Bank Statement
Enter the date on your statement and press Tab (See Also Data Entry in M.Y.O.B.) 

New Balance from Statement
M.Y.O.B. Accounting defaults to the current balance of the account.    This is correct only if    every 
transaction has cleared the bank.    Type the ending balance from your    statement and press Tab. 

Marking Cleared Transactions
All unreconciled transactions are displayed.    If the transaction shows up on your    statement, click the 
checkmark column to the left of the transaction.    If it has yet    to clear the bank, leave it unchecked.    To 
uncheck a checked transaction, simply click it again. 

Note:    Remember to enter all bank charges, etc. before reconciling.    Bank charges can be entered in 
General Journal Entry or as a check.    (See Non-Check    Withdrawals - Bank Fees, ATMs, and Transfers 
in the Write Checks section.)
Note:    If you enter new transactions or correct a prior one, remember to save    your changes before 
continuing with the reconciliation. 

Reconcile
M.Y.O.B. Accounting adds uncleared withdrawals to your account balance and subtracts    uncleared 
deposits from your account balance.    If the calculated balance agrees    with the New Balance from 
Statement, you may record cleared transactions as    reconciled.    If they disagree, M.Y.O.B. Accounting 
displays the Out of Balance amount.    An out    of balance situation can be caused by many things.    
Among them are:

1. You havent checked all cleared transactions or youve checked an uncleared transaction.
2. A transaction on your statement is not in M.Y.O.B. Accounting (remember to save before 

reconciling).
3. Your New Balance from Statement was entered incorrectly.
4. The individual check and deposit amounts entered in M.Y.O.B. Accounting disagree with 

your statement.    (If your Out of Balance amount is a multiple of 9, look for a numbers 
transposition; a 28, for example, entered as an 82.)

5. Your bank is wrong? 

Note:    If you decide to leave Reconcile Accounts without successfully reconciling,    the transactions 
marked as cleared remain marked.    You can pick up where you    left off at any time. 
Note:    You may have some difficulty reconciling if you have uncleared checks and deposits recorded 
prior to converting your books to M.Y.O.B. Accounting If so, enter the uncleared checks and deposits (you
may have to "fudge" the date).    Use your checking account as the allocation account so you don'tchange 
its balance.





Cash Flow Worksheet

Selecting a Checking Account
In the upper left of the Cash Flow Worksheet window is a pop-up menu    containing all accounts with 
checking privileges.    If you do not see your checking    account in the list, choose Chart of Accounts from 
the General Ledger command centerand assign checking privileges to the account.

Days to Look Ahead
Enter the number of days you want to include in your cash flow forecast and    press Tab. 

Note:    The Days to Look Ahead is preset to 30.    You may accept it by pressing Tab or change it and 
press Tab.    M.Y.O.B. Accounting fills the worksheet with the predicted    transactions for that period.      
Note:    The worksheet includes known payables and receivables.    It does not know    about sales or 
purchases yet to be made.    If you try to look ahead much farther than your average credit terms (30 to 90
days for most businesses), your cash flow accuracy will suffer. 

The Worksheet
The Cash Flow Worksheet includes: 

1. Recurring transactions for the selected checking account within the look-ahead range.    
The frequency of the recurring transaction is taken into account.    If, for example, the 
transaction recurs weekly, it is shown four times in a 28-day look ahead.    If the selected 
checking account is the linked checking account for receivables    (see Set Up 
Receivables in Chapter 3 of the Getting Started booklet), the worksheet includes:

2. Past due receivables
3. Receivables becoming due within the look-ahead range.    If the selected checking 

account is the linked checking account for payables (see Set Up Payables in Chapter 3 of
the Getting Started booklet), the worksheet includes:

4. Past due payables
5. Payables becoming due within the look-ahead range.    Change to $0.00 any amounts 

that you dont expect to pay or receive.    Scroll to    the bottom of the list to add any 
transactions that M.Y.O.B. Accounting did not include.    Enter a    description of the 
transaction, the due date and the money in or out. When you have completed the 
worksheet, click Analyze Cash Needs. 

Analyze Cash Needs
M.Y.O.B. Accounting takes the information entered in the Cash Flow Worksheet, sorts it by date and 
calculates the projected running balance of your selected checking account within the look ahead range.   
Click Return to Worksheet to modify any information.



Print Checks

Select Print Checks to print checks entered in three places:    Write Checks (Checkbook), Make a 
Payment (Purchases & Payables), and Write a Refund Check (Settle Credits).

You may order compatible checks and envelopes (an order form is included with your M.Y.O.B. 
Accounting package) or customize the check printing to fit your existing checks.

Important Note:    If you are using Continuous-Feed checks, set your Page Setup to U.S. Legal size (8½ x 
14").    If you are using the Laser checks, set it to U.S. Letter (8½ x 11").

Selected Checking Account
All accounts with checking privileges are listed in this popup menu.    If your checking account is not listed,
go to Chart of Accounts in the General Ledger command center, select the account and give it checking 
privileges.

Check # of First Check in Printer

Enter the number of the first check.    Once it has completed printing, M.Y.O.B. Accounting renumbers 
your cash disbursement records to match the number on the printed check.

Unprinted Checks Only
M.Y.O.B. Accounting keeps track of which checks have yet to be printed.    Use this checkbox to select 
them.    Before printing, M.Y.O.B. Accounting displays a list of the selected checks.    You may deselect 
any check you don't want printed.

Note:    If you check "Handwritten" when entering the check, it is considered a printed check.

Checks Dated From...
Use this selection to narrow down your choice of checks to print.    Before printing, M.Y.O.B. Accounting 
displays a list of the selected checks.    You may deselect any check you don't want printed.

Check Numbers Between...
Use this selection to narrow down your choice of checks to print.    Before printing, M.Y.O.B. Accounting 
displays a list of the selected checks.    You may deselect any check you don't want printed.

Form Currently Used for Checks:
M.Y.O.B. Accounting has pre-printed checks available (see the brochure that came with your M.Y.O.B. 
Accounting package).    If you do not have these checks, select the check format that most closely 
matches yours (continuousfeed or laser) and click Customize.    See the following instructions.

Print Alignment Check
Click this button to print a sample check.    Once it is printed, check the alignment, adjust your printer and 
reset the top of form.    (For continuousfeed printers, set the top of form by turning it off and then on.)

Customizing Checks
You may customize your checks.    Here's how:

1. Select Print Checks
2. Choose the form (ContinuousFeed Check or Laser Check) that most closely matches 

your form.
3. Click Customize.

The check form has two parts: the check and the stub.    Depending upon the type of check, M.Y.O.B. 
Accounting prints three types of stubs: a regular stub, a payable stub and a refund check stub.    Regular 
stubs are used when printing checks entered in Write Checks.    Payable stubs are used when printing 
checks entered in Make a Payment.    And refund check stubs are used when printing a check entered in 



Settle Credits.

You may customize the check, or any of the three stubs.    Choose which to customize from the Form 
menu.

Note:    When customizing a check stub, the check fields are displayed, but inaccessible.    You must 
choose Check Layout from the Form menu to customize the check fields.

See How to Customize Forms for customization instructions.

Saving Your Customized Check.    When you click OK in the Customize window, the format you're 
working on is saved as the UserCustomized Check.    If you've saved a customized format previously, 
you're warned that this version will replace the previous version.

Note:    The    ContinuousFeed Check format and the    Laser format are not changed.    Regardless of 
which format you originally selected to customize, the customized format is always saved as the 
UserCustomized Check.

View Checks Before Printing
When you click OK in the Print Checks Dialog, M.Y.O.B. Accounting produces a list of the checks that 
match your selection criteria.    If there's a check on the list you do not wish to print, click the checkmark in
the column labeled "Print."    The checkmark disappears, telling M.Y.O.B. Accounting not to print the 
check.

If you wish to see a check on the list, click the arrow.



Finding, Changing, Deleting, and Reversing Checks

Entering a Void Check
Erasing a Check Before It's Recorded
Finding a Check
Changing or Deleting a Check
Reversing (Voiding) a Check
Changing a Recurring Check
Deleting a Recurring Check



Entering a Void Check

Write a check for $0.00.    Click Record.    You are asked if you wish to void this check.    Click OK.

See Also
Finding, Changing, Deleting, and Reversing Checks



Erasing a Check Before It's Recorded

If, while entering a check, you need to start over, choose Erase Check Transaction from the Edit menu.

See Also
Finding, Changing, Deleting, and Reversing Checks



Finding a Check

Click the Cash Disbursements Journal icon in the Checkbook command center.    Or, if you are using 
Write Checks, you can access a prior check transaction via the journal icon or the Account Balance arrow.

The Journal Icon    Use the journal icon to quickly review an entire check transaction.

Click the journal icon in the lower right-hand corner of the check to zoom to the Cash Disbursements 
display.    This shows all entries - for all cash accounts - in the Cash Disbursements journal.    All pieces of 
a transaction, even the allocation accounts, are displayed.

The Account Balance Arrow    Use the Balance Arrow to quickly review you checking account history

Click the arrow next to the account balance to zoom to the Inquiry - Search by Account display.    This 
shows all the credits and debits to the checking account (for the selected journal within the selected date 
range).    It displays just the side of the transaction that affects your checking account.

The date range defaults to the current month.    all transactions between (and including) the From and To 
dates are displayed.    All transactions from the Write Checks window have a small arrow to their left.    
Click the arrow to display the check.

See Also
Finding, Changing, Deleting, and Reversing Checks



Changing or Deleting a Check

If the transaction arrow is white, the check has not been saved to your disk.    You may change any field 
(and click OK) or delete the check.    To delete the check, choose Delete Check Transaction from the Edit 
menu.

If the arrow is gray, see Reversing (Voiding) a Check.

See Also
Finding, Changing, Deleting, and Reversing Checks



Reversing (Voiding) a Check

To void a check prior to saving, simply change the amount (and all allocation amounts) to zero.

If you selected "Unchangeable" in Customize M.Y.O.B., when you chose Save from the File menu, the 
transaction arrow turns gray.    This means you may not change or delete it.    To correct a saved 
transaction you must reverse and re-enter it.    A reversing transaction is a new transaction that replicates 
the original transaction with debit amounts shown as credit amounts and vice versa.    After recording a 
reversing transaction, you have two transactions (the original and the reversing), but the current account 
balances appear as if the original transaction never happened.    Reversing a check is M.Y.O.B. 
Accounting's equivalent to voiding a check.

To reverse a displayed saved transaction, choose Reverse Check Transaction from the Edit menu.

See Also
Finding, Changing, Deleting, and Reversing Checks



Changing a Recurring Check

To change a recurring transaction's name or frequency, click Use Recurring, select the transaction and 
click Edit.    To change the detail (payee, accounts, amounts, etc.) of a transaction, wait until the next time
you need to record it.    When it is displayed, change it before recording.    The next time you use it, the 
new detail will be displayed.

See Also
Finding, Changing, Deleting, and Reversing Checks



Deleting a Recurring Check

To delete a recurring transaction from your list, click Use Recurring, select it and click Delete.

See Also
Finding, Changing, Deleting, and Reversing Checks



Finding, Changing, Deleting, and Reversing Deposits

Erasing a Deposit Transaction Before It's Recorded
Finding a Deposit
Changing or Deleting a Deposit
Reversing a Deposit
Changing a Recurring Deposit
Deleting a Recurring Deposit



Erasing a Deposit Transaction Before It's Recorded

If, while entering a deposit, you need to start over, choose Erase Deposit Transaction from the Edit menu.

See Also
Finding, Changing, Deleting, and Reversing Deposits



Finding a Deposit

Click the Cash Receipts journal icon in the Checkbook command center.    Or, if you are using Make a 
Deposit, you can access a prior deposit transaction via the Journal Icon or the Account Balance arrow.

The Journal Icon.    Use the journal icon to quickly review an entire deposit transaction.

Click the journal icon in the lower righthand corner of the deposit to zoom to the Cash Receipts display.    
This shows all entriesfor all cash accountsin the Cash Receipts journal.    All pieces of a transaction, even 
the allocation accounts, are displayed.

The date range defaults to the current month.    All transactions between (and including) the From and To 
dates are displayed.    All deposits have a small arrow to their left.    Click the arrow to display the deposit. 

The Account Balance Arrow.    Use the account balance arrow to quickly review your checking account 
history.

Click the arrow next to the account balance to zoom to the InquirySearch by Account window.    This 
shows all the credits and debits to the checking account (for the selected journal within the selected date 
range).    It displays just the side of the transaction that affects your checking account.

The date range defaults to the current month.    All transactions between (and including) the From and To 
dates are displayed.    All transactions from the Make a Deposit window have a small arrow to their left.    
Click the arrow to display the deposit. 

See Also
Finding, Changing, Deleting, and Reversing Deposits



Changing or Deleting a Deposit

If the transaction arrow is white, the deposit can still be edited.    (Either it has not been saved to your disk,
or your data file is "Changeable."    See Customize M.Y.O.B.)    You may change any field or delete the 
deposit.    To delete the deposit, choose Delete Deposit Transaction from the Edit menu.

If the arrow is gray, see Reversing a Deposit.

See Also
Finding, Changing, Deleting, and Reversing Deposits



Reversing a Deposit

If your data file is "Unchangeable" (See Customize M.Y.O.B.), when you choose Save from the File menu,
the arrow turns gray.    You may not change or delete this transaction.    To correct any saved transaction 
you must reverse it and reenter it.    A reversing transaction is a new transaction that replicates the original
transaction with debit amounts shown as credit amounts and vice versa.    After recording a reversing 
transaction, you have two transactions (the original and the reversing), but the current account balances 
appear as if the original transaction never happened.

To reverse a displayed saved transaction, choose Reverse Deposit Transaction from the Edit menu.

See Also
Finding, Changing, Deleting, and Reversing Deposits



Changing a Recurring Deposit

To change a recurring transaction's name or frequency, click Use Recurring, select the transaction and 
click Edit.    To change the detail (memo, accounts, amounts, etc.) of a transaction, wait until the next time 
you need to record it.    When it is displayed, change it before recording.    The next time you use it, the 
new detail is displayed.

See Also
Finding, Changing, Deleting, and Reversing Deposits



Deleting a Recurring Deposit

To delete a recurring transaction from your list, click Use Recurring, select it and click Delete.

Note:    Deleting a recurring transaction only deletes it from your list of recurring transactions.    All actual 
transactions recorded previously using this recurring transaction are not affected. 

See Also
Finding, Changing, Deleting, and Reversing Deposits



General Ledger

Chart of Accounts
Use Chart of Accounts to build or modify your list of assets, liabilities, equity, income, cost of sales, 
expense, other income or other expense accounts.

General Journal Entry
Use General Journal Entry to make single and recurring transaction entries that cannot be done within the
Checkbook, Sales & Receivables, Purchases & Payables or Inventory Command Centers.
 
Analyze Balance Sheet
Analyze Balance Sheet is a quick, powerful and interactive way to review your asset, liability and equity 
accounts.

Analyze Profit & Loss
Analyze Profit & Loss is a quick, powerful and interactive way to review your income, cost of sales, 
expense accounts, other income and other expense accounts.



Chart of Accounts

Account Type
See Account Types

Account Number
Every account must have a unique number.    All account numbers have a one-digit prefix followed by a 
four digit number.    The one-digit prefix identifies the type.    See the preceding chart for a description of 
account types.    The last four digits identify the account within that type.    You may use any four digits 
except 0000.    Remember, M.Y.O.B. Accounting keeps the accounts in account number order.    If you 
wish to reorder your accounts, simply change the account numbers. 

Note:    If you enter less than four digits, M.Y.O.B. Accounting fills in with zeros. 

Account Name
Enter up to 30 characters to describe the account. 

Section Headers
Section headers are non-postable accounts that contain detail accounts.    They serve no accounting 
purpose except to group and total detail accounts for reporting clarity.    Section headers are displayed in 
bold type in the chart.    You are not required to use section headers - all of your accounts (except for the 
level 1 accounts, see Levels) may be detail accounts.    For each section header, you may decide whether
or not to generate a report total of the accounts within the section.    You may create Section Headers at 
levels 2 or 3. 

Detail Accounts
Detail accounts are postable accounts that aggregate to a particular section header.    If you note that an 
account has checking privileges, enter the last check number.    When M.Y.O.B. Accounting displays the 
Write Checks window, the next check number in the sequence is the default.    If you change the check 
number on the Write Checks screen, M.Y.O.B. Accounting changes the last check number field in the 
account record.    You may create Detail Accounts at levels 2, 3 or 4. 

Note:    The equity account called Current Year Earnings behaves a bit differently.    It is a detail account, 
but you may not post to it.    It is reserved by M.Y.O.B. Accounting for recording your monthly profit or loss.
The account has a current balance (your year-to-date profit or loss), but does not have a transaction 
history. 

The Current Balance
Accounts display their current balance.    For Asset, Liability and Equity accounts (see Note) the current 
balance is the current valuation of the account.    For income, expense, cost of sales, other income and 
other expense account the current balance is the net activity in the account since the beginning of the 
fiscal year.    The Current Balance of a section header is the sum of the detail accounts within the section. 
Detail accounts have an arrow next to Current Balance.    Click it to zoom to the Account Transaction 
Detail display. 

Levels
Levels allow you to maintain a very detailed chart of accounts without cluttering up your financial reports.   
M.Y.O.B. Accounting allows up to four levels of accounts.    You are not required to use levels, but if you 
do you may choose the level of account detail when reporting.    Level 1 is the highest level and is 
reserved by M.Y.O.B. Accounting for the account type (asset, liability, etc.).    Level 4 is the lowest, most 
detailed level.    M.Y.O.B. Accounting displays your chart of accounts as an outline, indenting two spaces 
for each level.    The distinction between section headers and detail accounts forms the basis for levels.    
Level 1 is reserved for the account type.    It is the only account at level 1 and it is a section header.    You 
may change its name (if you want to change "Assets" to "Stuff I own", go ahead) and subtotal option.    
You may not delete it, change its number, or move it to another level.    You may create accounts at levels 
2, 3 and 4.    Every account must aggregate to a section header above it at the previous level.    A level 3 



detail account, for example, must aggregate to a level 2 section header which, in turn, must aggregate to 
a level 1 section header.    You may create section headers at levels 2 and 3.    Detail accounts can be at 
2, 3, or 4.    When you enter a new account, M.Y.O.B. Accounting takes its best guess as to which level 
you want.    To change it, click the correct level on the level control. 

Changing the Level of an Account
The level of an account is shown in the level control at the bottom right of the window.    To move the 
account, simply click the desired level number.    If the level number is grey, the account cannot be moved 
to that level.    Remember, before you can move an account to another level, there must be a section 
header above it at the previous level. 

Note:    When creating your chart of accounts, enter all of your section headers before entering your detail
accounts.    It's faster and more accurate at guessing the proper account level.

Creating a New Account
Choose whether this new account is a section header or detail account.    Next type a unique account 
number and press Tab.    The account appears in the list with the name NEW ACCOUNT.    Type the 
account name (up to 30 characters) and press Tab.    Make sure the account level is correct.    If it's a 
section header, verify the report subtotal checkbox.    If it's a detail account, check whether it has checking
privileges.    When youre ready, click OK or press Enter.    The Account Information box is ready for the 
next account. 

Editing an Account
There are two ways to select an account to edit.    Either click the account name in the list or enter the 
account number in the Account Information box and press Tab.    Either way, the Account Information 
appears.    You may change the account number, account name, checkboxes and, if allowed, the account 
level.    A detail account with transactions assigned to it may not be deleted or changed to a section 
header.    A section header may be changed to a detail account.    When you change an account's number,
the account list is reordered (in account number order).    If a section header is separated from its sub-
accounts, they are moved up one level.    If the section header is moved up or down a level, its sub-
accounts are moved with it. 
Historical Balances
If you wish to compare this year's balance sheet and income statement to last year's without waiting a 
year for M.Y.O.B. Accounting to collect the data, you need to enter historical balances for your accounts.   
Just click the Historical Balances button. 
BudgetsYou may set monthly budgets for any detail account by clicking the Budgets button.



Chart of Accounts Historical Balances

You are not required to enter historical balances.    But if you wish to compare this year's balance sheet 
and income statement to last year's without waiting a year for M.Y.O.B. Accounting to collect the data, you
need to enter pre-conversion balances for your accounts.    For balance sheet accounts (assets, liabilities,
and equity), enter the period ending balances for each account for the selected period.    You may not 
enter a balance for Current Year Earnings - it is calculated by M.Y.O.B. Accounting    For profit and loss 
accounts (income, cost of sales, and expense) enter the net activity for each account for the selected 
month.    Click the arrows in the upper right to select the month.    You may not enter historical balances for
the period immediately preceding your conversion month since these are the balances specified in the 
Opening Balances window.    Your Opening Balances    are the account balances at the end of the month 
prior to your conversion month.    Unless your conversion month is the beginning of a new fiscal year (see 
Note).    When you enter historical profit & loss (income, cost of sales, or expense) balances, M.Y.O.B. 
Accounting adjusts your Opening Balances.    If, for example, you have a calendar fiscal year and your 
conversion month is July, your Opening Balances are the total activity for January through June.    This 
number is saved as June's activity since M.Y.O.B. Accounting doesn't know how to divide the number 
among the preceding six months.    If you enter historical balances for January through May, they will be 
subtracted from the June activity figure. 
Note:    For those of you who are converting your data as of the beginning of your fiscal year - you are 
allowed to enter net activity for your profit and loss accounts (income, cost of sales, expense, other 
income and other expense) for the last month of the previous fiscal year, since you may not enter these 
numbers in the Opening Balances window.
See Also

Chart of Accounts



Chart of Accounts Budgets

You may set monthly budgets for any detail account.    Select the account from the Chart of Accounts and 
click the Budgets button.    If you enter budgets, M.Y.O.B. Accounting can perform some very useful 
analyses comparing budgeted performance with actual performance (see Analyze Balance Sheet and 
Analyze Profit & Loss).    Most people budget income, cost of sales, and expense accounts.    A few 
budget some assets (like capital expenditures) and liabilities (the buy-down of loan principal).    To help 
you figure out your budgets, M.Y.O.B. Accounting displays your historical account balances.    The 
monthly amount shown is the net activity for profit and loss (income, cost of sales, and expense) 
accounts.    It is the end of period balance for balance sheet (asset, liability, and equity) accounts.    The 
budget amount should be the expected net activity for the period regardless of the account type (balance 
sheet account or profit and loss account).    When setting your budgets, be careful what sign (+ or -) you 
use.    Positive budget amounts tell M.Y.O.B. Accounting to expect the account balance to grow during the 
month.    When you set a $100 monthly budget for an income account, it means you're expecting $100 
income for the month.    When you budget $100 for an expense or cost of sales account, youre expecting 
expenses or costs of $100 for the month.    Budget $100 for an asset and youre expecting the asset to 
grow by $100 during the month.    Budget $100 for a liability and youre expecting the liability to grow $100.
If youre buying down a loan, enter the budget as minus $100 per month. 

Budget Shortcuts
Enter an amount and a frequency (Weekly, Bi-Weekly, Half-Monthly or Monthly).    M.Y.O.B. Accounting 
multiplies the amount by the number of occurrences in a year.    It divides that number by 12 to determine 
the monthly budget.    If, for example, you have a $2,000 payroll expense every other week, enter $2,000 
and choose Bi-Weekly.    M.Y.O.B. Accounting multiplies $2,000 by 26 and divides the result by 12 for a 
monthly budget of $4,333.33.    Enter a Monthly Dollar Increase or Monthly Percentage Increase and 
M.Y.O.B. Accounting begins with the January budgeted amount and increases it by the specified amount 
or percent. 

Note:    M.Y.O.B. Accounting does not budget the 13th period.
See Also

Chart of Accounts



General Journal Entry

General Journal Number
The General Journal Number identifies this transaction.    M.Y.O.B. Accounting sorts general journal 
transactions by journal number within date.    You may enter up to 8 characters, using any combination of 
numbers and letters.    M.Y.O.B. Accounting provides a default journal number with the prefix GJ (for 
General Journal) followed by a 6-digit number.    M.Y.O.B. Accounting allows duplicate journal entry 
numbers, however it is not recommended. 

Date
All transactions within the General Journal are sorted by transaction date.    You may not enter a date in a 
prior fiscal year or prior to your conversion month.    If you enter a future date, M.Y.O.B. Accounting 
accepts it, but only after warning you that the date is probably in error.    See Also Data Entry in M.Y.O.B.. 

Memo
Enter whatever youd like.    Memos can be up to 255 characters, but because of report display limitations, 
it is most useful to limit your memos to 40 or 50 characters. 

Account Number
You must select an account.    In M.Y.O.B. Accounting accounts are selected using their account number.   
See Also Navigating in M.Y.O.B..    Click the New Account button on the search chart of accounts dialog 
and M.Y.O.B. zooms to Chart of Accounts.    Enter the account information and press Enter or click OK.    
The window disappears and youre back at the Account Number field.    Type the new account number and
press Tab.    The new account is selected, its name appears and you jump to the Debit Amount. 

Debit Amount and Credit Amount
Enter a dollar amount.    M.Y.O.B. Accounting allows you to type the dollar amount using numbers, 
commas, periods and dollar signs.    Improperly formed amounts are disallowed and decimal amounts are 
rounded to the nearest cent.    You may not enter negative amounts in the General Journal.    Use the 
Credit Amount column for negative debits and the Debit Amount column for negative credits.    If you enter
an amount in the Debit column, pressing Tab jumps you to the next line.    If you leave the Debit amount at
$0.00, pressing Tab brings you to the Credit column.    M.Y.O.B. Accounting bounces you back and forth 
between these two columns until you enter an amount or press Return to move to the next line.    M.Y.O.B.
Accounting takes its best guess as to the amount.    If it's wrong, delete it and enter the correct amount. 

Note:    An account without a dollar amount is not recorded as part of the journal entry.    You may not 
have both a debit and credit amount on the same line.    You may however, use the same account on 
more than one line.    

Job
If the selected account is an income, expense, cost of sales, other income or other expense account, you 
can assign the amount to a job (see Jobs List).    Type the job number and press Tab.    If you are unsure 
of the job number, press Ctrl-L to see the job list.    Select a job from the job list or click New Job to create 
a new one. 

Note:    If you need to assign an amount from a single account to more than one job, enter the account 
more than one time.    Say, for example, you have a $100 credit to widget sales and you need to assign 
$30 to job 12 and $70 to job 43.    Enter two credits to widget sales, one for $30 and the other for $70. 

Out of Balance
Total debits must equal total credits before you can post a General Journal transaction.    If debits are 
more than credits the out of balance amount is displayed beneath the debits column.    If credits outweigh 
debits the out of balance amount is beneath the credits column. 

Record
Total debits must equal total credits before you can record a General Journal transaction.    



Recurring General Journal Transactions
See Recurring General Journal Transactions



Recurring General Journal Transactions

Use General Journal Entry to record recurring general journal transactions.    General Journal transactions
that must be posted time and again - like depreciation or accrued expenses - are best saved as recurring 
transactions.    When you save a transaction as recurring, M.Y.O.B. Accounting puts a copy of the 
transaction in a separate list of recurring transactions.    Anytime you need to post one, just click Use 
Recurring, verify the date and journal number and post it.    There is no need to reenter the transaction 
detail (although you may if you wish). 

Save as Recurring
Every recurring transaction needs a name.    M.Y.O.B. Accounting keeps the list of recurring ransactions in
alphabetical order.    Enter up to 30 characters.    Additionally, you should specify the frequency of the 
transaction.    If you do, M.Y.O.B. Accounting can include a posting reminder in your To-Do list and, if the 
transaction affects a checking account, adjust for it on your Cash Flow Worksheet. 

Note:    If you save a transaction as recurring with the incorrect name or frequency, do not re-save it.    
Click Use Recurring, select the transaction and click Edit.    Change the name or frequency and click 
Record. 
Note:    Any recurring transaction with a frequency of "Other" is not included in your To-Do List or Cash 
Flow Worksheet. 

Use Recurring
Click Use Recurring and your recurring transactions are displayed alphabetically by name.    M.Y.O.B. 
Accounting lists every transaction frequency, date last recorded and due date.    Due date is calculated by 
taking the last recorded date and adding the number of days in the frequency (adjusted forward for 
nonbusiness days.)    If there is an asterisk after the due date, it means that the transaction is currently 
overdue.    It is for your information only.    M.Y.O.B. Accounting doesnt care if you record it or not.    To 
search for a transaction, type a few letters of its name and press Tab.    Double-click the desired 
transaction or select it (with a single click) and press Return.    The transaction is displayed, ready to be 
modified (if needed) and recorded.

Note:    The memo and transaction detail (accounts, amounts, etc.) of a recurring transaction are the 
same as the last time it was recorded.    The date and journal number change.    Feel free to change any 
entry before recording.    
Note:    You need only save a transaction as recurring once.    You should not save it as recurring every 
time you Record it. 

Changing a Recurring Transaction.
To change a recurring transaction's name or frequency, click Use Recurring, select the transaction and 
click Edit.    To change the detail (memo, accounts, amounts, etc.) of a transaction, wait until the next time 
you need to use it.    When it is displayed, change it before recording.    The next time you use it, the new 
detail will be displayed. 

Deleting a Recurring Transaction.
To delete a recurring transaction from your list, click Use Recurring, select it and click Delete. 

Note:    Deleting a recurring transaction only deletes it from your list of recurring transactions.    All actual 
transactions recorded previously using this recurring transaction are not affected.



Analyze Balance Sheet

Analyze Balance Sheet is a unique M.Y.O.B. Accounting feature that lets you take a look at your balance 
sheet in a variety of ways.

This Year's Actuals Only
This shows the actual account balances and the percent of account type (asset, liability or equity) as of 
the end of the selected month of the current fiscal year.    Click the pie chart icons to see the breakdown of
your asset, liability or equity accounts. 

Last Year's Actuals Only
This shows the actual account balances and the percent of account type (asset, liability or equity) as of 
the end of the selected month of the previous fiscal year.    Click the pie chart icons to see the breakdown 
of your asset, liability or equity accounts. 

Budgets Only
When you budget an asset, liability or equity account, youre telling M.Y.O.B. Accounting the expected 
change in the balance for the month (see Budgets).    When you ask to see a budgeted balance sheet, 
M.Y.O.B. Accounting takes the balance of the account at the beginning of the current fiscal year and adds 
the monthly budgets up to and including the selected month.    It is what your balance sheet would look 
like if your actuals matched your budgets exactly.    Click the pie chart icons to see the budgeted 
breakdown of your asset, liability or equity accounts. 

Actuals vs. Budgets
M.Y.O.B. Accounting compares your actual balance sheet to what your balance sheet would look like if 
your budgets were met every month.    The dollar difference is the actual amount minus the budgeted 
amount.    The percent difference is the dollar difference expressed as a percent of the budgeted amount. 

Note:    The difference between actual and budgets is the actual amount minus the budgeted amount, 
regardless of account type (asset, liability or equity).    A positive difference for an asset or equity account 
is usually good news.    A positive difference for a liability account is probably bad news. 

This Year vs. Last Year
M.Y.O.B. Accounting compares this year's balance sheet with what your balance sheet looked like at the 
same time last year. The dollar difference is this year minus last year.    The percent difference is the dollar
difference expressed as a percent of last year's amount. 

Selected Period
Choose a month by clicking it.    The balance sheet reflects activity as of the end of the month.    If you 
select This Year's Actuals Only, the month is in the current fiscal year.    Select Last Year's Actuals Only 
and it is in the prior fiscal year. 

Levels
You may view your balance sheet at any one of four levels.    If you took advantage of levels when 
building your Chart of Accounts, raising the level number increases the balance sheet detail.    To change 
the level, simply click the level control at the lower left of the window. 

Reselect
To change any selection criteria, click the reselect arrow in the lower left of the window.



Analyze Profit & Loss

What is a Profit & Loss Statement?
A profit & loss statement shows operating results (money in versus money out) over a period of time.    It 
contains income, cost of sales, expense, other income, and other expense accounts.    It adds income and
other income, and subtracts cost of sales, expenses and other expenses to calculate your net profit or 
loss for the period.    (Your net profit or loss is also reflected in the balance sheet in the equity account 
called "Current Year Earnings.") Analyze Profit & Loss is a unique M.Y.O.B. Accounting feature that lets 
you take a look at your Profit & Loss Statement in a variety of ways. 

This Year's Actuals Only
This shows the current fiscal year net activity for the selected period as well as the current year-to-date. 

Last Year's Actuals Only
This shows the previous fiscal year net activity for the selected period as well as the previous year-to-
date. 

Budgets Only
When you budget an income, expense or cost of sales account, youre telling M.Y.O.B. Accounting the 
expected net activity for the month (see Chart of AccountsBudgets).    When you ask to see a budgeted 
Profit & Loss, M.Y.O.B. Accounting adds the monthly budgets for the selected months.    It also displays 
the total budgeted activity for the year-to-date. 

Actuals vs. Budgets
M.Y.O.B. Accounting compares your actual profit & loss activity with your budgeted activity.    The dollar 
difference is the actual amount minus the budgeted amount.    The percent difference is the dollar 
difference expressed as a percent of the budgeted amount. Percent of sales displays the actual and 
budgeted activity in each account as a percent of total actual or budgeted income (which does not include
other income).    Use the radio buttons to jump between the selected period and year-to-date.

Note:    The difference between actual and budgets is the actual amount minus the budgeted amount, 
regardless of account type (income, expense, etc.).    A positive difference for an income account is 
usually good news.    A positive difference for an expense or cost of sales account is probably bad news. 

This Year vs. Last Year
M.Y.O.B. Accounting compares this year's profit & loss statement with what your statement looked like at 
the same time last year. The dollar difference is this year minus last year.    The percent difference is the 
dollar difference expressed as a percent of last year's amount.    Percent of sales displays this year's and 
last year's activity in each account as a percent of total income (which does not include other income) for 
the respective year.    Use the radio buttons to jump between the selected period and year-to-date. 

Selected Period
Choose a single month by clicking it.    Choose a range of months by clicking and dragging.    The profit & 
loss statement reflects activity for the selected months.    If you select This Year's Actuals Only, the month 
is in the current fiscal year.    Select Last Year's Actuals Only and it is in the prior fiscal year. 

Levels
You may view your profit & loss statement at any one of four levels.    If you took advantage of levels when
building your Chart of Accounts, raising the level number increases the profit & loss detail.    To change 
the level, simply click the level control at the lower left of the window. 

Reselect
To change any selection criteria, click the reselect arrow in the lower left of the window.



Finding and Changing a General Journal Entry

Changing a Recurring General Journal Entry
To change a recurring transaction's name or frequency, click Use Recurring, select the transaction and 
click Edit.    To change the detail (memo, accounts, amounts, etc.) of a transaction, wait until the next time
you need to use it.    When it is displayed, change it before recording.    The next time you use it, the new 
detail will be displayed.

Deleting a Recurring General Journal Entry
To delete a recurring transaction from you list, click Use Recurring, select it and click Delete.

Note:    Deleting a recurring transaction only deletes it from your list of recurring transactions.    All actual 
transactions recorded previously using this recurring transaction are not affected.



Glossary of M.Y.O.B. Accounting Terms

Account
Account Number
Accounts Receivable
Accounting Period
Accounts Payable
Accrual Method
Accrued Expenses
Aging: Payables
Aging: Receivables
Allocation Accounts
Assets
Audit Trail
Bad Debt
Balance
Balance Sheet
Budgets
Cash Disbursements
Cash Drawer
Cash Flow
Cash Method
Cash Receipts
Chart of Accounts
Cleared
Closed Period
Closed Purchases
Closed Sales
Company Information
Contact Log
Contra Account
Conversion Month
Cost: Item
Cost of Sales
Credit Amount
Credit Invoice
Credit Terms
Current Assets
Current Liabilities
Current Year Earnings
Customer
Debit
Debit Purchase
Deposits: From Customers
Deductions
Deposits: To Vendors
Depreciation
Detail Accounts
Disbursements: Cash
Discount Days
Discount: Early Payment
Discount: Volume Purchase
Double-Entry Accounting
Earnings
Employer Expenses
Equity

Historical Sale
Identifier
Income
Income Statement
Inquiry
Inventory
Invoice
Item
Item Invoice
Item Purchase Order
Job
Journal
Liability
Linked Account
Long-Term Liability
Net Income
Net Profit (Loss)
Non-Cash Wages
Opening Balance
Open Purchase
Open Sale
Operating Profit
Other Expenses
Other Income
Other Purchases
Other Sales
Out of Balance
Paid In Capital
Par Value
Payables
Pending Invoice
Pending Purchase
Period-End Processing
Point-of-Sale System
Prepaid Expenses
Primary Vendor
Profit
Profit & Loss Statement
Profit Center
Promised Date
Purchase Order
Purging
Recap Transaction
Receipts, Cash
Receivables
Reconciling
Recontact Date
Recurring Transaction
Retained Earnings
Revenue
Reversing
Sales History
SDI
Service Invoice



Expense
Federal Tax ID #
Federal Wages
FICA
Finance Charge
Financial Statements
Fiscal Year
Fixed Assets
FUTA
General Journal
General Ledger
Gross Profit
Header Account
Historical Balance
Historical Purchases

Service Purchase Order
Settle a Credit Invoice
Settle a Debit Purchase
Shareholder's Equity
Start a New Year
Terms
Transaction
Trial Balance
Vendor
Wages
W-2s
Year End

Account Accounts are the categories you want to use to organize your business.    Accounts in    M.Y.O.B.
Accounting are in one of eight categories:    asset, liability, equity, income, cost of sales, expense, other 
income, other expense.



Account Number The account number is what identifies an account.    Each M.Y.O.B. Accounting 
account must have a unique number.



Accounts Receivable What someone else owes you for items or services delivered.    In M.Y.O.B. 
Accounting, accounts receivable is an asset account.    Anytime you record a sale in the Sales & 
Receivables command center, the unpaid balance of the sale is added to your accounts receivable 
balance.

Every time you enter a customer payment (using Apply a Payment in the Sales & Receivables command 
center), the amount is subtracted from your accounts receivable balance.



Accounting Period A subset of your fiscal year.    M.Y.O.B. Accounting treats each calendar month as a 
separate accounting period.    Additionally, M.Y.O.B. Accounting provides an optional 13th period for year-
end adjustments.



Accounts Payable What you owe someone else for items or services delivered.    In M.Y.O.B. 
Accounting, accounts payable is a liability account.    Anytime you record a purchase in the Purchases & 
Payables command center, the unpaid balance of the purchase is added to your accounts payable.

Every time you pay a bill (using Make a Payment in the Purchases & Payables command center), the 
amount is subtracted from your accounts payable balance.



Accrual Method This is a method of accounting which records the sale or purchase of goods and 
services at the time they're delivered, not at the time they're paid for.



Accrued Expenses These are expenses for goods or services received, but not yet billed.    Once billed 
they become a payable.



Aging: Payables The number of days between receiving a bill from a vendor and an aging date (usually 
today).



Aging: Receivables The number of days between invoicing a customer and an aging date (usually 
today).



Allocation Accounts In M.Y.O.B. Accounting, when writing a check or recording a deposit, the allocation 
accounts are the expense, income, etc. accounts that balance the transaction.



Assets Assets are things you own.    Your checking account is an asset.    So is your computer.    If 
someone owes you money, it too is an asset.

Assets that can be turned into cash within a relatively short period of time (less than a year) are called 
current assets.    Things that take longer to turn into cash, like your factory building, are called fixed 
assets.

Assets normally have a debit balance.



Audit Trail A list of the transactions that make up the balance of an account or accounts.



Bad Debt Money owed to you that has a very slim chance of being paid back.    Many businesses create 
a contra-asset account to approximate the value of their bad debt.    That way, they have a clearer picture 
of the actual value of their assets.



Balance The sum of all the money added to and subtracted from an account.



Balance Sheet The balance sheet is a financial snapshot of a company's condition at a single point in 
time.    A balance sheet contains a listing of the company's asset, liability and equity accounts.

It is called a balance sheet because the total value of the asset accounts always equals the total value of 
the liability and equity accounts.



Budgets Expected monthly net activity for an account.    Budgets are useful for planning for the future and
analyzing actual performance against planned performance.



Cash Disbursements Money out.    All money entered in Write Checks, Paid Today (Purchases), Make a 
Payment, and Write a Refund Check (Settle Credits) is recorded as a cash disbursement and entered in 
the Cash Disbursement Journal.



Cash Drawer Where the money is kept between leaving the customer's hands and being deposited in the
bank.    Many businesses set up their cash drawer as an asset account.



Cash Flow The net flow of money in minus money out over a selected date range.



Cash Method The opposite of the accrual method of accounting.    The cash method records the sale or 
purchase of goods and services at the time they're paid for, not when they're delivered.



Cash Receipts Money in.    All money entered in Make a Deposit, Paid Today (Sales), Apply a Payment, 
and Deposit a Refund Check (Settle Debits) is recorded as a cash receipt and entered in the Cash 
Receipts Journal.



Chart of Accounts A listing of all your asset, liability, equity, income, cost of sales, expense, other 
income, and other expense accounts.



Cleared A check or deposit is cleared when your bank adjusts you account balance for it.



Closed Period An accounting period in which all entries are completed.    M.Y.O.B. Accounting does not 
require that you actively close a period.    However, in Customize M.Y.O.B. you can prevent accidental 
posting to a closed period.



Closed Purchases Purchases that have been paid in full.



Closed Sales Sales that have been paid in full.



Company Information Found in Set Up M.Y.O.B., your company information contains your company's 
name, address, tax IDs and information about your company's fiscal year.



Contact Log A record of contacts for each card in the Card File.



Contra Account An account that normally carries the opposite balance of the accounts of the same type. 
Assets, for example, normally have a debit balance.    A common contra-asset account is the accrued 
depreciation of an asset.

By using a contra account, you can show a company car that's worth $12,000 by listing the asset at its 
$15,000 purchase price followed by the -$3,000 balance of the accrued depreciation account.



Conversion Month The month in which you start entering transactions in M.Y.O.B. Accounting



Cost: Item The cost of an inventory item.    M.Y.O.B. Accounting uses average cost.    That is, it totals the 
cost of all your purchases of the items currently on hand and divides by the number of items.



Cost of Sales Sometimes called cost of goods sold, this account type works just like an expense 
account.    The only difference is where it appears on the profit & loss statement.    Cost of sales accounts 
appear after your income accounts, but before your expense account.    Cost of sales is subtracted from 
your income to produce gross profit    Your expenses are subtracted from your gross profit to produce net 
profit.

In M.Y.O.B. Accounting, you are not required to use cost of sales accounts.



Credit Amount On the right side of the ledger (a debit amount occupies the left side), a credit amount 
increases the balance of accounts with a credit balance and decreases the balance of accounts with a 
debit balance.

Accounts that normally carry a credit balance are liability, equity and income accounts.



Credit Invoice In M.Y.O.B. Accounting, a credit invoice is a sale with a negative balance due.

Usually caused by a return or adjustment, a credit invoice is settled by using Settle Credits.    There you 
can write the customer a refund check or apply the amount to another open receivable.



Credit Terms Terms are the agreed-upon rules governing the number of days between delivery and 
payment, discounts for early payment and penalties for late payment.

In M.Y.O.B. Accounting, you can set default terms for all customers when entering your linked receivables
accounts in Set Up M.Y.O.B.    Enter the default terms for your vendors when you enter your linked 
payables accounts.

You can override the default terms in each individual card.



Current Assets Assets that can be turned into cash within a relatively short period of time (less than a 
year) are called current assets.

Some of your current assets are your checking and savings accounts, accounts receivable and petty 
cash.    Current assets usually do not lose their value over time.

Current assets normally have a debit balance.    As a general rule, the more current an asset is, the closer
it is to the beginning of your chart of accounts.



Current Liabilities Liabilities that become payable within the next year are called current liabilities.

When recording a liability that is to be paid back over the next few years, many accountants split it into 
two liabilities.    The part that is to be paid off within the next year is entered as a current liability, the 
remaining is entered as a separate long-term liability.



Current Year Earnings Current year earnings is an equity type account.    Its balance equals your income
minus cost of sales and expenses.    Current year earnings are zero at the beginning of a fiscal year.    As 
the fiscal year progresses, current year earnings are kept as a running total.

When you start a new fiscal year, current year earnings is reset to zero by moving its balance into the 
account called Retained Earnings.



Customer Someone to whom you sell goods or services.    In M.Y.O.B. Accounting, you must enter a 
customer card before you can track a receivable balance.



Debit On the left side of the ledger (the credit amount occupies the right side), a debit amount increases 
the balance of accounts with a debit balance and decreases the balance of accounts with a credit 
balance.

Accounts that normally carry a debit balance are assets and expense accounts.



Debit Purchase In M.Y.O.B. Accounting, a debit purchase is a bill with a negative balance due.

Usually caused by a return or adjustment, a debit purchase is settled by using Settle Debits.    There you 
can deposit a vendor's refund check or apply the amount to another open payable.



Deductions    Amounts, other than taxes, taken out of an employee's paycheck (either voluntarily or 
involuntarily).



Deposits: From Customers Advances received for goods or services not yet delivered.    Customer 
deposits are kept in a liability type account.

When a customer makes a payment against a pending sale, M.Y.O.B. Accounting treats it as a deposit.



Deposits: To Vendors Advances paid to vendors for goods or services not yet delivered.    Vendor 
deposits are kept in an asset type account.



Depreciation The expense allocation of the cost of an asset over a period of time.

Most accountants create a contra-asset account to track the depreciation of an asset.    See Contra 
Account.

A typical depreciation transaction credits the contra-asset account and debits a depreciation expense 
account.    Depreciation is most often recorded as a general journal entry.



Detail Accounts An M.Y.O.B. Accounting account to which transactions can be assigned.



Disbursements: Cash Money out.    All money entered in Write Checks, Paid Today (Purchases), Make a
Payment, and Write a Refund Check (Settle Credits) is recorded as a cash disbursement and entered in 
the Cash Disbursements journal.



Discount Days The number of days from a sale or purchase within which full payment of the balance due
entitles the payee to a discount.



Discount: Early Payment The amount taken off the balance due in return for payment within an agreed 
upon number of days.



Discount: Volume Purchase The amount taken off an item's cost because of a special vendor or 
customer arrangement.



Double-Entry Accounting A method of bookkeeping in which every entry is balanced by another entry.

Correct double-entry accounting always provides a balanced set of books; that is, the total value of your 
asset accounts will equal the total value of your liability and equity accounts.



Earnings Income minus cost of sales and expenses.    See Current Year Earnings.



Employer Expenses Costs regarding employees paid by the employer (and not deducted from the 
employee's paycheck), such as matching payroll taxes and the employer's portion of benefits.



Equity A company's net worth.    The equity portion of a company equals its assets minus its liabilities.

Equity is an account type in M.Y.O.B. Accounting    It usually carries a credit balance.    Some common 
equity accounts are current year earnings, retained earnings and shareholder's equity.



Expense The cost associated with running a business.    Expense is an account type in M.Y.O.B. 
Accounting    It usually carried a debit balance.



Federal Tax ID # Also called Employer ID#.    It's the number assigned your company by the Internal 
Revenue Service for tax reporting purposes.



Federal Wages Those wages subject to Federal Income Tax.



FICA US Social Security taxes (and Employer Expenses).    Sometimes also called FOAI, FMED, and/or 
FSOC.



Finance Charge The amount added to an outstanding balance as a penalty for late payment.



Financial Statements The balance sheet and income (profit & loss) statement.    The balance sheet is 
your company's financial picture at a single point in time.    The income statement shows your company's 
financial performance over a period of time.



Fiscal Year The 12-month period you use to define your accounting year.    M.Y.O.B. Accounting does not 
require that it match the calendar year.    M.Y.O.B. Accounting also provides an optional 13th period for 
making year-end adjustments that you do not want to affect a particular month.



Fixed Assets Assets which have a relatively long life.    Your buildings, cars and computers are fixed 
assets.

Fixed assets are usually depreciated; that is, they lose some of their value as you use them.



FUTA Federal Unemployment Tax.    The FUTA rate shown in the IRS's "Circular E" may be reduced by 
the amount you pay in State Unemployment taxes.



General Journal A journal is a helpful organizing tool.    It ties like transactions together for ease of 
access.    In M.Y.O.B. Accounting, the general journal keeps transactions that do not belong in the Sales, 
Purchases, Inventory, Cash Disbursements, or Cash Receipts journals.



General Ledger This is where all your account information - sales, purchases, inventory, cash in, cash 
out - come together.    You draw your financial statements - balance sheet and income statement -    from 
the general ledger.



Gross Profit Gross profit is your income minus cost of sales.



Header Account A header account in M.Y.O.B. Accounting is used to group other accounts together for 
reporting clarity.

You may not post a transaction to a header account.



Historical Balance The balance of an account prior to converting your records to M.Y.O.B. Accounting

You are not required to enter historical balances in M.Y.O.B. Accounting    Enter them only if you wish to 
compare a current month's activity to the activity for the same month last year.

Historical balances are entered by clicking a button at the bottom of the Chart of Accounts window.



Historical Purchases A purchase made prior to using the Purchases & Payables command center in 
M.Y.O.B. Accounting

M.Y.O.B. Accounting requires that you enter the historical purchases that make up the current balance of 
the linked payables account before you can use the Purchases & Payables command center.



Historical Sale A sale made prior to using the Sales & Receivables command center in M.Y.O.B. 
Accounting

M.Y.O.B. Accounting requires that you enter the historical sales that make up the current balance of the 
linked receivables account before you can use the Sales & Receivables command center.



Identifier A one-letter code used to sort and select cards in the card file.

M.Y.O.B. Accounting lets you assign up to 26 identifiers to a card.



Income Revenue from the sale of goods or services.    Income is an account type in M.Y.O.B. Accounting  
It usually carries a credit balance.



Income Statement Also called a profit & loss statement, the income statement shows your company's 
performance over a period of time.
An M.Y.O.B. Accounting income statement begins with income.    It then subtracts cost of sales to produce
a gross profit.    Expenses are subtracted from gross profit to produce operating profit.    Other income 
accounts are added to operating profit and other expense accounts are subtracted from operating profit to
produce net profit.



Inquiry A menu provided by M.Y.O.B. Accounting to facilitate searching for a transaction.

Inquiry displays are for searching only.    They should not be confused with trial balance, receivables or 
payables reports.



Inventory Physical items kept for possible sale to a customer.    Most accountants record an inventory's 
value in a current asset account.



Invoice The written record of a sale.

M.Y.O.B. Accounting handles two types of invoices: item or service.    An item invoice is used to sell things
on your items list.    A service invoice is used to sell things not on your items list.



Item A unit in M.Y.O.B. Accounting's items list.    An item can be physical inventory, like a widget or a pair 
of shoes, or it can be non-physical like an hour of your time.



Item Invoice The written record of a sale of something on M.Y.O.B. Accounting's items list.



Item Purchase Order The written record of a purchase of something on M.Y.O.B. Accounting's items list.



Job Something for which you wish to track income and expenses.    In M.Y.O.B. Accounting, a job can be 
a profit center, a product line or any other subset of your business that requires a separate income 
statement.



Journal A journal is a tool for organizing your accounting entries.    M.Y.O.B. Accounting groups all entries
into one of six journals: General, Cash Disbursements, Cash Receipts, Sales & Receivables, Purchases 
& Payables, or Inventory.

A journal is simply a helpful organizing tool - nothing more or less.



Liability Liabilities are things you owe.    Your working capital loan is a liability.    Your accounts payable, 
what you owe someone for a purchase, is also a liability.

Liabilities that are due within the next year are called current liabilities.    When a liability is not due for 
more than a year, it is called a long-term liability.

Liabilities normally have a credit balance.



Linked Account Linked accounts are what M.Y.O.B. Accounting uses to post your inventory, sales and 
purchase transactions to the proper account.    When, for example, you link your receivables account, you 
are telling M.Y.O.B. Accounting which account to post the balance due from a sale.



Long-Term Liability Something you owe that does not have to paid for at least a year.



Net Income The total of all income accounts minus the sum of your expense and cost of sales accounts.  
Also called Net Profit (Loss).



Net Profit (Loss) The total of all income accounts minus the sum of your expense and cost of sales 
accounts.    Also called Net Income.



Non-Cash Wages Taxable income to the employee which is not included in the employee's check.    
Included are taxable fringe benefits which must have taxes withheld, but for which the employee receives 
no payment and Tips (for Federal tax reporting purposes).    



Opening Balance The dollar value of an account as of your conversion to M.Y.O.B. Accounting

Opening balances are entered in Set Up M.Y.O.B. Accounting    They must balance - total assets must 
equal the total of liabilities plus equity - before you can use M.Y.O.B. Accounting



Open Purchase A purchase with an outstanding balance due.



Open Sale A sale with an outstanding balance due.



Operating Profit Your profit before considering account types other income and other expense.



Other Expenses An M.Y.O.B. Accounting account type used to record expenses that are not directly 
related to your company's operations.

Use other expense accounts to record expenses that are outside the normal operation of your business, 
such as loan interest, fines, etc.    When you look at your P&L, M.Y.O.B. Accounting removes these costs 
from the operating costs and gives you a clearer picture of your operations.

Other expense accounts usually have a debit balance.



Other Income An M.Y.O.B. Accounting account type used to record income that is not directly related to 
your company's operations.

Use other income accounts to record income that is outside the normal operation of your business, such 
as interest income.    When you look at your P&L, M.Y.O.B. Accounting removes this income from your 
operating income and gives you a clearer picture of your operations.

Other income accounts usually have a credit balance.



Other Purchases Used in M.Y.O.B. Accounting to record non-item purchases that do not require a 
printed purchase order.



Other Sales Used in M.Y.O.B. Accounting to record non-item sales that do not require a printed invoice.



Out of Balance When the total credit amount does not equal the total debit amount in a transaction, it is 
out of balance.

M.Y.O.B. Accounting does not allow you to record an out of balance transaction.



Paid In Capital The amount of money paid by shareholders in excess of the par value of the stock.



Par Value The face value of a share of stock in a company.    Most times it has very little to do with the 
actual value of the stock.



Payables What you owe someone else for items or services delivered.    In M.Y.O.B. Accounting, 
accounts payable is a liability account.    Anytime you record a purchase in the Purchases & Payables 
command center, the unpaid balance of the purchase is added to your accounts payable.

Every time you pay a bill (using Make a Payment in the Purchases & Payables command center), the 
amount is subtracted from your accounts payable balance.



Pending Invoice In M.Y.O.B. Accounting, when you make a sale but have not yet delivered the goods or 
services, you can enter a pending invoice.

A pending invoice does not record the sale, nor does it decrement your inventory.    It simply keeps the 
invoice on file to be recorded when the goods or services are delivered.

A payment applied to a pending invoice is treated as a deposit.



Pending Purchase In M.Y.O.B. Accounting, when you make a purchase but have not yet received the 
goods or services, you can enter a pending purchase.

A pending purchase does not record the purchase, nor does it increment your inventory.    It simply keeps 
the purchase on file to be recorded when the goods or services are delivered.

A payment applied to a pending purchase is treated as a deposit.



Period-End Processing The steps taken when all entries have been made for a given month.    In 
M.Y.O.B. Accounting, these steps include:

1. Reconcile your bank accounts
2. Use the trial balance to verify your entries
3. Print your financial statements
4. Back up your data
5. Change the accidental posting month in Customize M.Y.O.B.



Point-of-Sale System Entering and printing invoices as they are made to the customer.

In Customize M.Y.O.B. there is a checkbox for printing invoices as they are recorded.



Prepaid Expenses Something you pay for (usually a service) in advance of receiving it.    Prepaid 
expenses are assets.

A good example of a prepaid expense is your insurance payment.    Say your insurance costs $100 per 
month.    At the beginning of the year, you pay $1,200 for a year's insurance.    The $1,200 is a prepaid 
expense and is recorded as an asset.    Every month, as you use up your insurance, you need to move 
$100 from the prepaid expense asset account to your insurance expense account.



Primary Vendor In M.Y.O.B. Accounting, the primary vendor is the vendor from which you usually 
purchase a particular item.

When your To Do list says that you're running low on an item, if the item has a primary vendor, click the 
arrow and M.Y.O.B. Accounting automatically creates a purchase order.



Profit Profit takes a few forms:

The total of all income accounts minus your cost of sales is called your gross profit.

The total of all income accounts minus your cost of sales and your expenses is called your operating 
profit.

When you subtract other expenses and add other income to operating profit you have net profit.



Profit & Loss Statement Also called an income statement, the profit & loss statement shows your 
company's performance over a period of time.

An M.Y.O.B. Accounting profit & loss statement begins with income.    It then subtracts cost of sales to 
produce a gross profit.    Expenses are subtracted from gross profit to produce operating profit.    Other 
income accounts are added to operating profit and other expense accounts are subtracted from operating
profit to produce net profit.



Profit Center A subset of your business for which you want to track income and expenses.    M.Y.O.B. 
Accounting calls profit centers jobs.



Promised Date The date a pending sale or pending purchase is due to be delivered.
If a pending sale is not delivered as of its promised date, a reminder is posted to M.Y.O.B. Accounting's To
Do List.



Purchase Order The written record of a purchase from a vendor.

M.Y.O.B. Accounting handles two types of purchase orders: item or service.    An item purchase order is 
used to buy things on your items list.    A service purchase order is used to buy things not on your items 
list.



Purging The act of erasing old data.    M.Y.O.B. Accounting allows you to purge journal entries, closed 
sales, closed purchases, and contact logs.



Recap Transaction An M.Y.O.B. Accounting function that lets you look at a journal entry before it is 
recorded.    Recap Transaction is particularly useful for those transactions, like invoices and purchase 
orders, for which the journal entry is not immediately obvious.

Recap Transaction is found in the Inquiry menu.



Receipts, Cash Money in.    All money entered in Make a Deposit, Paid Today (Sales), Apply a Payment, 
and Deposit a Refund Check (Settle Debits) is recorded as a cash receipt and entered in the Cash 
Receipts journal.



Receivables What someone else owes you for items or services delivered.    In M.Y.O.B. Accounting 
receivables are kept in an asset account.    Anytime you record a sale in the Sales & Receivables 
command center, the unpaid balance of the sale is added to your receivables account.

Every time you enter a customer payment (using Apply a Payment in the Sales & Receivables command 
center), the amount is subtracted from your receivables account.



Reconciling The process of checking that your records agree with your bank's records.



Recontact Date In M.Y.O.B. Accounting's Contact Log the recontact date is the date you promised to get 
back in touch with the person.

Once the recontact is made you should erase the recontact date from the contact log record.    Otherwise, 
it will show up in your To Do List.



Recurring Transaction An accounting entry that is made periodically, such as weekly payroll, monthly 
rent, etc.

M.Y.O.B. Accounting allows you to set up recurring checks, deposits and general journal entries.



Retained Earnings Money from previous year's earnings that has been left in the company.

At the end of a fiscal year any money earned (or lost) during the fiscal year is transferred to retained 
earnings.

Retained earnings is an equity account.



Revenue Income from the sale of goods or services.    Revenue is recorded in an income account in 
M.Y.O.B. Accounting    Income accounts usually carry a credit balance.



Reversing The process of counteracting a mistaken transaction by entering a new transaction with the 
same amounts, but with opposite signs.



Sales History M.Y.O.B. Accounting retains monthly sales figures for an item, customer or salesperson.    
Check Track Sales History in the item or card information window.



SDI State Disability Income tax and/or Employer Expense.



Service Invoice The written record of a sale of something not on M.Y.O.B. Accounting's items list.



Service Purchase Order The written record of a purchase of something not on M.Y.O.B. Accounting's 
items list.



Settle a Credit Invoice When someone returns something, you record an invoice that has a negative 
balance due.    It is called a credit invoice.    Paying off this negative amount is called settling a credit 
invoice.

Use Settle Credits to either write a refund check or apply the amount to another open invoice.



Settle a Debit Purchase When you return something to a vendor, you must record a purchase that has a 
negative balance due.    It is called a debit purchase.    Paying off this negative amount is called settling a 
debit purchase.

Use Settle Debits to either deposit the vendor's refund check or apply the amount to another open 
purchase.



Shareholder's Equity The owner's stake in the company.    It is comprised of the amount the owners 
invested in the company plus the current year earnings and retained earnings.



Start a New Year After all transactions for a fiscal year have been entered, you must start a new fiscal 
year.

In addition to clearing out your old transactions, starting a new year moves the balance of current year 
earnings to retained earnings a resets the balance of your income, cost of sales and expense accounts to
zero.



Terms Terms are the agreed upon rules governing the number of days between delivery and payment, 
discounts for early payment and penalties for late payment.

In M.Y.O.B. Accounting, you can set default terms for all your customers when you enter your linked 
receivables accounts in Setup M.Y.O.B.    Likewise, you can enter the default terms between you and your
vendors when you enter your linked payables accounts.



Transaction An entry in M.Y.O.B. Accounting that affects an account or accounts.



Trial Balance This is a report showing all the activity for an account or accounts within a selected date 
range.    It shows the balance of the account at the beginning of the date range, the activity within the date
range, and the balance at the end of the date range.

The trial balance is a useful tool for checking your entries prior to doing your period-end processing.



Vendor Someone from whom you buy goods or services.    In M.Y.O.B. Accounting you must enter a 
vendor card before you can track a payable balance.



Wages Money paid to employees for work done, including salaries, hourly earnings, bonuses, 
commissions, and other employee income.



W-2s The end-of-year form containing payroll information which all employers are required to give to their
employees and the taxation authorities



Year End The end of your fiscal year.    It does not necessarily match the end of the calendar year.    See 
Start a New Year.



Exporting - Overview

M.Y.O.B. Small Business Accounting can export its data to tab delimited or comma delimited files.    This 
function is similar to M.Y.O.B. Accounting's ability to export reports to a disk file, but here you are 
exporting raw data that is to be imported into another M.Y.O.B. Accounting data file or any other program 
that accepts tab delimited or comma delimited files.

You can export:
Accounts
Inventory Items
Customer Cards
Vendor Cards
Employee Cards
Personal Cards
Journal Entries *
Other Sales **
Other Purchases **
TAL (Timeslips) Chart of Accounts

* Although M.Y.O.B. Accounting exports all types of journals, when importing (see following section) all journal 
entries go into the general journal.

** M.Y.O.B. Accounting exports just those entries made in Other Sales and Other Purchases.    It does not export 
(or import) entries made in Invoice Sales or Purchase Orders.

You can export to either a tab delimited or comma delimited file.    This information can then be imported 
into another M.Y.O.B. Accounting data file, or into any other program which accepts one of these formats.

To export, select Export from the File menu, and select the desired export data from the Export sub-menu.
The Export File Dialog appears.

See Also
Fields in Import/Export Files



Export File

Export File Format:
Choose whether you want the exported file to be in Tab Delimited or Comma Delimited format.    M.Y.O.B. 
Accounting will import either format.    Check with your other software to see which of these formats it 
accepts.

First Record is:
Choose whether you want the first record exported to be a Header Record or a Data Record.    If you 
choose Header Record, M.Y.O.B. Accounting will export a first record of titles describing the contents of 
each field before it exports the data records.    This might be useful in a spreadsheet, for example, or for 
matching fields when importing into another M.Y.O.B. Accounting data file.

Additional Selection Criteria:
Depending upon the type of data, you may be presented with additional selection criteria:

Chart of Accounts Year Choose account balances from this year or last year.
Period Choose the period.    The account balance exported is as

of the end of the selected period. 

Inventory Items None No additional selection criteria.    M.Y.O.B. Accounting 
exports the entire items list.

Cards Identifiers Enter (optionally) one or more identifiers.    If you enter 
more than one identifier, M.Y.O.B. Accounting chooses 
only those customers that have every identifier entered.

Zip Code Enter (optionally) a zip code or partial zip code.    
M.Y.O.B. Accounting will export only those cards with 
matching zip codes.    If you enter a partial zip code, 
M.Y.O.B. Accounting will choose only those cards with 
zip codes that begin with those numbers.

Journal Entries Journal Type Choose to export General Journal, Cash Disbursements 
Journal, Cash Receipts Journal, Sales & Receivables 
Journal, Purchases & Payables Journal, Inventory 
Journal or All Journals

Date Range Enter (optionally) a range of dates.    M.Y.O.B. 
Accounting will export only those journal entries made 
on or between those dates.

Other Sales Identifiers Enter (optionally) one or more identifiers.    If you enter 
more than one identifier, M.Y.O.B. Accounting chooses 
the sales made to only those customers that have every 
identifier entered.

Date Range Enter (optionally) a range of dates.    M.Y.O.B. 
Accounting will export only those sales entries made on 
or between those dates.

Other Purchases Identifiers Enter (optionally) one or more identifiers.    If you enter 
more than one identifier, M.Y.O.B. Accounting chooses 
the sales made to only those customers that have every 
identifier entered.

Date Range Enter (optionally) a range of dates.    M.Y.O.B. 
Accounting will export only those sales entries made on 
or between those dates.

Continue



Click Continue after you've made your selections.    The Export Data dialog appears, where you can 
choose which fields to export, and in which order.

See Also
Fields in Import/Export Files



Export Data

The M.Y.O.B. Accounting Fields column lists all the fields that can be exported.    An asterisk appears to 
the left of the names of all fields that M.Y.O.B. Accounting requires when importing.    (If you plan to import
this information into another M.Y.O.B. Accounting data file, be sure to select at least these fields.)

Click the field names in the M.Y.O.B. Accounting Fields column in the order that you wish to export them.   
The current list of field names in the order you've selected them appears on the left, in the Export Fields 
column.    To remove a field name from your list, click its name in the M.Y.O.B. Accounting Fields column a
second time.

When you've selected a field name, its field position in your selection list will appear in the Export Order 
column.

Match All
Click Match All if you want to export all the M.Y.O.B. Accounting Fields in the order shown.

Unmatch All
Click Unmatch All to remove all your selections so far.

Export
Click Export after you've selected and ordered all the fields to be exported.    The standard file dialog 
appears.    Name your export file, decide where you want to save it, and click Save.

See Also
Fields in Import/Export Files



Importing

M.Y.O.B. Small Business Accounting can import data from another M.Y.O.B. Accounting data file or from 
any tab delimited or comma delimited file.

You can import:
Accounts
Inventory Items
Customer Cards
Vendor Cards
Employee Cards
Personal Cards
General Journal Entries *
Other Sales **
Other Purchases **
TAL (Timeslips Accounting Link) G/J Entries

* M.Y.O.B. Accounting imports all journal entries into the General Journal.

** M.Y.O.B. Accounting imports into Other Sales and Other Purchases.    It does not import transactions into 
Invoice Sales or Purchase Orders.

To import, select Import from the File menu, and select the desired data type from the Import sub-menu.    
The Import File dialog appears.

See Also
Fields in Import/Export Files
Import Errors and Warnings



Import File

Import File Format
Choose whether the file to be imported is in Tab Delimited or Comma Delimited format.

First Record is...
Choose whether the first record of the file to be imported is a Header Record or a Data Record.    A 
header record is a record containing the titles of the data fields.    If you choose Header Record, M.Y.O.B. 
Accounting will not import the first record of the import file.    It will use the header information to help you 
match the import data fields with the appropriate M.Y.O.B. Accounting data fields.

Additional Selection Criteria:
Accounts Duplicate Records The Chart of Accounts does not allow duplicate account 

numbers.    If, while importing, M.Y.O.B. Accounting 
encounters a duplicate account number, it needs to 
know whether you want to reject the record or update 
the existing account information with the new account 
information from your import file.

If you choose to reject duplicate accounts, the rejected 
records will be written to the file MYOBLOG.TXT.    (see 
Import Errors and Warnings).

Inventory Items Duplicate Records The Items List does not allow duplicate item numbers.    
If, while importing, M.Y.O.B. Accounting encounters a 
duplicate item number, it needs to know whether you 
want to reject the record or update the existing item 
information with the new item information from your 
import file.

If you choose to reject duplicate items, the rejected 
records will be written to the file MYOBLOG.TXT.    (see 
Import Errors and Warnings).

Cards Duplicate Records The Card file does allow duplicate card names.    If, while
importing, M.Y.O.B. Accounting encounters a duplicate 
card name, it needs to know whether you want to reject 
the record, update the matching card with the new card 
information from your import file, or add the card to your 
card file.

If you choose to reject duplicate cards, the rejected 
records will be written to the file MYOBLOG.TXT.    (see 
Import Errors and Warnings).

Journal Entries None No additional selection criteria.

Other Sales None No additional selection criteria.

Other Purchases None No additional selection criteria.

Continue
Click Continue after you've made your selections.    Next M.Y.O.B. Accounting asks you to locate and 
open your import file.



M.Y.O.B. Accounting reads the first record of the import file and displays the Import Data dialog where you
can match the fields from your import file to the fields in your M.Y.O.B. Accounting data file.

See Also
Fields in Import/Export Files
Import Errors and Warnings



Import Data

First click an import field, then click the matching M.Y.O.B. Accounting field.    The import field name will 
be written to the right of the M.Y.O.B. Accounting field name.    To remove a field, click the M.Y.O.B. 
Accounting field name a second time.    Fields with an asterisk to the left of their names are required by 
M.Y.O.B. Accounting    You must match asterisk fields with a valid import field.

Match All
Click Match All if your import data fields exactly match - line for line - M.Y.O.B. Accounting's fields.    This 
is true if your import file was created by M.Y.O.B. Accounting's export routine.

Import
Click Import after you've matched the fields.    See Import Errors and Warnings for more details.

See Also
Fields in Import/Export Files



Import Errors and Warnings

When importing data, M.Y.O.B. Accounting creates a file MYOBLOG.TXT.    It is a text file - readable by 
most word processors - that lists any problems encountered during the import.    MYOBLOG.TXT is 
written in the same directory as your M.Y.O.B. Accounting data file.    

Note:    MYOBLOG.TXT is overwritten during every import session.    If you wish to save the log, either change its 
name or move it to a directory other than your M.Y.O.B. Accounting data file directory.

MYOBLOG.TXT first lists any record that generated an error or warning.    Each record is preceded by an 
error or warning number.    At the bottom of the log is a summary of the import session.    The summary is 
followed by explanations of the errors or warnings encountered.

Here is a sample MYOBLOG.TXT:

      -5 11100 Checking Account $5,200.00 C 12
      -5 16100 Vehicles, Original Cost $32,000.00
      -2 243000 Accounts Payable $21,000.00

      0 records imported without errors.
      3 records skipped.
      0 records imported with warnings.

      Error -2:    Account Number is too long.
      Error -5:    Duplicate Account Number.

Note:    MYOBLOG.TXT is overwritten during every import session.    If you wish to save the log, either change its 
name or move it to a directory other than your M.Y.O.B. Accounting data file directory.

Suggestion:    If you are having difficulty importing a record and MYOBLOG.TXT is not helping you 
understand the problem, open the actual M.Y.O.B. Accounting data entry window and enter the record 
manually.    The error generated by M.Y.O.B. Accounting may be more explicit than the error in 
MYOBLOG.TXT.

Import Errors
There are 27 things that can cause a record to be rejected by M.Y.O.B. Accounting    These are called 
import errors.    If a record is rejected, the record is written to MYOBLOG.TXT.    The record is preceded by
an error number between -1 and -27.    See A List of Import Errors

Import Warnings
Sometimes M.Y.O.B. Accounting cannot import all the information found in an imported record.    For 
instance, an account name cannot be longer than 30 characters.    When this happens, M.Y.O.B. 
Accounting generates an import warning.    The record is imported, but the warning is written to let you 
know that some information was changed or ignored.    There are 115 import warnings.    Import warnings, 
like import errors, are written to MYOBLOG.TXT.    Each import warning record is preceded by a warning 
number between 1 and 115.    See A List of Import Warnings

See Also
Importing



A List of Import Errors

Error # Description
-1 Account Number may not be blank.
-2 Account Number is too long.
-3 Account Number must be numeric.
-4 First digit of Account Number must be 1,2,3,4,5,6,8, or 9.
-5 Duplicate Account Number.
-6 Item Number may not be blank.
-7 Item Number may not be more than 13 characters.
-8 Item Number contains invalid characters.
-9 Duplicate Item Number.
-10 Invalid date.
-11 Transactions dated before the beginning of your fiscal year may not be imported.
-12 Transactions dated before your conversion date may not be imported.
-13 Transactions dated before your Posting Complete date may not be imported.
-14 Invalid account number.
-15 Account number not found in list of postable accounts.
-16 Invalid debit amount.
-17 Invalid credit amount.
-18 Each line must have debit or credit, but not both.
-19 Unbalanced transaction.
-20 Company Name contains invalid characters.
-21 First Name contains invalid characters.
-22 Last Name contains invalid characters.
-23 Co./Last Name may not be blank.
-24 Duplicate card.
-25 Invalid amount.
-26 Card not found.
-27 A non-zero amount requires an account.

See Also
Importing



A List of Import Warnings

Error # Description
1 Account Name cannot be more than 30 characters; name truncated.
2 Account Name contains invalid characters; name ignored.
3 Last Check Number must be less than 10,000,000; number ignored.
4 Last Check Number must be numeric; number ignored.
5 Opening balances have been verified; balance ignored.
6 Opening balance must be valid currency value; balance ignored.
7 Opening balance may not be set for Current Earnings account; balance ignored.
8 Opening balance may only be set for detail accounts; balance ignored.
9 P&L Opening balances must be $0.00 at the beginning of your fiscal year; balance 

ignored.
10 Cannot specify last check number for account without checking privileges; number 

ignored.
11 Header accounts may not have checking privileges; privileges ignored.
12 Checks/deposits are on file for this account.    Checking privileges may not be removed.
13 This account is being used in Write Checks.    Checking privileges may not be removed.
14 This account is being used in Make Deposits.    Checking privileges may not be removed.
15 This account is being used in Print Checks.    Checking privileges may not be removed.
16 This account is being used in Make a Payment.    Checking privileges may not be 

removed.
17 This account is the default checking account for AR.    Checking privileges may not be 

removed.
18 This account is the default checking account for AP.    Checking privileges may not be 

removed.
19 Level 4 Accounts may not be headers.
20 Accounts with non-zero current balances may not be headers.
21 Accounts with journal entries may not be headers.
22 Accounts with recurring journal entries may not be headers.
23 Accounts linked to inventory items may not be headers.
24 Accounts linked to sales and/or purchases may not be headers.
25 Accounts with non-zero periodic balances may not be headers.
26 Linked accounts may not be headers.
27 The account being used in Count Inventory may not be a header.
28 An account being used in Journal Entry may not be a header.
29 An account being used in Adjust Inventory may not be a header.
30 An account being used in Write Checks may not be a header.
31 An account being used in Make Deposits may not be a header.
32 An account being used in Other Sales may not be a header.
33 An account being used in Other Purchases may not be a header.
34 An account being used in Invoice Sales may not be a header.
35 An account being used in Purchase Orders may not be a header.
36 An account being used in Reconcile Accounts may not be a header.
37 An account being used in Review Before Printing may not be a header.
38 An account being used in Make a Payment may not be a header.
39 Account Name may not be blank; default substituted.
40 Account Name may not be blank; ignored.
41 Company Information must be recorded before balances can be set; balance ignored.
42 Item Name cannot be more than 30 characters; name truncated.
43 Item Name contains invalid characters; name ignored.
44 Invalid Account Number; account ignored.
45 Vendor name too long; name truncated.
46 Vendor name contains invalid characters; name ignored.
47 Vendor number too long; number truncated.
48 Vendor number contains invalid characters; number ignored.



49 Unit of measure too long; unit truncated.
50 Unit of measure contains invalid characters; unit ignored.
51 Items per buying unit must be a number from 1 to 9999; number ignored.
52 Items per selling unit must be a number from 1 to 9999; number ignored.
53 Invalid Reorder Quantity; quantity ignored.
54 Invalid Reorder Level; level ignored.
55 Invalid Selling Price; price ignored.
56 Item Name may not be blank; default substituted.
57 Asset account invalid; item may not be inventoried.
58 Income account invalid; item may not be sold.
59 Expense account invalid; item may not be bought.
60 Cost of Sales account invalid; item may not be sold.
61 Asset Account not found; account ignored.
62 Income Account not found; account ignored.
63 Expense/COS Account not found; account ignored.
64 Income Account must be a P&L account; account ignored.
65 Expense/COS Account must be a P&L account; account ignored.
66 Vendor not found; name ignored.
67 Multiple vendors found; first vendor used. 
68 Tax code not found; default used.
69 Sales history may only be tracked for sold items.
70 Item is not bought; some information ignored.
71 Item is not sold; some information ignored.
72 Item is not inventoried; some information ignored.
73 Item is not inventoried and bought; reorder quantity ignored.
74 # Items per buying unit may only specified for items that are bought and inventoried.
75 # Items per selling unit may only specified for items that are sold and inventoried.
76 # Items per buying unit may not be changed; purchases on file.
77 # Items per selling unit may not be changed; sales on file.
78 Expense account invalid; item is not bought.
79 Cost of Sales account invalid; item is not sold.
80 ID # invalid; default assigned.
81 Memo too long; truncated.
82 Memo contains invalid characters; memo ignored.
83 Job # invalid; job ignored.
84 Job not found; job ignored.
85 Multiple jobs found; first job used.
86 Job allocations for balance sheet accounts invalid; job ignored.
87 Address line too long; truncated.
88 Address line contains invalid characters; ignored.
89 Zip code too long; truncated.
90 Zip code contains invalid characters; ignored.
91 Phone or Fax Number too long; truncated.
92 Phone or Fax Number contains invalid characters; ignored.
93 Salutation too long; truncated.
94 Salutation contains invalid characters; ignored.
95 Contact too long; truncated.
96 Contact contains invalid characters; ignored.
97 Notes too long; truncated.
98 Notes contains invalid characters; ignored.
99 Identifiers too long; truncated.
100 Identifiers contains invalid characters; ignored.
101 Last Name too long; truncated.
102 First Name too long; truncated.
103 Company Name too long; truncated.
104 Address 1 too long; truncated.



105 Address 2 too long; truncated.
106 Tax code too long; truncated.
107 Tax code contains invalid characters; ignored.
108 Tax code not found; ignored.
109 Multiple cards found; first card used.
110 Salesman Name too long; truncated.
111 Invalid characters in Salesman Name; ignored.
112 Salesman not found; ignored.
113 An item may not be changed to \Not Bought\ through importing.
114 An item may not be changed to \Not Sold\ through importing.
115 An item may not be changed to \Not Inventoried\ through importing.
116 Default account for tax not specified; tax code ignored 
117 Accounts linked to employee cards may not be headers.
118 Accounts linked to payroll categories may not be headers.
119 This account is being used in Write Paychecks.    Checking privileges may not be 

removed.
120 An account being used in Write Paychecks may not be a header.
121 Accounts linked to recurring sales or purchases may not be headers.

See Also
Importing



Fields in Import/Export Files

Import/Export Account Fields
Import/Export Item Fields
Import/Export Customer Card Fields
Import/Export Vendor Card Fields
Import/Export Employee Card Fields
Import/Export Personal Card Fields
Import/Export Journal Entry Fields
Import/Export Other Sales Fields
Import/Export Other Purchases Fields

See Also
Importing
Exporting



Import/Export Account Fields

Account Number 5 digits.    May (optionally) have a non-numeric separator between the 
first digit and the last 4 digits (ie. 1-1234).

Account Name 30 characters, alphanumeric.
Header 1 character field.    Any non-blank character signifies that it is a header 

account.
Balance Dollar amount field.    Up to 15 characters (including numbers, dollar 

signs, commas, negative signs).    If no decimal entered, M.Y.O.B. 
Accounting appends .00.    If more than 2 decimals, M.Y.O.B. Accounting 
rounds to nearest cent.

Checking Privileges 1 character field.    Any non-blank character signifies that the account has
checking privileges.

Last Check Number 7 digits.

See Also
Fields in Import/Export Files



Import/Export Item Fields

Item Number 13 character, alphanumeric
Item Name 30 character, alphanumeric
Buy 1 character field.    Any non-blank character signifies that the item is 

bought.
Sell 1 character field.    Any non-blank character signifies that the item is sold.
Inventory 1 character field.    Any non-blank character signifies that the item is 

inventoried.
Asset Acct Linked asset account.    5 digits.    May (optionally) have a non-numeric 

separator between the first digit and the last 4 digits (ie. 1-1234).
Income Acct Linked income account.    5 digits.    May (optionally) have a non-numeric 

separator between the first digit and the last 4 digits (ie. 1-1234).
Expense/COS Acct Linked expense or cost of sales account.    5 digits.    May (optionally) 

have a non-numeric separator between the first digit and the last 4 digits 
(ie. 1-1234).

Primary Vendor 31 characters alphanumeric.    Must match the name of a vendor card in 
your card file.    (If the vendor is an individual, M.Y.O.B. Accounting 
matches on the last name, followed by a comma and a space, followed 
by the first name.)

Vendor Item # 13 characters alphanumeric.
Tax When Bought 1 character field.    Any non-blank character signifies that the item is 

taxable when bought.
Buy Unit Measure 5 characters, alphanumeric.
# Items/Buy Unit 4 digits.
Reorder Quantity 10 digits, including up to 3 decimal places.
Minimum Level 10 digits, including up to 3 decimal places.
Selling Price 10 digits, including up to 3 decimal places.
Sell Unit Measure 5 characters, alphanumeric.
Track Sales History 1 character field.    Any non-blank character signifies that sales history 

should be tracked.
Tax When Sold 1 character field.    Any non-blank character signifies that the item is 

taxable when sold.
# Items/Sell Unit 4 digits.

See Also
Fields in Import/Export Files



Import/Export Customer Card Fields

Co./Last Name If a company name (no first name), up to 31 characters, alphanumeric.    
If a last name, up to 15 characters, alphanumeric.

First Name Up to 15 characters, alphanumeric.
Addr 1 - Line 1 Total address field (lines 1 through 4) cannot exceed 255 character, 

alphanumeric.
                      - Line 2 
                      - Line 3 
                      - Line 4 
                      - Zip Code 10 characters, alphanumeric
Addr 2 - Line 1    Total address field (lines 1 through 4) cannot exceed 255 character, 

alphanumeric.
                      - Line 2 
                      - Line 3 
                      - Line 4 
                      - Zip Code    10 characters, alphanumeric
Phone # 1 21 characters, alphanumeric.
Phone # 2    21 characters, alphanumeric.
Fax #    21 characters, alphanumeric.
Identifiers 10 characters, alpha only.
Salutation 15 characters, alphanumeric.
Contact Name 25 characters, alphanumeric.
Notes 255 characters, alphanumeric.

See Also
Fields in Import/Export Files



Import/Export Vendor Card Fields

Co./Last Name If a company name (no first name), up to 31 characters, alphanumeric.    
If a last name, up to 15 characters, alphanumeric.

First Name Up to 15 characters, alphanumeric.
Addr 1 - Line 1 Total address field (lines 1 through 4) cannot exceed 255 character, 

alphanumeric.
                      - Line 2 
                      - Line 3 
                      - Line 4 
                      - Zip Code 10 characters, alphanumeric
Addr 2 - Line 1    Total address field (lines 1 through 4) cannot exceed 255 character, 

alphanumeric.
                      - Line 2 
                      - Line 3 
                      - Line 4 
                      - Zip Code    10 characters, alphanumeric
Phone # 1 21 characters, alphanumeric.
Phone # 2    21 characters, alphanumeric.
Fax #    21 characters, alphanumeric.
Identifiers 10 characters, alpha only.
Salutation 15 characters, alphanumeric.
Contact Name 25 characters, alphanumeric.
Notes 255 characters, alphanumeric.

See Also
Fields in Import/Export Files



Import/Export Employee Card Fields

Co./Last Name If a company name (no first name), up to 31 characters, alphanumeric.    
If a last name, up to 15 characters, alphanumeric.

First Name Up to 15 characters, alphanumeric.
Addr 1 - Line 1 Total address field (lines 1 through 4) cannot exceed 255 characters, 

alphanumeric.
                      - Line 2 
                      - Line 3 
                      - Line 4 
                      - Zip Code 10 characters, alphanumeric
Phone # 1 21 characters, alphanumeric.
Phone # 2    21 characters, alphanumeric.
Fax #    21 characters, alphanumeric.
Identifiers 10 characters, alpha only.
Salutation 15 characters, alphanumeric.
Notes 255 characters, alphanumeric.

See Also
Fields in Import/Export Files



Import/Export Personal Card Fields

Co./Last Name If a company name (no first name), up to 31 characters, alphanumeric.    
If a last name, up to 15 characters, alphanumeric.

First Name Up to 15 characters, alphanumeric.
Addr 1 - Line 1 Total address field (lines 1 through 4) cannot exceed 255 characters, 

alphanumeric.
                      - Line 2 
                      - Line 3 
                      - Line 4 
                      - Zip Code 10 characters, alphanumeric
Phone # 1 21 characters, alphanumeric.
Phone # 2    21 characters, alphanumeric.
Fax #    21 characters, alphanumeric.
Identifiers 10 characters, alpha only.
Salutation 15 characters, alphanumeric.
Notes 255 characters, alphanumeric.

See Also
Fields in Import/Export Files



Import/Export Journal Entry Fields

Journal Number 8 characters, alphanumeric. 
Date Follows date convention for your system.    Allows any non-numeric as 

separator between months, days, and years.
Memo 255 characters, alphanumeric.
Account Number Must be valid, pre-existing M.Y.O.B. Accounting account number.    5 

digits.    May (optionally) have a non-numeric separator between the first 
digit and the last 4 digits (ie. 1-1234).

Debit Amount Dollar amount field.    Up to 15 characters (including numbers, dollar 
signs, commas, negative signs).    If no decimal entered, M.Y.O.B. 
Accounting appends .00.    If more than 2 decimals, M.Y.O.B. Accounting 
rounds to nearest cent.

Credit Amount Dollar amount field.    Up to 15 characters (including numbers, dollar 
signs, commas, negative signs).    If no decimal entered, M.Y.O.B. 
Accounting appends .00.    If more than 2 decimals, M.Y.O.B. Accounting 
rounds to nearest cent.

Job 5 characters, alphanumeric.    Must match a pre-existing job in your 
M.Y.O.B. Accounting data file.

See Also
Fields in Import/Export Files



Import/Export Other Sales Fields*

Co./Last Name 31 characters, alphanumeric.    Must match a pre-existing customer card 
in your M.Y.O.B. Accounting data file.    (If the customer is an individual, 
M.Y.O.B. Accounting matches on the last name, followed by a comma 
and a space, followed by the first name.)

First Name Up to 15 characters, alphanumeric.
Journal Number 8 characters alphanumeric.
Date Follows date convention for your system.    Allows any non-numeric as 

separator between months, days, and years.
Memo 255 characters, alphanumeric.
Slsmn Last Name If entered as a company name, 31 characters, alphanumeric.        (If the 

employee is an individual, M.Y.O.B. Accounting matches on the last 
name, followed by a comma and a space, followed by the first name.)    
Must match a pre-existing employee card in your M.Y.O.B. Accounting 
data file.

Slsmn First Name Up to 15 characters, alphanumeric.    Must match a pre-existing 
employee card in your M.Y.O.B. Accounting data file.

Account Number 5 digits.    Must match a pre-existing account in your M.Y.O.B. Accounting
data file.

Amount Dollar amount field.    Up to 15 characters (including numbers, dollar 
signs, commas, negative signs).    If no decimal entered, M.Y.O.B. 
Accounting appends .00.    If more than 2 decimals, M.Y.O.B. Accounting 
rounds to nearest cent.

Job 5 characters, alphanumeric.    Must match a pre-existing job in your 
M.Y.O.B. Accounting data file.

* The above information is repeated for every line of the Other Sales entry.    A carriage return ends 
each line in the entry.    An additional carriage return separates each sales entry.    

(M.Y.O.B. Accounting allocates the total for each sales entry to the linked receivables account.    
The customer's receivable balance is also updated.    The Paid Today field cannot be imported.)

See Also
Fields in Import/Export Files



Import/Export Other Purchases Fields **
Co./Last Name 31 characters, alphanumeric.    Must match a pre-existing vendor card in 

your M.Y.O.B. Accounting data file.    (If the vendor is an individual, 
M.Y.O.B. Accounting matches on the last name, followed by a comma 
and a space, followed by the first name.)

First Name Up to 15 characters, alphanumeric.
Journal Number 8 characters alphanumeric.
Date Follows date convention for your system.    Allows any non-numeric as 

separator between months, days, and years.
Memo 255 characters, alphanumeric.
Account Number 5 digits.    Must match a pre-existing account in your M.Y.O.B. Accounting

data file.
Amount Dollar amount field.    Up to 15 characters (including numbers, dollar 

signs, commas, negative signs).    If no decimal entered, M.Y.O.B. 
Accounting appends .00.    If more than 2 decimals, M.Y.O.B. Accounting 
rounds to nearest cent.

Job 5 characters, alphanumeric.    Must match a pre-existing job in your 
M.Y.O.B. Accounting data file.

** The above information is repeated for every line of the Other Purchases entry.    A carriage return 
ends each line in the entry.    An additional carriage return separates each sales entry.    

(M.Y.O.B. Accounting allocates the total for each purchases entry to the linked payables account.    
The vendor's payable balance is also updated.    The Paid Today field cannot be imported.)

See Also
Fields in Import/Export Files



Timeslips™ Accounting Link (TAL)
1.    Install Timeslips III v. 2.1 (or later) with TAL.    
2.    Modify your Chart of Accounts

If you are currently using TimeSlips, make sure youve added your Timeslips accounts to your 
M.Y.O.B. Accounting Chart of Accounts

If youre not already using TimeSlips, youll need to add the following accounts to your M.Y.O.B. 
Accounting Chart of Accounts.    You can do it through Chart of Accounts in the Administration 
Command Center, or selecting Import from the File Menu, choosing Chart of Accounts, and 
specifying    TAL.TXT as the file you wish to import.

Assets
1-0500    TAL Cash    General
1-0510    TAL Cash    Fees
1-0520    TAL Cash    Costs
1-0750    TAL Cash Escrow
1-0800    TAL Accts Receivable    General
1-0810    TAL Accts Receivable    Fees
1-0820    TAL Accts Receivable    Costs

Liabilities
2-0500    TAL Tax Payable    General
2-0510    TAL Tax Payable    Fees
2-0520    TAL Tax Payable    Costs
2-0750    TAL Client Escrow
2-0900    TAL Tax Receivable    General
2-0910    TAL Tax Receivable- Fees
2-0920    TAL Tax Receivable    Costs



Income
4-0500    TAL Charges    General
4-0510    TAL Charges    Fees
4-0520    TAL Charges    Costs
4-0750    TAL Write up    General
4-0760    TAL Write up    Fees
4-0770    TAL Write up    Costs
4-0800    TAL Suspense
4-0900    TAL Interest

Expenses
6-0500    TAL Credit memo
6-0750    TAL Write down    General
6-0760    TAL Write down    Fees
6-0770    TAL Write down    Costs

All of the TAL Specific Accounts are optional.    This guide does not suggest Specific Account 
numbers for the general ledger. Refer to the TAL manual for a detailed explanation of the strategy 
used with Specific Accounts.    The main point to remember about Specific Accounts is that you 
should created them as Income accounts in your general ledger.    When defined, these accounts 
substitute for the Charges accounts in Timeslips General Accounts dialog.

3.    Customize M.Y.O.B. for TAL
From the Administration Command Center, select Customize M.Y.O.B. and click I Use Timeslips 
Accounting Link.    You will be prompted to Export Now or Export Later.    

Once you export your Chart of Accounts to TAL, anytime one of your postable accounts changes, or 
accounts are added or deleted, M.Y.O.B. Accounting will automatically re-export your Chart to TAL.



4.    Link to Timeslips
Start TSReport and open the TAL Setup window.
Choose M.Y.O.B. from the General Ledger pop-up menu.
Complete the rest of the window (optional).    Refer to Chapter 3 in the TAL manual for advice on 
these options.    Click OK.    
Locate the file TAL Chart of Accounts in your MYOB4 subdirectory with the Open File dialog and 
click OK.    TAL will the verify the accounts and remind you if there are missing or invalid accounts.
Open the General Accounts dialog.    Fill it out with the accounts you created earlier in M.Y.O.B. 
Accounting.    You can click Suggest or Suggest All to automatically assign accounts from the 
selected list (on the previous and this page), or fill them in one at a time, starting with Cash 
Comprehensive.
Complete the Specific Accounts dialog (optional).

5.    Transfer Accounting Transactions
Print and finalize the Transfer Register in Timeslips.    Be sure to convert transaction dates to a bonafide 
G/L period date.
Follow Timeslips instructions to export G/J entries to TAL.
The next time you start or switch back to M.Y.O.B. Accounting, you will be asked if you want to Import 
Now or Import Later.    If you Import Now M.Y.O.B. Accounting automatically inputs the entries from TAL.
You can now print reports or do Account Inquiries in M.Y.O.B. Accounting to see the updated account 
balances and transactions.



Inventory

Items List
An item can be a physical unit like a shoe or a can of paint.    But it can also be something like 1 hour of 
consulting.    Create an items list if you want to use M.Y.O.B. Accountings item invoice feature.

Set Item Prices
Set Item Prices is a shortcut to changing current selling prices without having to go to the item information
window for each item.

Inventory Adjustments
Use Inventory Adjustments to enter an opening inventory value or to allocate missing inventory to an 
expense account like shrinkage.

Inventory Transfers
Use Inventory Transfers to record the transformation of    raw material into finished inventory. 

Enter the quantity taken from raw material as a negative.    Then enter the quantity of finished goods 
produced as a positive.    M.Y.O.B. Accounting adjusts the inventory quantities and values.

Auto-Build Inventory
When entering an inventory item that is made up of other inventory items, you can note the sub-items 
needed to build it.    Select Auto-Build to automatically transfer inventory from sub-items to finished 
product.

Count Inventory
Use Count Inventory to enter your physical inventory.    If your count differs from what M.Y.O.B. 
Accounting thinks you have, M.Y.O.B. Accounting prepares an Inventory Adjustment to reconcile the 
difference. 

Note:    Before counting your physical inventory, you may want to print an Inventory Count Sheet report.

Analyze Inventory
M.Y.O.B. Accounting analyzes your items list and produces, for each item, its quantity on hand, quantity 
committed to customers (from your pending sales), and quantity on order from vendors (from your 
pending purchases).



Items List

Item Number
Every item must have a unique number.    Enter up to 13 characters (numbers, letters or symbols) as the 
item number.    The items list is kept in item number order. 

New Item
To add an item to your list, type a unique item number and press Tab.    The item name defaults to "New 
Item". 

Edit an Existing Item
To edit an existing item, type its item number and press Tab.    If you do not know the item number press 
Ctrl-L or click Items List.

Note:    You can have items like shipping, handling, comments, etc.    They must have an item number.    
But, if you do not want the item number to print on the invoice or purchase order, put a backslash ( \ ) as 
the first character of the item number. 

Name
Enter up to 30 characters as the item name. 

I Buy This Item
Check this box if you purchase this item.    Purchased items are the only items that can be used on an 
item Purchase Order. 

I Sell This Item
Check this box if you sell this item.    Sold items are the only items that can be used on an item Invoice 
and in Set Item Prices.    Additionally, Sales History can be tracked only for items with this box checked. 

I Inventory This Item
Check this box if you keep this item in inventory.    Inventoried items are the only items that can be used in
Inventory Transfers, Inventory Adjustments, and Count Inventory.

Required Linked Accounts
M.Y.O.B. Accounting needs to know which accounts to adjust when you buy, sell, or inventory an item.    
As you check the buy, sell and inventory checkboxes, the linked accounts appear.    You must enter the 
requested linked account(s).    In addition to the unlikely item that is never bought, sold or inventoried, 
there are seven types of items.

Primary Vendor (Optional Buying Information)
Enter the primary vendor for this item.    Other than being useful information, noting a primary vendor 
serves another purpose.    If you inventory this item, whenever your inventory dips below the reorder level,
a reorder reminder appears on your To Do List.    Activate it and M.Y.O.B. Accounting automatically 
prepares an item purchase order for this item and vendor. 

Vendor Item Number (Optional Buying Information)
If you know it, enter the item number your primary vendor uses for this item.    When M.Y.O.B. Accounting 
prints an item purchase order for this item and vendor, it uses the vendor's item number.    If you dont 
enter a number or order this item from someone other than the primary vendor, M.Y.O.B. Accounting does
not print the item number. 

Taxable When Bought (Optional Buying Information)
Check this box if you pay sales tax when buying this item.    When you prepare an item purchase order, 
M.Y.O.B. Accounting calculates the sales tax automatically.    If necessary, you can override the tax status 
on the purchase order. 



Buying Unit of Measure (Optional Buying Information)
Enter up to 5 characters to describe the buying unit of measure (each, gross, case, etc.)    The buying unit
is printed on the item purchase order.    If, for example, you buy by the six-pack, when you order 5 units 
youre ordering 5 six-packs. 

Number of Items per Buying Unit (Optional Buying Information)
This is the number M.Y.O.B. Accounting adds to your on-hand inventory for every buying unit.    It is very 
important that you enter the correct number.    Say, for example, you buy soda by the six-pack.    Enter 6 
as the number of items per buying unit.    When you order 1 six-pack, M.Y.O.B. Accounting updates your 
item inventory by 6 units.    Leave this field blank and M.Y.O.B. Accounting defaults to 1.

Note:    It is important to track your inventory in the smallest unit of measure.    If, for example, you buy six-
packs and sell single cans, track your inventory in single cans. 

Reorder Quantity (Optional Buying Information)
It is important only if you want to be reminded when this item is below reorder quantity on the To Do List.   
Enter your usual reorder quantity.    When M.Y.O.B. Accounting prepares a purchase order, it defaults to 
this quantity. 

Note:    Enter Reorder Quantity in Buying Units of Measure.    If you buy by the six- pack and you usually 
reorder 100 six-packs, enter '100' not '600.' 

Reorder Level (Optional Buying and Inventory Information)
Reorder level is available only for items that are inventoried.    Enter the inventory level at which you 
reorder.    A reorder reminder appears in the To Do List when you reach this level. 

Note:    Enter Reorder Level in inventory units.    If you reorder when your inventory reaches 1 six-pack, 
your reorder level is '6,' not '1.' 

Selling Price (Optional Selling Information)
Enter the retail price of one selling unit. 

Track Sales History (Optional Selling Information)
Check this box if you want M.Y.O.B. Accounting to track monthly total unit sales, dollar sales, and cost of 
sales for this item.    Totals are kept for both last year and this year. 
Use Analyze Sales in the Sales & Receivables Command Center to review the totals.    
If the box is checked, the Sales History button is black.    Click it to enter historical sales figures. 

Note:    Tracking sales history consumes considerable disk space.    If you do not care to track sales for 
this item, be sure the box is unchecked. 

Taxable When Sold (Optional Selling Information)
Check this box if you collect sales tax when selling this item.    When you prepare an item invoice, 
M.Y.O.B. Accounting calculates the sales tax automatically.    If necessary, you can override the tax status 
on the invoice. 

Selling Unit of Measure (Optional Selling Information)
Enter up to 5 characters to describe the selling unit of measure (each, gross, case, etc.)    The selling unit 
is printed on the item invoice.    If, for example, you sell by the six-pack, when you sell 5 units, youre 
selling 5 six-packs. 

Number of Items per Selling Unit (Optional Selling Information)
This is the number M.Y.O.B. Accounting subtracts from your on-hand inventory for every selling unit.    It is
very important that you enter the correct number.    Say, for example, you sell by the six-pack.    Enter 6 as
the number of items per selling unit.    When you sell 1 six-pack, M.Y.O.B. Accounting reduces your item 
inventory by 6 units.    Leave this field blank and M.Y.O.B. Accounting defaults to 1.



Note:    It is important to track your inventory in the smallest unit of measure.    If, for example, you buy six-
packs and sell single cans, track your inventory in single cans. 

Auto-Build
If the item is manufactured from other items, click the Auto-Build Info button. Here you can enter the sub-
items needed to build this item.    First, enter the number of this item produced by the sub-items listed.    
Then list the item numbers and quantities of the sub-items.    The sub-items must also be inventory items. 
M.Y.O.B. Accounting uses this information to produce and inventory transfer transaction via the Auto-Build
Inventory function.



Set Item Prices

Changing a Price
All items that you sell are listed.    If an item is not listed and should be, go to Items List, select the item 
and check "I Sell this Item".    The current selling price is listed in the optional selling information.    Selling 
Price is the default price for one selling unit on the item invoice. 

Note:    When you set the price of an item, you are just setting the default price for the item invoice.    You 
may override the price when completing an invoice.    M.Y.O.B. Accounting accepts unit prices up to 3 
decimals.    On the invoice, it multiplies the unit price by the quantity sold before rounding to pennies.    For
your information, you may choose to see each item's average cost or last purchase price.    If the item was
transferred into inventory rather than bought, the last transfer price is displayed. 

Selecting an Item for Pricing Shortcuts
Change a price directly or click the Shortcut column.    When you click the Shortcut column a checkmark 
appears, signifying that the item is selected for pricing shortcuts.    Click the checkmark again to deselect 
the item.    When you click Shortcuts, you have the option of changing all prices or just those youve 
checked. 

Pricing Shortcuts
You can set the item prices based upon percent margin, percent markup or gross profit.    You can 
calculate percent margin or percent markup using the average cost or the last cost of the item.    See your 
M.Y.O.B. Accounting User Guide for the percent margin, percent markup and gross profit calculations. 

Basis for Calculation
The cost of the product is key to calculating margin, markup and gross profit.    You can use either the 
average cost of an item or its last cost.    Average cost is calculated by M.Y.O.B. Accounting It is the total 
cost of the item (what you paid when you purchased the item or the cost entered when you transferred 
the item into inventory) divided by the number of units on hand.    Last cost is the purchase price on the 
most recent purchase.    If the most recent item activity is an inventory transfer, the unit transfer cost is 
used. 

Use Calculated Price
Once the price of an item is calculated using your choice of percent margin, percent markup or gross 
profit, you can use the price or adjust it.    If you want the calculated price, click the radio button next to 
Use Calculated Price. 

Make Price a Multiple of...
Enter, for example, 25 cents ($.25) and M.Y.O.B. Accounting makes the price a multiple of 25 cents.    All 
item prices will end in .00, .25, .50 or .75. 

Make Price End in...
If, for example, you want all your prices to end in 99 cents, enter $.99. 

Round Prices to...
You can tell M.Y.O.B. Accounting whether to round the calculated price up, down or to the nearest 
requested price.    For example, you asked that all prices end in 99 cents and M.Y.O.B. Accounting 
calculates the price of an item to $24.76.    If you choose to round down, the price is set to $23.99.    If you 
choose to round up, it is set to $24.99.    If you choose to round to nearest, it is set to $24.99.    Click 
Update All Items and all selling prices are adjusted.    Click Update Items and only the checked items are 
adjusted.



Inventory Adjustments

Use Inventory Adjustments to reconcile your counted quantities with what M.Y.O.B. Accounting thinks you 
have. 

Inventory Journal Number
The Inventory Journal number identifies this transaction.    M.Y.O.B. Accounting sorts inventory journal 
transactions by journal number within date.    You may enter up to 8 characters, using any combination of 
numbers and letters.    M.Y.O.B. Accounting provides a default journal number with the prefix IJ (for 
Inventory Journal) followed by a 6-digit number.    M.Y.O.B. Accounting allows duplicate journal entry 
numbers, however it is not recommended. 

Date
All transactions within the Inventory Journal are sorted by transaction date.    You may not enter a date 
prior to the conversion date or in a prior fiscal year.    If you enter a future date, M.Y.O.B. Accounting 
accepts it, but only after warning you that the date is probably in error. 

Memo
Enter whatever youd like.    Memos can be up to 255 characters, but because of report display limitations, 
it is most useful to limit your memos to 40 or 50 characters. 

Note:    When you record an inventory adjustment, M.Y.O.B. Accounting adjusts your on-hand inventory 
and records the cash transaction, but loses the inventory item detail.    Therefore, you may want to put the
item name and quantity adjusted in the memo.    For example, when you reduce widgets by 12 units, enter
"-12 widgets" as your memo. 

Item Number
Enter the Item Number of the item you wish to adjust and press Tab. 

Note:    Only items checked "I Inventory this Item" in the Items List window can be adjusted.    

Quantity
Enter the adjustment quantity.    Enter a positive number and M.Y.O.B. Accounting adds that number to 
your on-hand inventory.    Enter a negative number and M.Y.O.B. Accounting subtracts it from on-hand 
inventory.    You may not reduce the on-hand inventory to less than zero units. 

Note:    The quantity is in inventory units, not buying or selling units.    Say, for example, you buy soda by 
the six-pack and inventory it by the single can.    When you enter a quantity of 24, youre adding 24 cans to
inventory. 

Unit Cost
Enter the cost of each unit transferred in or out of inventory.    M.Y.O.B. Accounting defaults to the average
cost of the item.    Average Cost is calculated by M.Y.O.B. Accounting    It is the total cost of the item 
divided by the number of units on hand.    

Amount
Amount is the quantity multiplied by the unit cost.    Change it and M.Y.O.B. Accounting recalculates the 
unit cost.    If the amount is positive, the value of your inventory is augmented and the linked inventory 
asset account is debited.    If it is negative, it is reduced and the linked inventory account is credited. 

Note:    When calculating the average cost of an item, M.Y.O.B. Accounting divides the current inventory 
value by the number of units in inventory.    Average cost is used when recording the cost of sales when 
selling an inventory item.    Remember, when you adjust inventory, you may be affecting the average cost.

Allocation Account
Enter the account number of the allocation account.    You must record the amount to an account (usually 



an expense account like "Shrinkage").    If it is a positive amount, it records a credit to the allocation 
account (because youre debiting the linked inventory account).    If it is a negative amount, M.Y.O.B. 
Accounting records a debit to the allocation account (because youre crediting the linked inventory 
account).    

Job
If the allocation account is an income, expense, cost of sales, other income or other expense account, 
you can assign the amount to a job (see Jobs List).    Type the job number and press Tab.    If you are 
unsure of the job number, press Ctrl-L to see the job list.    Select a job from the job list or click New Job to
create a new one. 

Record
Note:    When you record an inventory adjustment, M.Y.O.B. Accounting adjusts your on-hand inventory, 
and records the cash transaction, but loses the inventory item detail.    Therefore, you may want to put the
item name and quantity adjusted in the memo.    For example, when you reduce widgets by 12 units, enter
"-12 widgets" as your memo. 



Inventory Transfers

Use Inventory Transfers when you use up items to manufacture another item. 

Inventory Journal Number
The Inventory Journal number identifies this transaction.    M.Y.O.B. Accounting sorts inventory journal 
transactions by journal number within date.    You may enter up to 8 characters, using any combination of 
numbers and letters.    M.Y.O.B. Accounting provides a default journal number with the prefix IJ (for 
Inventory Journal) followed by a 6-digit number.    M.Y.O.B. Accounting allows duplicate journal entry 
numbers, however it is not recommended. 

Date
All transactions within the Inventory Journal are sorted by transaction date.    You may not enter a date 
prior to the conversion date or in a prior fiscal year.    If you enter a future date, M.Y.O.B. Accounting 
accepts it, but only after warning you that the date is probably in error. 

Memo
Enter whatever youd like.    Memos can be up to 255 characters, but because of report display limitations, 
it is most useful to limit your memos to 40 or 50 characters. 

Note:    When you record an inventory transfer, M.Y.O.B. Accounting adjusts your on-hand inventory and 
records the cash transaction, but then discards the inventory item detail.    Therefore, you may want to put
the item names and quantities transferred    in the memo.    For example, when you turn 4 boards into 1 
shelf, enter "-4    boards, 1 shelf" as your memo. 

Item Number
Enter the item number of the item you wish to transfer and press Tab. 

Note:    Only items checked "I Inventory this Item" in the Items List window can be adjusted.    

Quantity
Enter the transfer quantity.    Enter a positive number and M.Y.O.B. Accounting adds that number to your 
on-hand inventory.    Enter a negative number and M.Y.O.B. Accounting subtracts it from on-hand 
inventory.    You may not reduce the on-hand inventory to less than zero units. 

Note:    The quantity is in inventory units, not buying or selling units.    Say, for example, you buy soda by 
the six-pack and inventory it by the single can.    When you enter a quantity of 24, youre adding 24 cans to
inventory. 

Unit Cost
Enter the cost of each unit transferred in or out of inventory.    M.Y.O.B. Accounting defaults to the average
cost of the item.    Average cost is calculated by M.Y.O.B. Accounting    It is the total cost of the item 
divided by the number of units on hand.    

Amount
Amount is the quantity multiplied by the unit cost.    Change it and M.Y.O.B. Accounting recalculates the 
unit cost.    If the amount is positive, the value of your inventory is augmented.    If it is negative, it is 
reduced.    M.Y.O.B. Accounting does not allow a negative transfer amount that reduces the inventory 
value below zero. 

Note:    When calculating the average cost of an item, M.Y.O.B. Accounting divides the current inventory 
value by the number of units in inventory.    Average cost is used when recording the cost of sales when 
selling an inventory item.    Remember, when you transfer inventory, you may be affecting the average 
cost. 

Out of Balance



Out of Balance must be zero before you can record the transaction. 

Record
Note:    When you record an inventory transfer, M.Y.O.B. Accounting adjusts your on-hand inventory and 
records the cash transaction, but then discards the inventory item detail.    Therefore, you may want to put
the item names and quantities transferred in the memo.    For example, when you turn 4 boards into 1 
shelf, enter "-4    boards, 1 shelf" as your memo. 



Auto-Build Inventory

Auto-Build Inventory creates an Inventory Transfer transaction (see previous section). It is a shortcut for 
recording the manufacture of items.    Auto-Build Inventory presents a list of the items that M.Y.O.B. 
Accounting can build automatically. In order for an item to appear on this list you must first enter the item's
auto-build information.    To enter auto-build information, choose Items List and then select the item you 
wish to build.    Click the Auto-Build Info button at the bottom of the Item Information window. 

On Hand Quantity
This is the number of units M.Y.O.B. Accounting thinks you have in your current inventory. 

Pending Quantity
This is the quantity of this item on pending purchases (if you buy, as well as build, this item) minus the 
quantity on pending invoices.    (Use Analyze Inventory to review the pending quantities.) 

Net on Hand
This is the On Hand Quantity plus the Pending Quantity. 

Quantity to Build
Enter the quantity you wish to build.    If the Net on Hand quantity is less than the minimum level you 
entered in the Item Information window, M.Y.O.B. Accounting provides a default Quantity to Build. 

Build Items
When you click the Build Items button, M.Y.O.B. Accounting uses the item's auto-build information to 
create an Inventory Transfer transaction. 

How M.Y.O.B. Accounting Figures Costs and Values
M.Y.O.B. Accounting uses the sub-items' average cost as the Unit Cost.    The dollar amount being 
subtracted from each sub-item's inventory value is the Quantity times the Unit Cost. Since the transaction 
must balance, M.Y.O.B. Accounting adds up the total dollar amount being taken out of the sub-item's 
inventory and assigns it to the item being built.    The Unit Cost of the item being built is the Amount 
divided by the Quantity.    Review this transaction carefully.    Once it is recorded, you cannot view it in this 
window again.    You may view only the Inventory Journal transaction.



Count Inventory

Note:    Before taking inventory, you may want to print an Inventory Count Sheet Report.    It's a helpful 
form for writing down your inventory quantities. 

The Items List
Listed are all items in your item inventory.    If an item is not listed and should be, go to Items List, select 
the item and check "I Inventory this Item."

On Hand
This is the number of inventory units M.Y.O.B. Accounting thinks you have. 

Note:    The quantity is in inventory units, not buying or selling units.    Say, for example, you buy soda by 
the six-pack and inventory it by the single can.    When you see a quantity of 24, you have 24 cans in 
inventory. 

Counted
After counting your physical inventory, enter the quantity counted here. 

Note:    The quantity is in inventory units, not buying or selling units.    Say, for example, you buy soda by 
the six-pack and inventory it by the single can.    When you see a quantity of 24, you have 24 cans in 
inventory. 

Difference
This is the On Hand quantity minus the Counted quantity. 

Default Account for Inventory Adjustments
If your count disagrees with M.Y.O.B. Accounting's records, you should adjust your M.Y.O.B. Accounting 
inventory to reflect the real world.    Click Adjust Inventory to Reflect Count and M.Y.O.B. Accounting fills 
out the inventory adjustment transaction for you.    M.Y.O.B. Accounting enters for you as much of the 
transaction as it can.    Enter a default account before clicking Adjust Inventory to Reflect Count (usually 
an expense account like "Shrinkage") and M.Y.O.B. Accounting can better complete the transaction. As 
always, you may change the adjusting transaction before recording it.    You are not required to enter a 
default account.    If you dont, you must enter an account for each item in the Inventory Adjustments 
window. 

Note:    Be sure to record any inventory transfers before counting your inventory.    This avoids 
accidentally expensing missing inventory that was really used to build another item. 

Adjust Inventory to Reflect Count
If your count disagrees with M.Y.O.B. Accounting's records, you should adjust your M.Y.O.B. Accounting 
inventory to reflect the real world.    M.Y.O.B. Accounting helps reconcile your counted quantity with your 
on-hand quantity.    Click Adjust Inventory to Reflect Count to zoom to Inventory Adjustments.    M.Y.O.B. 
Accounting enters for you as much of the transaction as it can. 

Note:    Be sure to record any inventory transfers before counting your inventory.    This avoids 
accidentally expensing missing inventory that was really used to build another item.



Analyze Inventory

M.Y.O.B. Accounting provides a quick and easy analysis of your inventory "order book". 

Note:    If you want to see past sales of inventory items, see Analyze Sales in the Sales & Receivables 
Command Center. 

Summary
Choose Analyze Inventory from the Inventory Command Center and your Items List is displayed. 

On Hand
This is how many units M.Y.O.B. Accounting thinks you have in Inventory. 

Committed
M.Y.O.B. Accounting scans your pending sales file and calculates how many of each item you have 
promised to customers. 

On Order
M.Y.O.B. Accounting scans your pending purchases file and calculates how many of each item you have 
on order from vendors. 

Available
This is the On Hand amount plus the On Order amount, minus the Committed amount. 

Note:    If your pending purchases from vendors are going to be significantly delayed, what M.Y.O.B. 
Accounting shows as 'available' may not really become available for some time.    If youre unsure of the 
promised shipping date of an item, click the arrow next to the item name. 

Item # Detail
From the summary window, click an arrow next to an item (or click the item # radio button and enter an 
item number).    M.Y.O.B. Accounting displays all the pending sales and purchases for the selected item.    
Click the arrow in the left column to view the original invoice or purchase order. 

Invoice/PO#
If this is a pending sale, this is the invoice number.    If it is a pending purchase, it is a purchase order 
number.    Click the arrow next to this number to view the original invoice or purchase order. 

Customer/Vendor
This field lists the customer name for sales, the vendor name for purchases. 

Ordered
This is the date the pending sale or pending purchase was entered. 

Promised
This is the date the goods were promised to the customer (sales) or by the vendor (purchases).    It is 
taken from the Promised Date field on the pending invoice or purchase order. 

Committed
If this is a pending sale, this is the quantity you promised the customer. 

On Order
If this is a pending purchase, this is the quantity ordered from the vendor.



Finding, Changing, or Deleting Inventory Adjustments

Erasing an Adjustment Before It's Recorded
Finding an Inventory Adjustment
Changing or Deleting an Inventory Adjustment



Erasing an Adjustment Before It's Recorded
If, while entering an adjustment, you need to start over, choose Erase Adjust Inventory Transaction from 
the Edit menu.

See Also
Finding, Changing, or Deleting Inventory Adjustments



Finding an Inventory Adjustment

Click the Inventory Journal icon in the Inventory Adjustments window or the Inventory command center to 
zoom to the Inventory Journal display.

The date range defaults to the current month.    All transactions between (and including) the From and To 
dates are displayed.    There are no transaction arrows next to inventory journal transactions.    You may 
not redisplay the transactions in their original entry windows.

See Also
Finding, Changing, or Deleting Inventory Adjustments



Changing or Deleting an Inventory Adjustment

Unlike other types of transactions, once an inventory adjustment is recorded, you may not change, delete 
or automatically reverse it.    You may review it by clicking the Journal Icon.    If you need to change or 
reverse the transaction, you must enter a new offsetting transaction.

See Also
Finding, Changing, or Deleting Inventory Adjustments



Finding, Changing, or Deleting Inventory Transfers

Erasing a Transfer Before It's Recorded
Finding an Inventory Transfer
Changing or Deleting an Inventory Transfer



Erasing a Transfer Before It's Recorded

If, while entering an inventory transfer, you need to start over, choose Erase Transfer Inventory 
Transaction from the Edit menu.

See Also
Finding, Changing, or Deleting Inventory Transfers



Finding an Inventory Transfer

Click the Inventory Journal icon in the Inventory Transfers window or the Inventory command center to 
zoom to the Inventory Journal display.

The date range defaults to the current month.    All transactions between (and including) the From and To 
dates are displayed.    There are no transaction arrows next to inventory journal transactions.    You may 
not redisplay the transactions in their original entry windows.

See Also
Finding, Changing, or Deleting Inventory Transfers



Changing or Deleting an Inventory Transfer

Unlike other types of transactions, once an inventory transfer is recorded, you may not change, delete or 
automatically reverse it.    You may review it by clicking the Journal Icon.    If you need to change or 
reverse the transaction, you must manually enter a new offsetting transaction.

See Also
Finding, Changing, or Deleting Inventory Transfers



M.Y.O.B. Accounting General Help

To get help about a particular screen in M.Y.O.B. Accounting, go to that screen and press F1.    To get help
on a particular topic now, press the "Search" button and choose from the alphabetized list of M.Y.O.B. 
Accounting help keywords.    If you need to look up the meaning of a particular accounting term, see 
Glossary of M.Y.O.B. Accounting Terms.    If you made a mistake, see When Things Go Wrong.    If you 
still require assistance, please contact Customer Support.

To get help on a particular command center, choose one of the following:
General Ledger
Checkbook
Sales & Receivables
Purchases & Payables
Payroll
Inventory
Card File
Administration



Customer Support

In order to provide you with timely information about upgrades, new products and other exciting offers, as 
well as to provide you with exceptional service and support, we need to know who you are.    For that 
reason, you are required to register your copy of M.Y.O.B. Accounting.

Once you register, you are eligible for 30 days of FREE technical support from the date of your first phone
call.    After that time, you will want to choose one of our flexible Extended Support plans to continue to 
receive expert advice and technical assistance when you need it.

See the brochure included in your M.Y.O.B. Accounting package for details and ordering information, or 
call 800-322-6962 (or 201-586-2200 ext. 300).

How to Reach Technical Support
Technical support is available on business days between 9:00 am and 6:00 pm Eastern Time.

Phone Support:    (201) 586-2269
Fax Support:    (201) 586-8885



General Ledger Opening Balances

Remember, once you record and verify your opening balances, you may not change them.    After 
verification, the General Ledger menu selection changes from "Opening Balances" to "Current Balances".

Choose Set Up M.Y.O.B. from the Administration command center.    Click the radio button next to Set Up 
General Ledger.    Click the arrow next to Enter Opening Balances.

Here you need to enter your opening account balances.    An opening balance is the balance of each 
account at the beginning of your conversion month.    If your conversion month is the first month of your 
fiscal year, all you need to enter is the opening balances of your balance sheet accounts (asset, liability 
and equity accounts).    If your conversion month is not the beginning of your fiscal year, you should enter 
the fiscal yeartodate balances of all your accounts.

Note:    Enter your balances as positive numbers.    Don't, for example, enter your assets as positive and 
your liabilities as negative.    M.Y.O.B. Accounting knows the normal sign of your accounts.    Enter a 
negative amount only if the account has a negative balance.

If you have (or your accountant has) a Trial Balance report for the month prior to your conversion month, 
the ending balance for the month is your opening balance in M.Y.O.B. Accounting    Enter these values 
into M.Y.O.B. Accounting and your accounts should balance.    (Alternatively, you could use a Balance 
Sheet to enter your assets, liabilities and equity balances and a yeartodate Income Statement for income,
cost of sales and expense balances.)

Note:    M.Y.O.B. Accounting includes an equity account for Current Year Earnings.    It calculates its 
opening balance automatically.    Do not enter your own account for current year earnings or your 
accounts will not balance.

Note:    If your conversion month is the first month of your fiscal year, your income and expense accounts 
and Current Year Earnings are zero and last year's earnings should already have been added to your 
Retained Earnings account.

Verifying Your Opening Balances
Once you've entered your opening balances, click the Verify Balances button. 

Before you can use M.Y.O.B. Accounting,    your accounts must be in balance; that is, the total value of 
your assets must equal the sum of your liability accounts plus your equity accounts.

ASSETS = LIABILITIES + EQUITY

Once you enter your opening balances, here's how M.Y.O.B. Accounting verifies that they're in balance:
1. It calculates your current year earnings by totaling your income and subtracting expenses

and cost of sales.
2. It includes this current year earnings amount when figuring out the total of your equity 

accounts.
3. If your assets equal your liabilities plus equity (including current year earnings), your 

accounts balance.

If your accounts don't balance, M.Y.O.B. Accounting displays a summary of your account balances 
including the out of balance amount.

Note:    If you're not using M.Y.O.B. Accounting to track your balance sheet, you probably don't care to 
meticulously balance your accounts.    Continue on to the next section called "Forcing Your Accounts to 
Balance".

Forcing Your Accounts to Balance



Try to enter your opening balances as accurately as possible.    Be sure to include your Accounts 
Receivable and Accounts Payable balances.    If your accounts don't balance and you either don't care or 
are ready to give up, click Adjust Balances and M.Y.O.B. Accounting will automatically balance your 
accounts by adjusting your Retained Earnings account.

If, in the future, you find out where the out of balance amount belongs, simply use General Journal Entry 
to move money from Retained Earnings to the correct account.    Also use this method if you've forgotten 
to include some accounts after setting your opening balances.

Once your opening balances are verified, you've completed General Ledger Setup.



Linked Accounts

Receivables Linked Accounts
Choose Linked Accounts from the Sales & Receivables menu.    Or, choose Set Up M.Y.O.B. from the 
Administration Command Center.    Click the button next to Set Up Sales & Receivables.    Click the arrow 
next to Linked Receivables Accounts.    Your receivables account is an asset account.    Its balance equals
the total of all unpaid invoices.    Your receivables checking account is the asset account in which you 
deposit payments (and from which you write refund checks).    These two accounts must be linked before 
you can use the Sales and Receivables Command Center.

Note: See Using a Cash Drawer Account in Chapter 12 of the User's Guide for a good way to control the 
deposits made into the linked receivables checking account.
The following are optional linked accounts.    If you

1. Collect state sales tax, youll need a liability account to keep track of your sales tax 
payable to the state.

2 Charge freight, you'll need an income account to track it.
3. Accept cash deposits from customers, youll need a liability account for them.
4. Give discounts when customers pay early, you must link them to an account.    If you think

discounts increase the cost of the sale, link them to a cost of sales account.    If you think 
discounts are a sales and marketing expense, link them to an expense account.

5. Assess charges against late payers, you must link them to an income account.

Payables Linked Accounts
Choose Linked Accounts from the Purchases & Payables menu.    Or, choose Set Up M.Y.O.B. from the 
Administration Command Center.    Click the button next to Set Up Purchases & Payables.    Click the 
arrow next to Linked Payables Accounts.    Your payables account is a liability account.    Its balance 
equals the total of all unpaid purchases.    Your payables checking account is the asset account from 
which you make bill payments.    These two accounts must be linked before you can use the Purchases & 
Payables Command Center.    The following are optional linked accounts.    If you:

1. Pay freight, you'll need an expense or cost of sales account to track it.
2. Send cash deposits to vendors, youll need an asset account for them.
3. Receive discounts when you pay early, you must link them to an account.    If you think 

discounts decrease the cost of the sale, link them to a cost of sales account.    If you think
discounts decrease your expenses, link them to an expense account.

4. Pay charges for late payments, you must link them to an expense account.

Payroll Linked Accounts
Choose Linked Accounts from Payroll menu.    Or, choose Set Up Payroll  from the Payroll Command 
Center.    Click the Set Up Payroll button;    click the arrow next to Linked Payroll Accounts.    

Your Payroll Checking account is the checking account from which you normally write your 
Payroll Checks.    You can change this each time you Write Paychecks.

Default Employer Expense Account is the account this is charged for your Employer Expenses 
(including all the preset Expenses).    You can change the Expense account for each Employer 
Expense when you enter or edit it.

Default Wages Expense Account is the default General Ledger account this is charged for your 
Wages expenses.    You can change this account for each employee.

Default Withholding Payable Account is the account in which the amounts withheld from the 
employee's paycheck is accrued.    You can change this for each Deduction category, Employer 
Expense, and Taxes category.

Click Record to record the Payroll Linked Accounts.





Receivable Opening Balances (Historical Sales)

Before you can use the Sales & Receivables Command Center, you must enter the sales that make up 
the balance of your linked receivables account.    These are called "historical sales" because they 
occurred prior to setting up the Sales & Receivables Command Center.    Receivable Opening Balances 
are entered in Set Up M.Y.O.B.    Displayed is a list of your customers with the historical sales entered to 
date. (If this is the first time youre entering historical sales, the list is all zeros.) Click the arrow to the left 
of a customer's name to see a detail listing of their historical sales.    The total of your historical sales must
equal the current balance of your linked receivables account before you can use the Sales & Receivables 
Command Center.    If the balance of your linked receivables account is not zero, enter your historical 
sales by clicking Add a Sale.    When youre done entering your historical sales, click Verify Opening 
Balances.    M.Y.O.B. Accounting checks to see that the balance of your receivables account equals the 
total of your historical sales.    If they don't equal, you must do one of two things:    Add, change or delete 
(choose Delete Sale from the Edit menu) your historical sales OR change the balance of your linked 
receivables account.    For instructions on changing the balance of your linked receivables account, see 
Set Up Receivables in Chapter 3 of the Getting Started booklet. 
Note:    Once you've verified your opening receivables balances, this selection changes to Current 
Balances.



Historical Sales

You must enter the sales that make up the balance of your linked receivables, account.    Historical sales 
are those that occurred prior to setting up the, Sales & Receivables Command Center. Historical Sale are 
entered in Receivable Opening Balances in Set Up M.Y.O.B.    Enter the customer, sales #, date, memo 
and amount of the sale.    Click Record.    Continue to add all your historical sales.    Make sure you assign 
them to the correct customer. 
Note:    When you record an historical sale, both a debit and a credit for the sale amount are posted to the
linked receivables account.    The balance of the receivables account does not change.



Payable Opening Balances (Historical Purchases)

Before you can use the Purchases & Payables Command Center, you must enter the purchases that 
make up the balance of your linked payables account.    These are called "historical purchases" because 
they occurred prior to setting up the Purchases & Payables Command Center.    Payable Opening 
Balances are entered in Set Up M.Y.O.B.    Displayed is a list of your vendors with the historical purchases
entered to date. (If this is the first time youre entering historical purchases, the list is all zeros.)    Click the 
arrow to the left of a vendor's name to see a detail listing of your historical purchases.    The total of your 
historical purchases must equal the current balance of your linked payables account before you can use 
the Purchases & Payables Command Center.    If the balance of your linked payables account is not zero, 
enter your historical purchases by clicking Add a Purchase.    See Historical Purchases.    When youre 
done entering your historical purchases, click Verify Opening Balances.    M.Y.O.B. Accounting checks to 
see that the balance of your payables account equals the total of your historical purchases.    If they don't 
equal, you must do one of two things:    Add, change or delete (choose Delete Purchase from the Edit 
menu) your historical purchases OR change the balance of your linked payables account.    For 
instructions on changing the balance of your linked payables account, see Set Up Payables in Chapter 3 
of the Getting Started booklet. 
Note:    Once you've verified your opening payables balances, this selection changes to Current 
Balances.



Historical Purchases

You must enter the purchases that make up the balance of your linked payables, account.    Historical 
purchases are those that occurred prior to setting up the, Purchases & Payables Command Center.    
Enter the vendor, purchase #, date, memo and amount of the purchase.    Click Record.    Continue to add 
all your historical purchases.    Make sure you assign them to the correct vendor.
Note:    When you record an historical purchase, both a debit and a credit for the purchase amount are 
posted to the linked payables account.    The balance of the payables account does not change.



Data Entry in M.Y.O.B. Accounting

Tab
Use the Tab key to move to the next field.
Shift Tab
Pressing Tab while holding down the shift key moves the cursor to the previous field. 
Down Arrow
Press down arrow to move to the next field. 
Up Arrow
Press up arrow to move to the previous field. 
Left and Right Arrow
Use the left and right arrow keys to move from character to character within a field. 
Enter
The Enter key does four things

1. In a single line data entry field - like a dollar amount - Enter    behaves like Tab.
2. In multi-line fields - like an address field or the detail of a journal entry or invoice - Enter 

moves the cursor to the next line.
3. In dialog boxes, pressing Enter is the same as clicking the with the thick black line around

it.
4. Within a scroll area Enter moves to the next line.    

Ctrl-Enter
Most windows in M.Y.O.B. Accounting have a default button.    The default button has a thin black line 
around it.    Press Ctrl-Enter to activate the default button.    In a dialog box, pressing Ctrl-Enter activates 
the button with the thick black line around it.

Editing a Field
Use the Delete key to erase the previous character.    Use the left and right arrows to move from character
to character within a field.    If there are more characters than can fit in the display field, use the left and 
right arrows (or click and drag the mouse) to scroll the data sideways. 
Dates
You may not enter a date in a prior fiscal year or prior to your Conversion Month.    If you enter a future 
date, M.Y.O.B. Accounting accepts it, but only after warning you that the date is probably in error.    Enter 
the date in your system's date format: month/day/year (American), or day/month/year (European), etc.    
You may use any non-numeric character to separate the month from the day and the day from the year.    
To enter a date after the year 1999, type the 4-digit year or 100 plus the last two digits of the year.    Enter,
for example, New Year's day in 2012 as 1/1/112.    When you press Tab, M.Y.O.B. Accounting converts it 
to 1/1/2012. 
Note:    M.Y.O.B. Accounting displays a default date.    In most cases this date is correct - simply press 
Tab to accept it.    To change the day of the month, just type the day and press Tab.    M.Y.O.B. Accounting 
enters the default month and year.    To change the month, type the month (a non-numeric separator) and 
the day and press Tab.    M.Y.O.B. Accounting enters the default year. 
Dollar Amounts
You may enter dollar amounts using numbers, commas, periods and dollar signs.    Improperly formed 
amounts are disallowed and decimal amounts are rounded to the nearest cent. 
Account Numbers
When entering an account number, be sure to include the account type (asset, liability, etc.) prefix.    You 
may, but are not required to, type a hyphen to separate the prefix from the last four digits. 
Note:    If you do not type all 5 digits, M.Y.O.B. Accounting fills in with zeros.    For example, you can enter 
the account number '1-2000 'as '12.'    When you press Tab, M.Y.O.B. Accounting converts it to '1-2000.'
See Also

Navigating in M.Y.O.B.



Navigating in M.Y.O.B. Accounting

Windows
With the exception of the Command Center window, all windows in M.Y.O.B. Accounting are standard 
windows.    The name of the window is centered in the title bar at the top.    You may move a window by 
clicking and dragging the title bar.    The name of the window is centered in the title bar.    To save the 
location of your windows, select Customize M.Y.O.B. in the Administration Command Center.

Close A Window
To close the window, select Close from the window's system menu, or press the ESCAPE key.    For data 
entry windows, unless you are warned otherwise, when you close the window the contents of the window 
are saved.    If there is a Cancel button, click it and the window closes.    Any changes made to the data in 
a canceled window are erased.

Command Centers
There are seven command centers listed on the left side of the command center window.    Click one, and 
the right side of the window displays the functions available for the selected command center.    M.Y.O.B. 
Accounting uses a flow chart analogy to express the relationship between the functions.    Click the name 
of the function you wish to perform. Alternatively, all command center functions are listed under the 
Command Center menu selection.

Auto-Feed Arrows
Throughout M.Y.O.B. Accounting are small arrows next to names, account balances, invoice numbers, 
etc.    Click the arrow to zoom to the detail information for this field. 

Card File Icon
Most times, when M.Y.O.B. Accounting asks you to link a sale to a customer card or a purchase to a 
vendors card, you have no choice; you must select a card.    If you press Tab or Return, you cannot leave 
the field without selecting a card. However, there are a few places in M.Y.O.B. Accounting - like the payee
on a check - where a card name is optional.    Pressing Tab or Return moves you to the next field.    A 
small card file icon appears next to the optional fields.    Click the icon to see, or select from a card file list. 

Control Panel Icons
The To Do List window and the Analysis windows have a control panel at the bottom.    Click an icon to 
change the display.    If there's a bent arrow in the control panel, click it to redisplay the selection dialog. 

Selecting From a Search List
Before entering an account, inventory item, job or card name, you can look at the entire list.    This is 
called a "search list".    Accounts, inventory items and jobs are selected by number.    Cards are selected    
by company name (or, if an individual, last name).    There are a few ways to select from a search list:

1. Type a unique number (or card name) and press Tab.    It is selected and you jump to the 
next field.

2. Type a non-unique number (or card name) and press Tab.    The search list appears with 
the closest match selected.    Press Return to accept it.    To select another, use the up 
and down arrows to highlight it and press Return, or simply double-click it. 

3. Press Tab (or Ctrl-L) without typing anything and the search list appears with the first 
entry selected.    Use the "Search for" field to enter a complete or partial account number 
(or name) and press Tab.    M.Y.O.B. Accounting finds the closest match.    Press Return 
to accept it or use the "Search for" field again. 

Note:    Method 3 is not available for entering an optional card name (see Card    File Icon).    Most search 
lists have a New button.    Click it to enter a new account, item, job or card.    When you accept the new 
entry, M.Y.O.B. Accounting zooms back to the original window.    Type the new number or name and press
Tab.
See Also

Data Entry in M.Y.O.B.



Journal Display

When you select the journal display, the date range defaults to the current    month.    You may change the 
dates.    The selected journal is displayed in the pop-up menu in the upper left of the    window.    You may 
change it at any time. 
Note: Once a journal is displayed you may select any other journal or all from    the pop-up.

Zooming in on a Journal Transaction
Transactions between (and including) the From and To dates are displayed.    All transactions, except 
inventory journal entries, have a small arrow to their left.    Click the arrow to display the transaction.    If 
the arrow is white, the transaction is still editable.    After clicking the arrow to reload the transaction in its 
entry window, you may change any field or delete the entire transaction.    To delete the transaction, 
choose the Delete option from the Edit menu.    If the arrow is gray, you may not change or delete this 
transaction.    To correct a gray arrow transaction you must reverse it.    A reversing transaction is a new 
transaction that replicates the original transaction with debit amounts shown as credit amounts and vice 
versa.    After recording a reversing transaction, you have two transactions (the original and the reversing),
and the current account balance appears as if the original transaction never happened.    To reverse a 
displayed transaction, choose Reverse from the Edit menu, review the transaction information, and click 
OK. 
Note:    You may change only the date, the ID# and the memo in a reversing transaction.



Recap Transaction

This is the first selection from the Inquiry menu.    This displays the journal transaction about to be 
generated.    Once you record the transaction, the Recap window is erased.    Recap Transaction can be 
very helpful when entering a transaction (like an item invoice) for which the journal entry is not obvious.



Searching

M.Y.O.B. Accounting always provides a convenient method of searching for an account, invoice, 
purchase, etc.    See Navigating in M.Y.O.B. or choose from one of the following topics for more 
information:

Search by Account
Search by Card
Search by Invoice
Search by Purchase
Search by Job



Search by Account - Inquiry Menu

You can view the transactions for a given account.    Enter an account number and press Tab.    (See Also 
Navigating in M.Y.O.B..)    The date range defaults to the current month.    You may change it.    You may 
limit    your selections by journal.    If you choose All journals, M.Y.O.B. Accounting provides beginning and 
ending account balances.    Click the arrow next to the account name to zoom to the Chart of Accounts.    
Click the arrow next to a transaction to display it.



Search by Card - Inquiry Menu

You can view any transaction (check, deposit, invoice, or purchase) you linked to a card.    Enter a card 
name and press Tab.    (See Also Navigating in M.Y.O.B..)    The date range defaults to the current month.  
You may change it.    Also, you may limit your selections by journal.    Click the arrow next to the card 
name to zoom to the card.    Click the arrow next to a transaction to display it. 
Note:    The Search by Card function is provided as a means of, locating a transaction.    It is not for 
looking up a payable or receivable balance.    To find the current balance of a card, use Analyze Payables 
or Analyze Receivables.



Search by Invoice - Inquiry Menu

You can view the transactions for a given invoice.    Enter an invoice number and press Tab.    (See Also 
Navigating in M.Y.O.B..)    When you search by invoice, M.Y.O.B. displays just the    transactions that affect
the balance of the invoice - usually just the receivables    and deposit transactions.    It does not display the
income, sales tax, inventory, etc. transactions.    Click the arrow next to the invoice number to display the 
invoice itself.    Click the arrow next to a transaction to display it.



Search by Purchase - Inquiry Menu

You can view the transactions for a given purchase.    Enter a purchase number and press Tab.    (See 
Also Navigating in M.Y.O.B..)    When you search by purchase, M.Y.O.B. Accounting displays just the 
transactions that affect the balance of the purchase - usually just the payables and deposit transactions.    
It does not display the expense, inventory, etc. transactions.    Click the arrow next to the purchase 
number to display the purchase itself.    Click the arrow next to a transaction to display it.



Search by Job - Inquiry Menu

You can view the transactions for a given job.    Enter a job number and press Tab.    (See Also Navigating 
in M.Y.O.B..)    The date range defaults to the current month.    You may change it.    You may limit your 
selections by journal.    If you choose All journals, M.Y.O.B. Accounting provides beginning and ending 
balances for the job.    Click the arrow next to the job number to zoom to the job information.    Click the 
arrow next to a transaction to display it.



Data File

M.Y.O.B. Accounting's data is kept in a single, convenient data file.    You may change the name of the file.
The program will recognize it as a M.Y.O.B. Accounting data file. 



Saving Data

Saving During a Session
While working with M.Y.O.B. Accounting, the changes you make to your data are kept in your computer's 
temporary memory.    In order to record these changes on your hard disk, you must choose Save from File
menu or simply press Ctrl-S.    We recommend that you save often.    It takes only a moment, and it may 
save you a lot of work.    If you have a power blackout while using M.Y.O.B. Accounting, any entries made 
since the last time you saved will be lost.    However, the M.Y.O.B. Accounting data on your hard disk 
should remain intact.



Reverting to the Last Saved Version Data

During a session, you can erase all the changes since the last time you saved.    Select Revert to Saved 
from the File menu.    If you never saved during the session, M.Y.O.B. Accounting erases all changes 
since the beginning of the session.



Backing Up Data

Your business generates an enormous amount of data.    Computers are very reliable, but not perfect.    
You must backup your M.Y.O.B. Accounting data on a regular basis.    You should backup onto a separate 
disk.    Dont put your backups on the same hard disk as M.Y.O.B - a single disaster can wipe out all your 
records.    See When to Backup Your Data.



When to Backup Your Data

Here's what we recommend:
1. During the month, backup after every session.    If you use M.Y.O.B. Accounting everyday,

make a backup disk for each day of the week.    Use, for example, your Monday backup 
disk after Monday's session, Tuesday's backup after Tuesday's session, etc.    If you use 
M.Y.O.B. Accounting on a more sporadic basis, make two backup copiesa "father" and a 
"grandfather"and rotate them.    The father is a backup from your most recent M.Y.O.B. 
Accounting session.    The grandfather is a backup from your next to last session.    When 
you backup the current session, use the grandfather disk.    The generations then 
swapthe grandfather becomes the father and the father becomes the grandfather.

2. After completing all entries for a month, make an archive copy.    For example, when you 
finish making entries for May (which is usually sometime in June), make a backup copy.    
Label it "M.Y.O.B. Accounting May Archive."    Put it in a safe place, preferably in a 
different location than your computer.    If you follow these directions, at the end of a 
12month fiscal year the daily user will have 17 backup copies12 monthly archive backups
and 5 current daily (Monday through Friday) backups.    The sporadic user will have 14 
backup copiestwo current backups (the father and grandfather) and 12 monthly archive 
backups.

Note:    If your data file becomes too large to fit on a single floppy disk, use a backup utility program.    One
example is the IBM DOS Backup command.    Instructions on using it can be found in your DOS manual.

Why is Backing Up So Important?
Because disks can fail.

But Why Make Multiple Backups?
Because sometimes disks fail in devilishly subtle ways.    A failure can wipe out a big chunk of your data in
such a way that you may not notice it during a session.    Once you copy the bad data onto your only 
backup, you're stuck.    Multiple backups give you more levels of protection.



Purging Old Data

M.Y.O.B. Accounting, with its journal entries, invoices, purchase orders and contact logs, maintains an 
incredible amount of your business data.    

Unless M.Y.O.B. Accounting tells you, you are not required to purge your data.    But if you feel your data 
is becoming too unwieldy, you can selectively purge your data.    You can purge journal entries, closed 
(paid) sales, closed (paid) purchases, or contact logs.

Note:    Before doing any purging, print appropriate reports and then make a backup copy of your data file.

See
Purging Journal Entries
Purging Closed Sales
Purging Closed Purchases
Purging Contact Logs



Purging Journal Entries

You are not required to purge your journal entries.    Most M.Y.O.B. Accounting users do this only if they 
need the disk space.    Journal entries are your accounting transactionssometimes called your "audit trail." 
This selection erases these accounting transactions (along with any job allocations) within a specified 
period range.    The monthly totals for each account (and job) are retained, but the detail transactions that 
make up those totals are erased.    Since the monthly totals are retained, you can generate a balance 
sheet and profit & loss statement even after purging the journal entries for the period.    But a detail trial 
balance report or an account inquiry report for a purged period will be irrelevant.

Note:    The Trial Balance, Account Inquiry and Job Inquiry reports will not include beginning and ending 
balances if the report includes a purged period.

Select the General Ledger command center.    Choose Purge Journal Entries... from the File menu.    
Select a period range.    Be careful!    Do not include a period that is not 100% completed.    You can still 
enter new journal entries in a period that has been purged, but you'll end up with an incomplete picture of 
the period.

Unreconciled Transactions.    Check any account you regularly reconcile.    M.Y.O.B. Accounting does 
not    purge any unreconciled transactions from the checked accounts.

Note:    M.Y.O.B. Accounting does not purge any transactions associated with a sale or purchase.    If you 
want to purge journal transactions associated with closed sales or purchases, you must first purge the 
closed sale or purchase records.

See Also
Purging Old Data



Purging Closed Sales

A closed sale is a sale entered via Invoice Sales or Other Sales that has been paid in full.    This is 
probably the most commonly purged file.    If you make a lot of sales, especially invoice sales, your sales 
file can grow very quickly.

Select the Sales & Receivables command center.    Choose Purge Closed Sales from the File menu.    
Choose a period range.

Detail Only.    You can purge just the detail of a sale.    The detail is what appears within the scroll area of 
the sale.    Purging just the detail leaves the ID number, date, customer, memo, and (if applicable) 
salesperson and customer P.O. number.    The journal entries generated by the sale are not affected by 
purging the sales record.

Note:    If you look in the Sales & Receivables journal, you'll notice that arrows remain next to transactions
generated by sales that have had their detail purged.    When you click an arrow, you'll go to the original 
sales entry, but the detail information in the scroll area will have been erased.    

Entire Sale.    You can purge an entire sale.    All record of the invoice is erased.    The journal entries 
generated by the sale are not    affected by purging the sales record. 

Note:    If you look in the Sales & Receivables journal, you'll notice that there are no arrows next to 
transactions generated by sales that have been purged.    

See Also
Purging Old Data



Purging Closed Purchases

A closed purchase is a purchase entered via Purchase Orders or Other Purchases that has been paid in 
full.    Next to closed sales, this is probably the most commonly purged file.    If you make a lot of 
purchases, especially purchase orders, your purchases file can grow very quickly.

Select the Purchases & Payables command center.    Choose Purge Closed Purchases from the File 
menu.    Choose a period range.

Detail Only.    You can purge just the detail of a purchase.    The detail is what appears within the scroll 
area of the purchase.    Purging just the detail leaves the ID number, date, vendor, memo, and (if 
applicable) vendor invoice number.    The journal entries generated by the purchase are not affected by 
purging the purchase record.

Note:    If you look in the Purchases & Payables journal, you'll notice that arrows remain next to 
transactions generated by purchases that have had their detail purged.    When you click an arrow, you'll 
go to the original purchase entry, but the detail information in the scroll area will have been erased.    

Entire Purchase.    You can purge an entire purchase.    All record of the purchase is erased.    The journal
entries generated by the purchase are not affected by purging the purchase record. 

Note:    If you look in the Purchases & Payables journal, you'll notice that there are no arrows next to 
transactions generated by purchases that have been purged.    

See Also
Purging Old Data



Purging Contact Logs

Contact log entries are not tied to your accounting entries.    Purging a card's contact log does not affect 
any of your other records.

Select the Card File command center.    Choose Purge Contact Logs from the File menu.    Choose a 
period range.    Contact log entries for the selected cards made in or before this period are erased.

Card Type.    You can erase the contact logs for all cards, customer cards, vendor cards, employee cards,
or personal cards.

Identifiers.    This can be a very helpful feature.    If you routinely purge the contact logs for a select 
subset of your cards, assign them a unique identifier (how about "P" for "Purge"?).    Enter an identifier 
and only contact logs for those cards with that identifier are purged.

Note:    Enter more than one identifier and only those cards with all identifiers are selected.    Enter "AB," 
for example, and only those cards with both A and B are selected.

Recontact Date.    You may choose not to erase contact log entries that have a recontact date.

See Also
Purging Old Data



Starting a New Fiscal Year

When to Start a New Year
You should start a new fiscal year after all entries have been made for the current fiscal year.

You may make entries in the new fiscal year before closing out the current year.    The only two 
drawbacks:

1. You cannot print your balance sheet or profit & loss statements for the new fiscal year 
until you tell M.Y.O.B. Accounting to start a new fiscal year.

2. The unit sales of an item are not added to the sales history file.    (You are warned before 
posting an item sale in a future fiscal year.)

Note: Before beginning a new fiscal year, make a backup copy of your current year's data.    (For 
additional recommended steps, see PeriodEnd Processing.)

To begin a new fiscal year, choose Start a New Year from the File menu.    Follow the directions on the 
screen.    They will prompt you stepbystep through the process.

Here is a summary of what happens when you start a new fiscal year.    For the purposes of this summary,
let's say that you have a calendar fiscal year and you are ending 1993 and beginning 1994:

1. M.Y.O.B. Accounting replaces last year's (1992) historical monthly totals with the monthly 
totals of the year just completed (1993).

2. M.Y.O.B. Accounting purges everything (journal entries, sales, purchases) prior to the 
new fiscal year (1994), except:
a. Those entries attached to open or pending sales or purchases.
b. Unreconciled transactions in the accounts you reconcile.
c. Contact log entries.

3. M.Y.O.B. Accounting moves the balance of current year earnings to retained earnings 
and zeros out the balances of all your income, cost of sales, expense, other income and 
other expense accounts as of the beginning of the new fiscal year.

4. M.Y.O.B. Accounting does not touch any entries made in the new fiscal year.

If your new fiscal year ends in a different month than your last fiscal year, you can change it when you 
start a new year.

Note:    If your fiscal yearend changes, check with your accountant about reporting rules governing a 
"short year."

When you start a new fiscal year, you can change from 12 periods per year to 13 periods per year.    You 
may change from 13 periods to 12 periods only if you had no transactions in the 13th period for all of last 
year.



Period-End Processing

When to Perform Period-End Processing
Unlike most other accounting programs, M.Y.O.B. Accounting does not require you to close a month 
before starting a new month.    You can make entries in any month (even in the next fiscal year). As a 
good accounting practice, we recommend the following steps after completing your entries for a period.    
(Remember, you usually havent completed a period until a month or so later.) 
Note:    These steps are recommended.    They are not required.    M.Y.O.B. Accounting does not purge 
any accounting entries when you perform the following period-end processing.    After youre fairly certain 
that all entries for a month have been made: 

1. If youve received your bank statement, reconcile your checkbook.
2. Print a Trial Balance summary report for the month.    Check the activity in the trial 

balance to make sure youve entered everything.    (Look for zero activity in accounts that 
usually have activity,    Verify the balance of your checkbook at the end of the month, etc.) 
If something doesnt look right, print a trial balance detail report.

3. Once everything looks okay, print a Balance Sheet, Profit & Loss Statement. and any 
supporting schedules (journals, aged receivables, aged payables, etc.) you would like to 
have on file.

4. Make a backup copy of your data (See Backing Up Data). 
5. Choose Customize M.Y.O.B. from the Administration Command Center and change the 

"accidental posting" month to the month just completed.    If, down the road, you must 
make an adjustment in this month, youll have to change the "accidental posting" month 
and make the entry.    Afterward, you should do these five steps again.



"What You See Is What You Get".



When Things Go Wrong

M.Y.O.B. Accounting provides easy and accessible ways to correct mistaken entries.    

Chapters 2 through 8 of the Users Guide cover the seven command centers, while Chapter 15 covers 
Payroll.    The last section of each of these chapters is called How Do I ??.    The following is a quick-
reference table of whats covered in those sections. 

Action Selection Available Corrective Action

General Journal Entry General Journal Entry If unsaved:    Change or Delete
If saved:    Auto-Reverse

Recurring General General Journal Entry Delete
Journal Entry

Check Write Checks If unsaved:    Change or Delete
If saved:    Auto-Reverse

Recurring Checks Write Checks Delete

Deposit Make a Deposit If unsaved:    Change or Delete
If saved:    Auto-Reverse

Recurring Deposits Make a Deposit Delete

Sales Journal Entry Other Sales If unsaved:    Change or Delete
If saved:    Auto-Reverse

Recorded Invoice Invoice Sales If unsaved:    Change or Delete
If saved:    Auto-Reverse

Payment Received Apply a Payment If unsaved:    Delete
from Customer If saved:    Auto-Reverse

Applied Credit to an Settle Credits If unsaved:    Delete 
Open Invoice If saved:    Auto-Reverse

Write a Refund Check Settle Credits If unsaved:    Delete
to a Customer If saved:    Auto-Reverse

Purchases Journal Other Purchases If unsaved:    Change or Delete
Entry If saved:    Auto-Reverse

Recorded Purchase Purchase Orders If unsaved:    Change or Delete
If saved:    Auto-Reverse

Make a Payment to a Make a Payment If unsaved:    Delete
Vendor If saved:    Auto-Reverse

Applied Credit to an Settle Credits If unsaved:    Delete
Open Purchase Order If saved:    Auto-Reverse

Deposit a Refund Settle Credits If unsaved:    Delete
Check from Vendor If saved:    Auto-Reverse



Inventory Adjustment Inventory Adjustments Make a New, Reversing Entry

Inventory Transfer Inventory Transfers Make a New, Reversing Entry

Auto-Build Inventory Auto-Build Inventory Make a New, Reversing Entry

For more information, see also
Checks
Deposits
General Journal
Sales
Invoices
Customer Payments
Credits
Purchase Orders
Pending Purchases
Other Purchases
Settle Debits
Make a Payment
Inventory Adjustments
Inventory Transfers
Reverting to the Last Saved Version Data



Account Types

There are eight account types.    Select an account's type by clicking the appropriate tab at the upper-left 
of the window.    Every account must have a unique number.    All account numbers have a one-digit prefix 
followed by a four digit number.    The one-digit prefix identifies the type.    The four digits identify the 
account within that type.

Account Type Prefix
Asset 1
Liability 2
Equity 3
Income 4
Cost of Sales 5
Expense 6
Other Income 8
Other Expense 9

Sales History

M.Y.O.B. Accounting can track sales figures on a per-customer or per-item basis.    These figures are 
useful for comparison between this year and last year.
See Also

Customer Sales History
Item Sales History



Customer Sales History

If you wish to compare this year's sales to last year's sales for this customer (in Analyze Sales), enter the 
net sales for the months preceding your using M.Y.O.B. Accounting

Once you check Track Sales History, whenever you make a sale to this customer, the amount of the sale 
is added automatically to the total for that month.

Note:    M.Y.O.B. Accounting does not prohibit you from changing these numbers.    It increments the sales
amounts at the time of the sale.    If you change them, M.Y.O.B. Accounting CANNOT reconstruct the 
monthly totals from its sales records.    It simply adds the next sale to the amount you entered.



Item Sales History

If you wish to compare this year's sales to last year's sales for this item (in Analyze Sales), enter the unit 
sales, dollar sales, and cost of sales for the months preceding your using M.Y.O.B. Accounting    Once you
check Track Sales History, whenever you sell this item, the units sold, sales amount and cost of sales are 
added automatically to the totals for that month.
Note:    M.Y.O.B. Accounting does not prohibit you from changing these numbers.    It increments the 
amounts at the time of the sale.    If you change them, M.Y.O.B. Accounting CANNOT reconstruct the 
monthly totals from its sales records.    It simply adds the next sale to the amounts you entered.



Purchases and Payables

Other Purchases
Choose Other Purchases to record a purchase for which no purchase order form is needed.

Enter the expense accounts and amounts.    Enter also any payment made at the time of the purchase.    
The payment decreases the balance of your linked checking account.    The balance due is applied to 
your linked payables account, creating an open payable.

Item Purchase Order
Write an item purchase order to record the purchase of something (widget, gadget, etc.) on your items 
list.    Even if you don't need to print the purchase order, it's the only way to record item purchases.    Enter
the detail of the item purchase.    Enter also any payment made at the time of the purchase.    When 
recorded as an actual purchase, the payment decreases the balance of your linked checking account and
the balance due is applied to your linked payables account, creating an open payable.

To write an item purchase order, choose Purchase Orders.    Click the Item Purchase radio button.    

Service Purchase Order
A service purchase order is a freeform purchase order.    Write a service purchase order when you want to
use M.Y.O.B. Accounting's invoicing function to buy something not on your items list.    Enter the detail of 
the purchase by typing the description, entering the purchases (most likely expense) account and 
amount.    Enter also any payment made at the time of the purchase.    When recorded as an actual 
purchase, the payment decreases the balance of your linked checking account and the balance due is 
applied to your linked payables account, creating an open payable.

To write a service purchase order, choose Purchase Orders.    Click the Service Purchase radio button.    

Pending Purchase Order
Both Item and Service Purchase Orders can be placed in the pending file.    Placing a purchase in the 
pending file does not create any cash or inventory transactions.    It simply keeps the order on file awaiting
future receipt.    If an amount is entered in the Paid Today field, it is considered an advance deposit and 
increases (debits) your linked deposits account and takes the money out of (credits) your linked checking 
account. 

To record additional deposits on a pending purchase order, use Make a Payment.

When the order is received, you must call up the pending purchase order and convert it to an actual 
purchase.    

Settle Debits
When something goes wrong with a recorded purchase order (a return, adjustment, etc.), you must create
a new adjusting purchase . If the new purchase order has a negative balance due, it becomes a debit 
purchase.    Settle Debits lets you get these debits off your books by applying the amount to another 
purchase order or by depositing a refund check.

Make a Payment
When you pay a bill, use Make a Payment to write the check and settle the open payable. 

Analyze Payables
Analyze Payables is a quick, powerful and interactive way to review who you owe, how much you owe, 
and how long you've owed it.

Print Purchase Orders
M.Y.O.B. Accounting prints purchase orders on either pre-printed forms or your own stationery.



Ship Via
Select the method you would like the vendor to ship these items from the Shipping Methods list.    The 
Ship Via field can be printed on the purchase order.

Comment
Choose from the drop-down menu, or enter a comment to be printed on the purchase order.



Purchase Orders

Vendor
You must select a vendor for this purchase.    Vendors are those card file entries you labeled "Vendor".    
See Also Navigating in M.Y.O.B..    If there are pending purchase orders on file for this vendor, a dialog 
appears.    You may choose to process a pending purchase order or to create a new one. 

Note:    If this is a cash purchase and you do not track the purchases activity for    this vendor, create a 
new vendor card called something like "Cash", or "MasterCard".    If this is a credit purchase, youre better 
off adding this vendor    to your card file, so you can track the payable balance. 

Ship To
This is where you want the vendor to ship your order.    The default is your    company address entered in 
Company Information.    You may accept the default    address or change it and press Tab.    There's a 
Card File icon next to the Ship To address.    Click it to choose an address from a card other than the 
selected vendor's card.    Choose any card, regardless of card type.

Purchase Order Number
The Purchase Order Number identifies this transaction within the Purchases &    Payables journal.    
M.Y.O.B. Accounting sorts journal transactions by journal (purchase    order) number within date.    You 
may enter up to 8 characters, using any    combination of numbers and letters.    M.Y.O.B. Accounting 
provides a default 8-digit purchase order number.    M.Y.O.B. Accounting allows duplicate purchase order 
numbers, however it is    not recommended. 

Note: M.Y.O.B. Accounting automatically increments numeric purchase numbers.    M.Y.O.B. Accounting    
does not increment non-numeric purchase order numbers.    If you must use a    non-numeric format, 
M.Y.O.B. Accounting keeps incrementing and providing the next    numeric purchase order number as the 
default.    It is up to you to override it for    every purchase . 

Date
All transactions within the Purchases & Payables journal are sorted by    transaction date.    You may not 
enter a date prior to the conversion date or in a    prior fiscal year.    If you enter a future date, MYOB 
accepts it, but only after    warning you that the date is probably in error. 

Vendor Invoice Number
This is optional.    If your vendor included an invoice number with your order and    you wish to note it on 
the purchase order, enter it here.    

Ship Via
Select the method you would like the vendor to ship these items from the Shipping Methods list.    The 
Ship Via field can be printed on the purchase order.

Terms
The purchase order displays the credit terms, if any, for this vendor.    To change    them, click the arrow 
next to the vendor's name.    

Item Purchase
Received Quantity and Backorder Quantity
There are two quantity fields in M.Y.O.B. Accounting.    When you click Record, M.Y.O.B. Accounting 
records the purchase for items with a Received Quantity and creates a pending purchase for any 
quantities in the Backorder field.
Enter the purchase quantity.    Enter up to three decimal places.    Zero is a valid quantity.    Use zero 
quantity for special items like freight (see Items List).    Note:    The quantity is in buying units.    Say, for 
example, you said (when entering the item information) there are 6 inventory items per buying unit.    
When you enter 1 as the quantity, 6 items are added to inventory.    Note:    Use Tab to move to the Item 
Number field.    Pressing Return moves you to the next line.    When the Quantity field is empty, pressing 



Return jumps you to the Paid Today field. 

Item Number
Enter the Item Number of the item youre buying and press Tab.    The item description is displayed and 
youre brought to the Price field. Note:    Only items checked "I Buy this Item"    in the Items List window 
can be bought (see Items List.)    Note:    Item numbers beginning with a backslash ( \ ) are not printed on 
the order.    Use backslash item numbers to identify special items such as freight or handling charges or 
comments like, "Ship A.S.A.P."    See Items List for a complete discussion of special items. 

Description
The Description defaults to the name given to the item in the Item Information window.    You may change 
it.    But remember, if you change it, the item information is not changed.    To change the item's name 
permanently, you must edit it via Items List in the Inventory Command Center.    To enter more than one 
line of description, use one of the following methods:

1. Just keep typing.    You can enter up to 255 characters for the description.    If the 
description does not fit on a signle line on the printed invoice, M.Y.O.B. Accounting wraps 
the text onto the next line.

2. Create a special item for additional lines.    In your Items List, enter an item with a 
backslash as the first character of the item number.    Check "I buy this item".    Assign it to
any expense account.    (Since you won't be assigning a price to this item, it won't affect 
your books.)    Make sure the price is $0.00, the Selling Unit of measure is blank, and you 
uncheck Taxable When Bought.    Once this special item is recorded, you can use it 
anytime for a description.    Simply Tab past the Ship and Backorder fields, enter the item 
#, and type the description.    Press Return to move to the next line.

Price
M.Y.O.B. Accounting defaults to the last purchase price of the item.    You may change it if you wish.    
Enter a whole number followed by up to three decimal places.    M.Y.O.B. Accounting multiplies the price 
by the quantity, subtracts the discount and then rounds the final amount to the nearest cent.    

Discount
The discount is the percentage entered as the volume discount in the vendor's card.    You may change it. 
Discounts can range from -100% to 100%.    Enter 2.5% as "2.5", not ".025".    Note:    This is a discount for
volume purchase.    It is not the discount for early payment. 

Total
Total Amount is the Received Quantity multiplied by the price, minus the discount.    Change it and 
M.Y.O.B. Accounting recalculates the discount. 

Service Purchase
Description
Enter whatever youd like.    For multi-line descriptions, press Return to move to the next line.    When 
youve completed the description, press Tab to enter an account.    Note:    To put a blank line between 
descriptions, type a space and press Return.    

Account Number
Before you can enter an amount, you must select an account.    Since this is a Purchases & Payables 
journal entry, it is usually an expense account.    If you need to enter a new expense account, click the 
New Account button on the detail accounts dialog and M.Y.O.B. Accounting zooms to Chart of Accounts.   
Enter the account information and press Enter or click OK.    The window disappears and youre back at 
the Account Number field.    Type the new account number and press Tab.    The new account is selected, 
its name appears and you jump to the Amount field. 

Amount
Enter a dollar amount.    M.Y.O.B. Accounting allows you to type the dollar amount using numbers, 



commas, periods and dollar signs.    Improperly formed amounts are disallowed and decimal amounts are 
rounded to the nearest cent.    Since M.Y.O.B. Accounting balances positive amounts with a credit to your 
linked    payables account, any positive number entered is treated as a debit.    This is almost always 
correct, since whenever you add to an expense account it is a debit.    If youre entering a return or sales 
adjustment, use a negative amount.    Negative amounts reduce (credit) the selected account.      If there is
a negative balance due, the linked receivables account is debited.    Note:    A negative balance due 
creates a debit purchase.    Use Settle Debits to process a refund or apply the money to another payable.  
Note:    An account without a dollar amount is kept on the order, but is not recorded as part of the journal 
entry.    

Job
You can assign the amount to a job if you do not inventory the item (see Jobs List).    Type the job number 
and press Tab.    If you are unsure of the job number, press Ctrl-L to see the job list.    Select a job from the
job list or click New Job to create a new one.    If you do not inventory this item the cost of the purchase is 
assigned to the job. 

Note:    If you need to assign a single item to more than one job, enter the item    more than one time.    
Say, for example, youre purchasing 50 widgets and 30 are    for job 12 and 20 are for job 43.    Enter two 
lines for widget purchases, one for    30 units and the other for 20 units. 

Tax
A checkmark in the Tax column means that you pay tax when you purchase the    item.    The Tax column 
defaults to a checkmark if you checked "Taxable When Bought" in the Items List window.    Click the 
column to enter a checkmark.    Click a checkmark to remove it. 

Comment
Choose from the drop-down menu, or enter a comment to be printed on the purchase order.

Journal Memo
This is a memo for the Purchases & Payables Journal transaction.    When printing purchase orders, you 
may decide whether or not to print journal memos.

Promised Date
If you are placing this purchase order in the pending file, enter the date the order    should be delivered. 

Note:    Although you may enter a Promised Date for an actual purchase, it is    relevant only if you place 
the purchase order in the pending file. 

Sales Tax Percent
Sales tax is calculated on all taxable items based upon the percentage entered.    Taxable items are those
that have checkmarks in the tax column. 

Note:    M.Y.O.B. Accounting defaults to the last sales tax percentage entered. 

Paid Today
If this is a full or partial cash purchase, enter the amount paid here.    This    amount is recorded in the 
Cash Disbursements journal.    When you record the purchase, a dialog appears with the check number, 
payee and memo.    If the information is correct, click OK.    If it is incorrect, click Cancel and use Make a    
Payment to record the cash payment. 

Freight
Enter the shipping charges for this purchase.    You must have a linked freight account before you can use
the field.

Balance Due
This is the total of all lines, plus sales tax, minus the payment made.    This    amount is added to the 



vendor's payables balance.    If the amount is positive an    open purchase is created.    If it is zero, a 
closed purchase is created.    If it is    negative, a debit purchase is created. 

Record
M.Y.O.B. Accounting records the quantity received.    If there are any backordered quantities, M.Y.O.B. 
Accounting creates a new pending purchase for the backorder amount.    (For further discussion see 
Backorder Quantity vs. Pending Button.)

See Also
Other Purchases
Pending Purchase Orders



Backorder Quantity vs. Pending Button

Clicking Record on a purchase order with a backorder quantity creates a pending purchase and clicking 
Pending File also creates a pending purchase.    So what's the difference?

Let's say you write a purchase order with both Received and Backordered quantities.    If you click 
Pending File, M.Y.O.B. Accounting puts the entire purchase away in the pending file.    If you click 
Record, M.Y.O.B. Accounting records the received amount and creates a pending purchase for only the 
backordered amount.

See Also
Purchase Orders



Other Purchases

Vendor
You must select a vendor for this purchase.    Vendors are those card file entries you labeled "Vendors".    
See Also Navigating in M.Y.O.B.. 
Note:    If this is a cash purchase and you do not track the purchases activity for    this vendor, create a 
new vendor card called something like "Cash", or    "MasterCard".    If this is a payable purchase, youre 
better off adding this vendor    to your card file, so you can track the payable balance. 

Purchase Number
The purchase number identifies this transaction within the Purchases &    Payables journal.    M.Y.O.B. 
Accounting sorts journal transactions by number within date.      You may enter up to 8 characters, using 
any combination of numbers and letters.      M.Y.O.B. Accounting provides a default purchases number 
with the prefix PJ (for Purchases & Payables journal) followed by a 6-digit number.    M.Y.O.B. Accounting 
allows duplicate    journal entry numbers, however it is not recommended. 

Date
All transactions within the Purchases & Payables Journal are sorted by    transaction date.    You may not 
enter a date prior to the conversion date or in a    prior fiscal year.    If you enter a future date, M.Y.O.B. 
Accounting accepts it, but only after    warning you that the date is probably in error. 

Memo
Enter whatever youd like.    Memos can be up to 255 characters, but because of    report display 
limitations, it is most useful to limit your memos to 40 or 50    characters. 

Account Number
You must select an account.    Since this is a purchase, it is usually an expense    account.    To select an 
account, See Also Navigating in M.Y.O.B..    If you need to enter a new expense account, click the New 
Account button on the    search chart of accounts dialog and M.Y.O.B. Accounting zooms to Chart of 
Accounts.    Enter the account information and press Enter or click OK.    The window disappears and    
youre back at the Account Number field.    Type the new account number and press    Tab.    The new 
account is selected, its name appears and you jump to the Amount    field. 

Amount
Enter a dollar amount.    M.Y.O.B. Accounting allows you to type the dollar amount using    numbers, 
commas, periods and dollar signs.    Improperly formed amounts are    disallowed and decimal amounts 
are rounded to the nearest cent.    Since M.Y.O.B. Accounting balances positive amounts with a credit to 
your linked payables    account, any positive number entered is treated as a debit.    This is almost always 
correct, since whenever you add to an expense account it is a debit.    If youre entering a return or 
purchases adjustment, use a negative amount.    Negative    amounts reduce (credit) the selected account.
If there is a negative balance due,    the linked payables account is debited.    

Note:    A negative balance due creates a debit purchase.    Use Settle Debits to    deposit a refund or 
apply the money to another payable. 
Note:    An account without a dollar amount is not recorded as part of the journal    entry. 

Job
If the selected account is an income, expense, cost of sales, other income or other expense account, you 
can assign the amount to a job (see Jobs List).    Type the job number and press Tab.    If you are unsure 
of the job number, press Ctrl-L to see the job list.    Select a job from the job list or click New Job to create 
a new one.
Note:    If you need to assign an amount from a single account to more than one job, enter the account 
more than one time.    Say, for example, you have $100 debit to widget expenses and you need to assign 
$30 to job 12 and $70 to job 43.    Enter two debits to widget expenses, one for $30 and the other for $70. 
Note:    Upon entering the complete purchase, use the down arrow to jump to the Paid Today field. 



Paid Today
Upon entering the details of the purchase, use the down arrow to jump to the Paid Today field.    If this is a
full or partial cash purchase, enter the amount paid here.    This amount is drawn from your linked 
checking account and recorded in the Cash Disbursements journal.    When you record the purchase, a 
dialog appears with the check number, payee and memo.    If the information is correct, click OK.    If it is 
incorrect, click Cancel and use Make a Payment to record the cash payment. 

Balance Due
A positive balance due increases (credits) your linked payables account.    A positive balance due also 
creates an open payable.    When you pay all or part of this balance, use Make a Payment to write the 
check and settle this payable.    A return or adjustment usually creates a negative balance due.    A 
negative balance due decreases (debits) your linked payables account.    The purchase becomes a debit 
purchase.    Use Settle Debits to apply the debit to an open payable or to deposit the vendor's refund. 

Record
Positive amounts in the detail of the purchase are recorded as debits.    Negative amounts are credits.    If 
there's a positive balance due, it's added to the payable balance for this vendor and a new open payable 
is created.    When you pay your bill, use Make a Payment to write the check, and settle this payable. 

Note:    A negative balance due reduces your payable balance and creates a debit purchase order.    Use 
Settle Debits to apply the debit to an open payable or to deposit the vendor's refund.    If you entered an 
amount in Paid Today, a check is drawn from your linked checking account and recorded in the Cash 
Disbursements journal.    When you record the purchase, a dialog appears with the check number, payee 
and memo.    If the information is correct, click OK.    If it is incorrect, click Cancel and use Make a 
Payment to record the cash payment. 
See Also

Purchase Orders



Pending Purchase Orders

Recording a Pending Purchase Order as an Actual Purchase
Select Purchase Orders and enter a vendor.    A dialog listing all pending purchase orders for this vendor 
will appear.    Select the desired pending purchase order.    Change anything youd like about the pending 
purchase order, except the deposit amount.    To enter an additional deposit on a pending purchase, use 
Make a Payment.    When youre ready, click Record as an Actual Purchase.    The pending purchase order
is converted to an actual purchase and recorded. 

Note:    If the date of the recorded purchase order is earlier than the current system date you are alerted. 
Note:    If you change any item information in the Items List window (linked accounts, quantities, etc.), 
when you recall the pending item purchase order, the new item information is used. 
Note:    When you record a pending purchase order with a deposit as an actual purchase, M.Y.O.B. 
Accounting moves the money from your deposits account to your linked account.    Your linked deposits 
account is reduced (credited) by the amount of the deposit and the linked account is debited. 

See Also
Purchase Orders



Settle Debits

Apply to Open Purchase
All purchases from this vendor are displayed.    Open purchases are displayed first, followed by pending 
purchases and then by closed purchases. 

ID Number
The ID Number identifies this transaction within the Purchases & Payables Journal.    M.Y.O.B. Accounting
sorts Purchases & Payables Journal transactions by journal ID number within date.    You may enter up to 
8 characters, using any combination of numbers and letters.    M.Y.O.B. Accounting provides a default ID 
number with the prefix PJ (for Purchases & Payables Journal) followed by a 6-digit number.    M.Y.O.B. 
Accounting allows duplicate ID numbers, however it is not recommended. 

Date
All transactions within the Purchases & Payables Journal are sorted by transaction date.    You may not 
enter a date prior to the conversion date or in a prior fiscal year.    If you enter a future date, M.Y.O.B. 
Accounting accepts it, but only after warning you that the date is probably in error. 

Debit Amount
M.Y.O.B. Accounting displays the amount of the debit.    You may change it to a lesser amount. You may 
not increase it.    M.Y.O.B. Accounting allows you to type the dollar amount using numbers, commas, 
periods and dollar signs.    Improperly formed amounts are disallowed and decimal amounts are rounded 
to the nearest cent. 

Memo
Enter whatever youd like.    Memos can be up to 255 characters, but because of report display limitations, 
it is most useful to limit your memos to 40 or 50 characters. 

Purchase Number
This is the number of the previous purchase from this vendor. 

Status
Purchases that have a positive balance are "open".    Purchases with a zero balance are "closed".    
Purchases placed in the pending file are "pending". 

Amount
This is the current amount due, net of previous payments or applied debits, on the purchase. 

Discount
If the vendor gives you an early payment discount, a discount amount appears here.    You may override 
the discount.    Note:    Discounts are recorded only when settling the entire balance due of a purchase.    
Consider a $100 balance with a $2 discount.    The Total Due is $98.    Apply, say, $75 to this purchase.    
When you record it, the $2 discount is ignored.    The next time you see this purchase, it will have a $25 
(not $23) balance.    

Amount Applied
M.Y.O.B. Accounting defaults to the Amount Due or the unapplied remainder of the Debit Amount, 
whichever is less.    You may apply the debit amount to more than one purchase.    Note:    Applying a debit
to an open or closed purchase does not change the vendor's payable balance.    It simply re-assigns the 
money from a debit purchase to a regular purchase.    Applying a debit to a pending purchase does 
change the vendor's balance, because the money is moved from payables to your linked deposits asset 
account.    See Examples of Applied Debits for examples of applied debits. 

Record
The transaction is recorded in the purchases journal as an equal debit and credit.    Since neither the 
vendor's balance nor your payable balance has changed these entries are made for audit trail purposes. 



Deposit a Refund Check
Verify the ID Number, Date, Amount, Payor and Memo of the deposit.    See Make a Deposit for more 
information about these fields. You may reduce the amount of the refund, but you may not increase it 
above the debit amount. 

Record
The transaction is recorded in the Cash Receipts Journal.    Your checking account is increased (debited) 
by the amount of the deposit.    The payable balance for this vendor is increased (credited).

See Also
Purchase Orders
Pending Purchase Orders



Examples of Applied Debits

Example:    In addition to a few closed (fully paid)    purchases, you have an open purchase with a balance
due of $125, and a $25 debit from a previous return.    This yields a net payable balance of $100.

Scenario A - Applying the debit to an open purchase.
You apply the $25 debit to the $125 open purchase.    The debit is settled and the open purchase has a 
new balance of $100.    There is no change in the vendor's payable balance.

Scenario B - Applying the debit to a closed purchase.
You apply the $25 debit to a closed (fully paid) purchase.    The old debit is settled and the closed 
purchase becomes a new $25 debit purchase.    There is no change in the vendor's payable balance.    
This is a possible, but very improbable situation.

Scenario C - Applying the debit to a pending purchase.
You want to treat the $25 as a deposit with the vendor and apply it against a pending purchase.    The 
debit is settled and you have a new payable balance with the vendor of $125 and a deposit on account for
$25.      

Note:    You may not apply a payment to a pending purchase order unless you have a linked deposits 
account.    See Set Up Payables in Chapter 3 of the Getting Started booklet.



Make a Payment

Selecting a Checking Account
In the upper left of the Make a Payment window is a pop-up menu containing all accounts with checking 
privileges.    If you do not see your checking account in the list, choose Chart of Accounts from the 
General Ledger Command Center and assign checking privileges to the account. 

Balance
Balance is the current balance of the selected checking account.    Click the arrow to zoom to the Account 
Transaction Detail window. 

Vendor
You must select a vendor for this payment.    Vendors are those card file entries you labeled "Vendor".    
See Also Navigating in M.Y.O.B.. 

Payee
The vendor's name and address are displayed beneath the vendor field.    This is what is printed next to 
"Pay to the Order of" on the check.    If you use window envelopes, this is what shows through the 
window.    If the name or address is incorrect, you may change them. 

Memo
Enter whatever youd like.    Memos can be up to 255 characters, but because of report display limitations, 
it is most useful to limit your memos to 40 or 50 characters. 

Note:    When you look at this check transaction in the Cash Disbursements journal, the contents of the 
memo field are displayed.    If the memo field is left blank, the first line of the payee field is displayed. 

Check Number
M.Y.O.B. Accounting provides a default check number using the Last Check Number field from the 
account information entered in Chart of Accounts.    If you change the check number, it resets the Last 
Check Number field. 

Note:    When you print checks, M.Y.O.B. Accounting (at your option) renumbers your check transactions 
to match the printed checks.    If your printer eats some of your checks, dont worry. 

Date
All checks are sorted by date.    You may not enter a date prior to the conversion date or in a prior fiscal 
year.    If you enter a future date, M.Y.O.B. Accounting .accepts it, but only after warning you that the date 
is probably in error. 

Amount
Enter the amount of the check.    M.Y.O.B. Accounting allows you to type the dollar amount using 
numbers, commas, decimal points, and dollar signs.    Improperly formed amounts are disallowed and 
decimal amounts are rounded to the nearest cent.    You may not enter negative check amounts.    The 
checking account balance is credited (decreased) by the amount of the check.

Purchase Order Number
This is the number of the previous purchase from this vendor. 

Status
Purchases that have a positive balance are "open".    Purchases with a zero balance are "closed".    
Purchases placed in the pending file are "pending".    

Amount
This is the current amount due on the purchase, net of previous payments, deposits or applied debits. 



Discount
If youre entitled to a discount (See Also Card File Entry), a discount amount appears here.    You may 
override the discount. 

Note:    Discounts are recorded only when settling the entire balance due of a purchase.    Consider a 
$100 balance with a $2 discount.    The Total Due is $98.    Apply, say, $75 to this purchase.    When you 
record it, the $2 discount is ignored.    The next time you see this purchase, it will have a $25 (not $23) 
balance.    

Amount Applied
You may apply the payment to more than one purchase.    Purchases that have a positive balance are 
"open".    Apply the payment to reduce the open balance.    If you apply more than the balance due, the 
open purchase becomes a debit purchase.    When you apply a payment to an open purchase order, your 
payable balance is reduced (debited) by the amount of the payment.    Purchases with a zero balance are 
"closed".    Apply a payment to a closed purchase, and it becomes a debit purchase.    When you apply a 
payment to a closed purchase, the vendor's payable balance is reduced (debited) by the amount of the 
payment.    Purchase Orders placed in the pending file are "pending".    Apply a payment to a pending 
purchase order and it is treated as a deposit.    The vendor's payable balance remains unchanged and the
deposits account is increased (debited). 

Finance Charge
If your check includes a finance charge payment, use the Finance Charge field to enter it.    Your linked 
finance charge account (see Set Up Payables in Chapter 3 of the Getting Started booklet, is increased 
(debited) by the amount of the charge. 

Record
The transaction is recorded in the Cash Disbursements journal.    Your checking account is decreased 
(credited) by the amount of the check.    If applied to an open or closed purchase, your payable balance 
for this vendor is reduced (debited).    If applied to a pending purchase order, the linked deposits account 
is increased (debited).
See Also

Purchase Orders
Pending Purchase Orders



Analyze Payables

Calculate Number of Days Since Purchase Date
Choose this to age your payables based upon the purchase date.

Calculate Days Overdue Using Vendor Terms
Choose this to age your payables based upon when the purchase should be paid given your credit terms 
with the vendor.

Aging Date
Enter a date, usually the current date.    M.Y.O.B. Accounting determines the age of your payables by 
calculating the number of days between the purchase date and this date. 

Display $0.00 Balance Purchases
This includes all closed (fully paid) purchases in the aging analysis.    Leave it unchecked unless you are 
looking for a particular purchase and are unsure whether or not it has been paid. 

Summary Analysis
All your payables are displayed, totaled by vendor.    The outstanding payable balance for each vendor is 
displayed in the Total column.    The total is broken down by age and displayed in the appropriate aging 
column.    Click the arrow to the left of a vendor to see the vendor payable detail. 

Vendor Detail
Click the radio button for Vendor Detail and select a vendor.    All payables for this vendor are displayed in 
date order.    The balance due for each purchase is displayed in the total column and again in the 
appropriate aging column.    Click the arrow to the left of the purchase number to see the purchase detail. 

Purchase Detail
Click the radio button for Purchase Detail and select a purchase.    This is the transaction trail for a single 
purchase.    Click the arrow to the left of the transaction to see it in its originating window.



Print Purchase Orders

Select Print Purchase Orders to print service or item purchase orders entered in Purchase Orders.

You may order compatible purchase orders and envelopes (an order form is included with your M.Y.O.B. 
Accounting package) or customize the purchase order printing to fit your existing forms.

Purchase Order Type
Choose the type of purchase order - item or service -    you want to print.

Purchase Order Status
You may print all purchase orders or limit your selection to open purchase orders (most common), closed 
purchase orders, debit purchase orders or pending purchase orders.

Unprinted Purchase Orders Only
Check this selection to print only those purchase orders (matching all your other selection criteria) not 
previously printed.

Purchase Orders Dated...
Check this selection and enter a date range.    M.Y.O.B. Accounting prints only those purchase orders 
between (and including) the From and To Dates.

Purchase Order Numbers...
Check this selection and enter a purchase order number range.    M.Y.O.B. Accounting prints only those 
purchase orders between (and including) the beginning and ending purchase order numbers.

Form Currently Used for...
Ordering information for purchase orders designed exclusively for M.Y.O.B. Accounting users is included 
with your M.Y.O.B. Accounting package.

There are three formats for each type (service or item) of purchase order:    pre-printed, plain paper and 
user-customized.    Pre-printed purchase orders already have the lines and headers on the form, so 
M.Y.O.B. Accounting does not print them.    Plain-paper purchase orders do not have lines and column 
headers, so M.Y.O.B. Accounting draws them when printing the purchase order.    The third format (user-
customized) is of your own design.    This selection is gray until you customize a purchase order format.    
To customize a purchase order, choose the purchase order format (Pre-Printed Purchase Order or 
M.Y.O.B. Accounting's Plain Paper Purchase Order) that most closely matches your form.    Click 
Customize.    See Customizing Purchase Orders.

Print Alignment Purchase Order
Click this button to print a sample purchase order.    Once it is printed, check the alignment, adjust your 
printer and reset the top of form.    (For continuousfeed printers, set the top of form by turning it off and 
then on.)

Backorder Purchases
M.Y.O.B. Accounting first prints the received goods, then skips a line and lists the backordered goods.    
Received goods have a completed amount field, backordered goods leave the amount field blank.

Note:    To print a separate backorder purchase, just choose to print the pending invoice. 

Note:    If you do not want the backorder information printed on the actual purchase order, do not use the 
Backorder field on the purchase order.    Create a separate pending purchase order.

See Also
Customizing Purchase Orders





Customizing Purchase Orders

There are two types of purchase orders in M.Y.O.B. Accounting:    item purchase orders and service 
purchase orders.    You may make a customized version of each type.    Here's how:

1. Select Print Purchase Orders.
2. Choose the appropriate Purchase Order Type (Service or Item).
3. Choose the purchase order format (Pre-Printed Purchase Order or M.Y.O.B. Accounting's

Plain Paper Purchase Order) that most closely matches your form.    The pre-printed 
purchase order format does not have lines or column headers (they are already printed 
on the form), the plain paper purchase order includes lines and headers.

4. Click Customize.

See How to Customize Forms for customization instructions.

Saving Your Customized Purchase Order.    When you click OK in the Customize window, the format 
you're working on is saved as the User-Customized (Service or Item) Purchase Order.    If you've saved a 
customized format previously, you're warned that this version will replace the previous version.

Note:    The Pre-Printed format and the Plain Paper format are not changed.    Regardless of which format 
you originally selected to customize, the customized format is always saved as the User-Customized 
Purchase Order.

Review Purchase Orders Before Printing
When you click OK, a list of purchase orders matching your selection criteria is displayed.    They are all 
checked.    If you do not wish to print one, click the checkmark to de-select it.

If you wish to see a purchase order on the list, click the arrow.

After you've reviewed the list, click Print.

See Also
Print Purchase Orders



Finding, Changing, Deleting, and Reversing Other Purchases

Erasing a Purchases & Payables Journal Entry Before It's Recorded
Finding a Purchases & Payables Journal Entry
Changing or Deleting a Purchases Journal Entry
Reversing a Purchases & Payables Journal Entry



Erasing a Purchases & Payables Journal Entry Before It's Recorded

If, while entering a purchase, you need to start over, choose Erase Purchase from the Edit menu.

See Also
Finding, Changing, Deleting, and Reversing Other Purchases



Finding a Purchases & Payables Journal Entry

Select Analyze Payables from the Purchases & Payables command center.    If the purchase you're 
looking for has been paid, be sure to check Include $0.00 Balance Purchases.

A summary list of your vendors is displayed.    Click the arrow to the left of the desired vendor.    All 
purchases from that vendor are displayed.    Click the arrow next to the desired purchase.    All 
transactions relating to that purchase are displayed.    Click the arrow next to the purchase order number 
and the original purchase is displayed.    (If you're in the middle of entering a new purchase in the Other 
Purchases window, you're asked to record or erase it before displaying a previous purchase.)

See Also
Finding, Changing, Deleting, and Reversing Other Purchases



Changing or Deleting a Purchases Journal Entry

Note:    The following discussion applies to those users who have chosen to make their data file 
Unchangeable.    If your data file is Changeable, you may change or delete entries at any time.    See 
Customize M.Y.O.B. for a discussion of Changeable versus Unchangeable.

Prior to saving, a purchase may be changed or deleted (choose Delete from the edit menu).    If you have 
made payments on the purchase, you must delete the payments prior to deleting the purchase.

Once you save your data, you may view it and automatically reverse it, but you may not change or delete 
the purchase.    See Reversing a Purchases & Payables Journal Entry. 

See Also
Finding, Changing, Deleting, and Reversing Other Purchases



Reversing a Purchases & Payables Journal Entry
Follow the directions in Finding a Purchases & Payables Journal Entry.

Reversing an Unpaid Purchase.    To reverse a displayed purchase, choose Reverse Purchase from the 
Edit menu, review the purchase number and date, and click OK.    A new debit purchase is created.    Use 
Settle Debits to apply this debit to the original purchase.

Note:    If there have been any payments on this purchase, when the purchase is reversed, the payments 
are not reversed.    For examples, see the following sections, "Reversing a Completely Paid Purchase," or
"Reversing a Partially Paid Purchase."

Note:    You may not change the accounts and amounts in a reversing purchase.    

Note:    Be aware of the recording date of a reversing purchase.    If you use the current date when you 
reverse a purchase from a prior month, the monthend financials for the prior month will not reflect the 
reversing purchase.    If you use the original date for the reversing purchase, your prior month financials 
should be reprinted.

Reversing a Completely Paid Purchase.    Reversing a paid in full purchase (also called a "closed 
purchase order") creates a new debit purchase, but does not reverse the payments.    Use Settle Debits to
deposit a refund check or apply the payment to an open payable.

Example:    You enter a purchase for $25 that is paid in full.    You return the purchase the next day.
1. Locate the purchase in Analyze Payables and click the gray arrow to display it.
2. Select Reverse Purchase from the Edit menu.
3. Verify the date and journal number and click OK.    Now you have yesterday's $25 

purchase with a $25 payment, and today's debit purchase for ($25).
4. Select Settle Debits.    A list of the debit purchases is displayed.    Choose the $25 debit 

purchase just entered.
5. You may:

a. Deposit a Refund Check.    Verify the ID number, memo and date.    Click Record.
b. Apply to an Open Purchase Order.    Enter the $25 next to the desired open 

purchase order and press Tab.    Click Record.

Reversing a Partially Paid Purchase.    If there were any payments made on this purchase, reversing 
the purchase creates a new debit purchase, but does not reverse the payments.    You must do two things:

1. Use Settle Debits to wipe out the outstanding payable of the original purchase.
2. Use Settle Debits to handle the partial payment by either depositing a refund check or 

applying it to another open payable.

Example:    You enter a purchase for $100 with $25 paid today.    You return the purchase the next day.
1. Locate the purchase in the Analyze Payables and click the gray arrow to display it.
2. Select Reverse Purchase from the Edit menu.
3. Verify the date and purchases number and click OK.    Now you have yesterday's $100 

purchase with a $25 payment (leaving a $75 open payable) and today's debit purchase of
($100).

4. Select Settle Debits.    A list of the debit purchases is displayed.    Choose the $100 debit 
purchase just entered and click Apply to Open Purchase Order.

5. At this point you have three options:
a. Apply $75 of this debit to the open $75 payable.    Apply the remaining $25 to 

another open payable.    Click Record.
b. Change the debit amount from $100 to $75.    Enter $75 next    to the open 

purchase order and press Tab.    Click Record. (Remember, you still have a $25 
debit.)



c. Apply $75 of this debit to the open $75 payable.    Reselect Settle Debits.    Select
the remaining $25 debit and click Deposit a Refund Check.    Verify the ID 
number, memo and date.    Click Record.

See Also
Finding, Changing, Deleting, and Reversing Other Purchases



Finding, Changing, Deleting, and Reversing Purchase Orders

Erasing an Item Purchase Order Before It's Recorded
Finding an Item Purchase Order
Changing or Deleting an Item Purchase Order
Reversing an Item Purchase Order
Erasing a Service Purchase Order Before It's Recorded
Finding a Service Purchase Order
Changing or Deleting a Service Purchase Order
Reversing a Service Purchase Order



Erasing an Item Purchase Order Before It's Recorded

If, while entering a purchase order you need to start over, choose Erase Purchase Order from the Edit 
menu.

See Also
Finding, Changing, Deleting, and Reversing Purchase Orders



Finding an Item Purchase Order

Select Analyze Payables from the Purchases & Payables command center.    If the purchase you're 
looking for has been paid, be sure to check Include $0.00 Balance Purchases.

A summary list of your vendors is displayed.    Click the arrow to the left of the desired vendor.    All 
purchases from that vendor are displayed.    Click the arrow next to the desired purchase.    All 
transactions relating to that purchase are displayed.    Click the arrow next to the purchase order number 
and the original purchase is displayed. (If you're in the middle of entering a new purchase order, you're 
asked to record or erase it before displaying a previous purchase order.)

See Also
Finding, Changing, Deleting, and Reversing Purchase Orders



Changing or Deleting an Item Purchase Order

Note:    The following discussion applies to those users who have chosen to make their data file 
Unchangeable.    If your data file is Changeable, you may change or delete entries at any time.    See 
Customize M.Y.O.B. for a discussion of Changeable versus Unchangeable.

Prior to saving, a purchase order may be changed or deleted (choose Delete Purchase Order from the 
edit menu).    If you have made payments on the purchase order, you must delete the payments prior to 
deleting the purchase order.

Once you save your data, you may view it and automatically reverse it, but you may not change or delete 
the purchase order.    See Reversing an Item Purchase Order. 

See Also
Finding, Changing, Deleting, and Reversing Purchase Orders



Reversing an Item Purchase Order

Note:    The following discussion applies to those users who have chosen to make their data file 
Unchangeable.    If your data file is Changeable, you may change or delete entries at any time.    See 
Customize M.Y.O.B. for a discussion of Changeable versus Unchangeable.

If you've saved your data, you can no longer change or delete a purchase order.    You must either reverse
the entire purchase order or generate a new purchase order with negative quantities.

The following includes instructions for:
Returns on an unpaid purchase order
Returns on a completely paid purchase order
Returns on a partially paid purchase order
Item Purchase Order adjustments

Returns on an Unpaid Purchase Order.    If you return all the items on a purchase order, choose 
Reverse Purchase from the Edit menu.    A new debit purchase order is created.    Use Settle Debits to 
apply the negative balance of the debit purchase order against the open balance of the original purchase 
order.

If you return just some of the items on a purchase order, create a new item purchase order with negative 
quantities.    In addition to correcting your inventory, this creates a purchase order with a negative balance
due.    This is called a "debit purchase order."    Remember to use Settle Debits to apply the balance of the
debit purchase order against the original purchase order.    If you don't, the balance due from the original 
purchase order will remain in your payables file.

Example:    You buy 50 widgets, and return them the next day.
1. Call up the original purchase order and choose Reverse Purchase Order from the Edit 

menu.    When you record the reversal, a debit purchase order is created.
2. Select Settle Debits.    Select the new debit purchase order.    Apply the debit amount to 

the original order.    Both the original purchase order and the debit purchase order are 
now closed.

Returns on a Completely Paid Purchase Order.    Follow the instructions for processing a return in the 
preceding section.    If you've paid the original purchase order, use Settle Debits to deposit the refund 
check or apply the payment to an open payable.
Example:    You enter a purchase for $25 that is paid in full.    You return the purchase the next day.

1. Create a $25 debit purchase order (by either reversing the original or creating a new debit
purchase order).

2. Select Settle Debits.    A list of debit purchases is displayed.    Choose the $25 debit 
purchase order just created.

3. You may:
a. Deposit a Refund Check.    Verify the ID number, memo and date.    Click Record.
b. Apply to an Open Purchase Order.    Enter the $25 next to the desired open 

purchase order and press Tab.    Click Record.    

Returns on a Partially Paid Purchase Order.    Follow the instructions for processing a return.    If you've
made a partial payment of the original purchase order, use Settle Debits to deposit the refund check or 
apply the payment to an open payable.

Example:    You enter a purchase for $100 with $25 paid today.    You return the purchase the next day.
1. Create a $100 debit purchase order (by either reversing the original or creating a new 

debit purchase order).
2. Select Settle Debits.    A list of debit purchases is displayed.    Choose the $100 debit 

purchase just created and click Apply to Open Purchase Order.
3. At this point you have three options:



a. Apply $75 of this debit to the open $75 payable.    Apply the remaining $25 to 
another open payable.    Click Record.

b. Change the debit amount from $100 to $75.    Enter $75 next to the open 
purchase order and press Tab.    Click Record.    (Remember, you still have a $25
debit.)

c. Deposit a refund check.    Reselect Settle Debits.    Select the remaining $25 debit
and click Deposit a Refund Check.    Verify the ID number, memo and date.    
Click Record.

Item Purchase Order Adjustments.
An adjustment is needed when items are not returned, but the price or sales tax on the purchase order is 
incorrect.    To process an adjustment, you must write a new purchase order.    There are two ways to 
process an adjustment:

1. The method that gives you the best record of the adjustment is to return the item by 
entering a negative quantity with the original price, discount, job, and sales tax 
checkmark.    On the next line rebuy the item by entering a positive quantity with the 
adjusted price, discount, job, or sales tax checkmark.

2. A faster, but less desirable method is to calculate the adjusting amount and write a 
service purchase order for it.

If the new purchase order has a positive balance due, it becomes a new payable.    If it has a negative 
balance due, it becomes a debit purchase order.    Use Settle Debits to apply the balance of the debit 
purchase order against the original purchase order.

See Also
Finding, Changing, Deleting, and Reversing Purchase Orders



Erasing a Service Purchase Order Before It's Recorded

If, while entering a purchase order, you need to start over, choose Erase Purchase Order from the Edit 
menu.



Finding a Service Purchase Order

Select Analyze Payables from the Purchases & Payables command center.    If the purchase you're 
looking for has been paid, be sure to check Include $0.00 Balance Purchases.

A summary list of your vendors is displayed.    Click the arrow to the left of the desired vendor.    All 
purchases to that vendor are displayed.    Click the arrow next to the desired purchase.    All transactions 
relating to that purchase are displayed.    Click the arrow next to the purchase order number and the 
original purchase is displayed.    (If you're in the middle of entering a new purchase order, you're asked to 
record or erase it before displaying a previous purchase order.)

See Also
Finding, Changing, Deleting, and Reversing Purchase Orders



Changing or Deleting a Service Purchase Order

Note:    The following discussion applies to those users who have chosen to make their data file 
Unchangeable.    If your data file is Changeable, you may change or delete entries at any time.    See 
Customize M.Y.O.B. for a discussion of Changeable versus Unchangeable.

Prior to saving, a purchase order may be changed or deleted (choose Delete Purchase Order from the 
edit menu).    If you have made payments on the purchase order, you must delete the payments prior to 
deleting the purchase order.

Once you save your data, you may view it and automatically reverse it, but you may not change or delete 
it.    See Reversing a Service Purchase Order. 

See Also
Finding, Changing, Deleting, and Reversing Purchase Orders



Reversing a Service Purchase Order

Note:    The following discussion applies to those users who have chosen to make their data file 
Unchangeable.    If your data file is Changeable, you may change or delete entries at any time.    See 
Customize M.Y.O.B. for a discussion of Changeable versus Unchangeable.

If you've saved your data, you can no longer change or delete a purchase order.    You must either reverse
the entire purchase order or generate a new purchase order with negative amounts.

The following includes instructions for:
Correcting an unpaid purchase order
Correcting a completely paid purchase order
Correcting a partially paid purchase order

Correcting an Unpaid Purchase Order.    Call up the purchase order (see Finding a Service Purchase 
Order) and choose Reverse Purchase Order from the Edit menu.        A new debit purchase order is 
created.    Use Settle Debits to apply the negative balance of the debit purchase order against the open 
balance of the original purchase order.

Correcting a Completely Paid Purchase Order.    Call up the purchase order (see Finding a Service 
Purchase Order) and choose Reverse Purchase Order from the Edit menu.        A new debit purchase 
order is created.    Use Settle Debits to deposit a refund check or apply the payment to an open payable.

Example:    You enter a purchase for $25 that is paid in full.    You return the purchase the next day.
1. Reverse the original $25 purchase order.
2. Select Settle Debits.    A list of debit purchases is displayed.    Choose the $25 debit 

purchase order just created.
3. You may:

a. Deposit a Refund Check.    Verify the ID number, memo and date.    Click Record.
b. Apply to an Open Purchase Order.    Enter the $25 next to the desired open 

purchase order and press Tab.    Click Record.    

Correcting a Partially Paid Purchase.    Call up the purchase order (see Finding a Service Purchase 
Order) and choose Reverse Purchase Order from the Edit menu.        A new debit purchase order is 
created.    Use Settle Debits to deposit a refund check or apply the payment to an open payable.

Example:    You enter a purchase for $100 with $25 paid today.    You return the purchase the next day.
1. Reverse the original $100 purchase order.
2. Select Settle Debits.    A list of debit purchases is displayed.    Choose the $100 debit 

purchase just created and click Apply to Open Purchase Order.
3. At this point you have three options:

a. Apply $75 of this debit to the open $75 payable.    Apply the remaining $25 to 
another open payable.    Click Record.

b. Change the debit amount from $100 to $75.    Enter $75 next to the open 
purchase order and press Tab.    Click Record. (Remember, you still have a $25 
debit.)

c. Change the debit amount from $100 to $75.    Reselect Settle Debits.    Select the 
remaining $25 debit and click Deposit a Refund Check.    Verify the ID number, 
memo and date.    Click Record.

See Also
Finding, Changing, Deleting, and Reversing Purchase Orders



Finding, Changing, and Deleting Pending Purchases

Finding a Pending Purchase
Changing or Deleting a Pending Purchase



Finding a Pending Purchase

Select Purchase Orders and enter a vendor.    A dialog listing all pending purchases for this vendor will 
appear.    Select the desired purchase.

See Also
Finding, Changing, and Deleting Pending Purchases



Changing or Deleting a Pending Purchase

There are two type of pending purchases: those without deposits and those with deposits.

Pending Purchases Without Deposits.    Since a pending purchase without a deposit does not create a 
cash or inventory transaction, you may change or delete it at any time. Once it is displayed, delete it by 
choosing Delete Pending Purchase from the Edit menu.    Or change it and then put it back by clicking 
Pending File.

Pending Purchases With Deposits.    A pending purchase with a deposit may not be deleted unless the 
deposit is deleted.    Remember, once you save your data, you cannot delete the deposit.

To remove a pending purchase with an "undeletable" deposit, you must erase the detail of the purchase 
order (change all quantities to zero or change the type of purchase order) and record it as an actual 
purchase.    This creates a purchase order with a negative balance due, also known as a debit purchase 
order.    Use Settle Debits to apply the debit to an open payable.

Note:    When you record a pending purchase with a deposit as an actual purchase, M.Y.O.B. Accounting 
moves the money from your deposits accounts to your linked payables account.    Your linked deposits 
account is reduced (credited) by the amount of the deposit and the linked payables account is debited.    

See Also
Finding, Changing, and Deleting Pending Purchases



Finding, Deleting, and Reversing Settle Debits

Erasing a Debit Before It's Recorded
Finding an Applied Debit Transaction
Deleting an Applied Debit
Reversing an Applied Debit
Erasing a Refund Check Before It's Recorded - Debit
Finding a Refund Check - Debit
Changing or Deleting a Refund Check - Debit
Reversing a Refund Check - Debit



Erasing a Debit Before It's Recorded

If, while entering a transaction, you need to start over, choose Erase Debit from the Edit menu.

See Also
Finding, Deleting, and Reversing Settle Debits



Finding an Applied Debit Transaction

An applied debit is recorded in the Purchases & Payables Journal.    When you settle a debit purchase 
order by applying it against an open purchase order (the most common situation), the cash transaction 
contains two entries to your linked payables account.    The first is a credit to payables which settles the 
debit purchase order.    The second entry is a debit to payables which reduces the balance due of the 
applied purchase order.

Click the journal icon in the Purchases & Payables command center to zoom to the Purchases & 
Payables journal display.

The date range defaults to the current month.    All Purchases & Payables journal transactions between 
(and including) the From and To dates are displayed.    Every transaction has a small arrow to its left.    
Click the arrow to display the transaction.    (If you're in the middle of applying a debit, you're asked to 
record or erase it before displaying a previous transaction.)

See Also
Finding, Deleting, and Reversing Settle Debits



Deleting an Applied Debit

Note:    The following discussion applies to those users who have chosen to make their data file 
Unchangeable.    If your data file is Changeable, you may change or delete entries at any time.    See 
Customize M.Y.O.B. for a discussion of Changeable versus Unchangeable.

Prior to saving, an applied debit may be deleted.    Choose Delete Debit from the Edit menu.    Once you 
save your data, you may no longer delete an applied debit.    You may only reverse it.    See Reversing an 
Applied Debit.

See Also
Finding, Deleting, and Reversing Settle Debits



Reversing an Applied Debit

Note:    The following discussion applies to those users who have chosen to make their data file 
Unchangeable.    If your data file is Changeable, you may change or delete entries at any time.    See 
Customize M.Y.O.B. for a discussion of Changeable versus Unchangeable.

Follow the directions in Finding an Applied Debit Transaction.    To reverse an applied debit, choose 
Reverse Debit from the Edit menu, review the ID number and date, and click Record.    The debit is 
"unapplied."    That is, the debit purchase order is recreated and the balance due of the applied purchase 
order is increased. 

Note:    You may not change the accounts and amounts in a reversing transaction.    

Note:    Be aware of the recording date of a reversing transaction.    If you use the current date when you 
reverse a transaction from a prior month, the monthend financials for the prior month will not reflect the 
reversing transaction.    If you use the original date for the reversing transaction, your prior month 
financials should be reprinted.

See Also
Finding, Deleting, and Reversing Settle Debits



Erasing a Refund Check Before It's Recorded - Debit

If, while entering a transaction, you need to start over, choose Erase Debit from the Edit menu.

See Also
Finding, Deleting, and Reversing Settle Debits



Finding a Refund Check - Debit

Click the Cash Receipts journal icon in the Checkbook command center to zoom to the Cash Receipts 
display.    This shows all entriesfor all cash accountsin the Cash Receipts journal. 

The date range defaults to the current month.    All transactions between (and including) the From and To 
dates are displayed.    All check transactions have a small arrow to their left.    A refund check is a credit to 
your linked payables account, balanced by a debit to your checking account. 

Click the arrow to display the refund check transaction.    (If you're in the middle of depositing refund 
check, you're asked to record or erase it before displaying a previous transaction.)

See Also
Finding, Deleting, and Reversing Settle Debits



Changing or Deleting a Refund Check - Debit

Note:    The following discussion applies to those users who have chosen to make their data file 
Unchangeable.    If your data file is Changeable, you may change or delete entries at any time.    See 
Customize M.Y.O.B. for a discussion of Changeable versus Unchangeable.

Prior to saving, a refund check may be deleted.    Choose Delete Debit from the Edit menu.    Once you 
save your data, you may no longer delete a refund check.    You may only reverse it.    See Reversing a 
Refund Check.

See Also
Finding, Deleting, and Reversing Settle Debits



Reversing a Refund Check - Debit

Follow the directions in Finding a Refund Check.

To reverse a refund check, choose Reverse Debit from the Edit menu, review the ID number and date, 
and click Record.    Your checkbook balance is decreased and the debit is "unapplied."    That is, the debit 
purchase order is recreated.

Note:    You may not change the accounts and amounts in a reversing transaction.    

Note:    Be aware of the recording date of a reversing transaction.    If you use the current date when you 
reverse a transaction from a prior month, the monthend financials for the prior month will not reflect the 
reversing transaction.    If you use the original date for the reversing transaction, your prior month 
financials should be reprinted.

See Also
Finding, Deleting, and Reversing Settle Debits



Finding, Deleting, and Reversing Vendor Payments

Erasing a Vendor Payment Before It's Recorded
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Reversing a Vendor Payment



Erasing a Vendor Payment Before It's Recorded
If, while entering a transaction, you need to start over, choose Erase Payment from the Edit menu.

See Also
Finding, Deleting, and Reversing Vendor Payments



Finding a Vendor Payment

From the Inquiry menu, choose Search by Card.    Select the desired vendor.    All transactions for the 
selected vendor (within the specified date range) are displayed.    Any payments made were recorded in 
the Cash Disbursements journal, so "CD" is noted under source journal. Locate the payment and click the
arrow to its left.    The original payment is displayed.      (If you're in the middle of making a payment, you're
asked to record or erase it before displaying a previous transaction.)

See Also
Finding, Deleting, and Reversing Vendor Payments



Changing or Deleting a Vendor Payment

Note:    The following discussion applies to those users who have chosen to make their data file 
Unchangeable.    If your data file is Changeable, you may change or delete entries at any time.    See 
Customize M.Y.O.B. for a discussion of Changeable versus Unchangeable.

Prior to saving, a payment may be deleted.    Choose Delete Payment from the Edit menu.    Once you 
save your data, you may no longer delete a payment.    You may only reverse it.    See Reversing a 
Payment.

See Also
Finding, Deleting, and Reversing Vendor Payments



Reversing a Vendor Payment

Note:    The following discussion applies to those users who have chosen to make their data file 
Unchangeable.    If your data file is Changeable, you may change or delete entries at any time.    See 
Customize M.Y.O.B. for a discussion of Changeable versus Unchangeable.

Follow the directions in Finding a Vendor Payment.

To reverse a payment, choose Reverse Payment from the Edit menu, review the ID number and date, and
click OK.    Your checkbook balance is increased and the payment is "unapplied".    That is, the open 
purchase order is recreated.

Note:    You may not change the accounts and amounts in a reversing transaction.    

Note:    Be aware of the recording date of a reversing transaction.    If you use the current date when you 
reverse a transaction from a prior month, the monthend financials for the prior month will not reflect the 
reversing transaction.    If you use the original date for the reversing transaction, your prior month 
financials should be reprinted.

Note:    Be aware that if a discount for early payment was taken    for a payment you are reversing you will 
have to reverse the discount.    M.Y.O.B. Accounting will alert you to this via a dialog box.    The original 
discount transaction is in the Purchases Journal.    Find it and click the arrow to its left.      When the 
discount transaction is displayed, reverse it.

See Also
Finding, Deleting, and Reversing Vendor Payments



Payroll

Wages
Money paid to employees for work done, including salaries, hourly earnings, bonuses, commissions, and 
other employee income.    

Deductions
Amounts, other than taxes, taken out of an employees paycheck (either voluntarily or involuntarily). 

Employer Expenses
Costs regarding employees paid by the employer (and not deducted from the employees paycheck), such
as matching payroll taxes and the employers portion of benefits.

Write Paychecks
The Write Paychecks window looks like a check, and is very similar to the Write Checks window in 
M.Y.O.B. Accounting.

Set Up Payroll
There are four basic steps to setting up M.Y.O.B. Payroll:

Load Tax Tables
Set up Payroll Linked Accounts
Set Payroll Year and Tax Defaults
Enter Payroll Information and Review Default Payroll Categories.

 
Analyze Payroll
Analyze payroll is a quick, powerful and interactive way to review valuable information about the pay of 
each employee, his/her deductions, taxes withheld, your Employer Expenses, and the actual direct costs 
(salary plus Employer Expenses) of that employee.

Print W-2s
In order to print the IRS Form W-2, you must tell M.Y.O.B. Payroll certain information.

Print Paychecks
Print Paychecks in M.Y.O.B. Payroll is the same as Print Checks in M.Y.O.B. Accounting .    You may 
order compatible checks and envelopes (see the order form included with your M.Y.O.B. Small Business 
Accounting with Payroll    package) or customize the check printing to fit your existing checks.



Employee Payroll Information

Wage Expense Account is the default account entered in Linked Payroll Accounts.    You may change it 
to any Expense account.

Pay Basis (Hourly or Salary) determines whether an employee is paid on the basis of number of hours 
worked or a fixed salary (although a salaried employee may be given overtime or other wages on an 
hourly basis).

Annual Base Pay/Hourly Base Pay is displayed and entered depending upon whether an employee is 
Hourly or Salary.    Enter the correct figure. 

Pay Frequency may be Weekly, Bi-Weekly (every other week), Semi-Monthly, or Monthly.

Social Security # is the Employee's Social Security Number.

Hire Date is an optional field for your convenience.

Terminate Date is an optional field for your convenience.

Federal Status/State Status/Local Status.    Your choice of Residence Code determines the available 
choices    Single, Married, Head of Household, or Other.    For Federal and most States, you must enter 
the number of allowances the employee is claiming, and the extra amount the employee has requested to
be withheld from each paycheck (if any).    This information can be found on the Employee's Federal W-4 
and similar State forms.

Because Arkansas, Arizona, Connecticut, Louisiana, and Mississippi require special handling, you 
must enter the appropriate information under Allowances:    

AR Arkansas:    Enter the number of dependents.    Do not include the employee or spouse, if any.
AZ Arizona:    Enter the percentage of Federal withholding elected by the employee on the line 
labeled Allowances.    The calculated Federal income tax withholding will be multiplied by    the 
"number of Allowances" [as a percentage] to determine the Arizona income tax withholding for the
employee.
CT Connecticut:    The exemptions are derived based on the employee's state taxable wages for 
the pay period.    Any amounts entered in this field will be ignored.
LA Louisiana:    Enter the number of dependents.    Do not include the employee or spouse, if any.
MS Mississippi:    Enter the dollar amount for the allowances.    If, for example, the allowance is 
$9,000, enter 9000.00.

Select Payroll Categories allows you to select the Wages categories, Deductions, Employer Expenses 
and Taxes which apply to this particular employee (and which will show on the Paycheck entry screen).



Pay History
If you're starting M.Y.O.B. Payroll anytime after the first pay period of the year, you must enter the 
employees Quarterly (and/or Monthly) Payroll History prior to the first pay period done by M.Y.O.B. 
Payroll.    Enter the month-by-month figures for each Wages category, each Deductions category, each 
Employer Expenses category and each Taxes category which applies to this employee.    

Only those Wages, Deductions, Taxes and Employer Expenses categories which you have selected for 
the employee in the Payroll Information Window will appear in this list. 

If you enter Pay History for a given Quarter and enter the data in the __ Quarter    column, the data will be 
assigned to the first month in the Quarter.



Set Up Payroll
Load Tax Tables 
    
Payroll Linked Accounts

Payroll Checking Account is the checking account you normally use to write your Payroll 
checks.    You can change this when you write paychecks.

Default Employer Expense Account is the account that are charged for your Employer 
Expenses (including all the preset Expenses).    You can change the Expense account for each 
Employer Expense when you enter or edit it.

Default Wages Expense Account is the default General Ledger account that are charged for 
your Wages expenses.    You can change this account for each employee.

Default Withholding Payable Account is the account in which the amounts withheld from the 
employee's paycheck are accrued.    You can change this for each Deduction category Employer 
Expense, and Taxes category.    

Click Record to record the Payroll Linked Accounts. 

Enter General Payroll Information 

The Current Payroll Year is the year for which you want to begin M.Y.O.B. Payroll.

Number of Hours in a Full-Time Work Week is the default number of hours entered in each 
hourly employees paycheck.    This figure is also used for salaried employees if you use any 
hourly based Wage categories for that employee (such as sick-pay).

Federal Tax ID Number is your EIN (Employers ID Number).    This gets printed on several 
reports and the W-2s.

FUTA (Federal Unemployment) Tax Rate is your FUTA rate.    

Two letter State abbreviation is the US Postal Service two-letter abbreviation (i.e., NJ=New 
Jersey, ME=Maine, TX=Texas, VA=Virginia) for your company's "Home State".

State Payroll Tax ID is the Tax ID you use for payroll reporting for your company's "Home State".

SUTA (State Unemployment) Tax Rate for your company's "Home State".    If you have more 
than one state SUTA (or SDI), you are able to enter additional State Tax IDs and SUTA rates for 
other states in Employer Expenses.

Enter Payroll Info & Review Default Payroll Categories
Enter Employee Payroll Information via the Card File.    By clicking the arrow next to this 
selection, you go to the View Card File window, from which you can select and edit (or add New) 
Employees.

Review (and edit) Default Wages Categories.    By clicking the arrow next to this selection, you 
go to the Wages List window, from which you can select and edit (or add New) Wages 
categories.



Review (and edit) Default Deductions Categories.    By clicking the arrow next to this selection,
you go to the Deductions List window, from which you can select and edit (or add New) 
Deductions categories.

Review (and edit) Default Employer Expense Categories.    By clicking the arrow next to this 
selection, you go to the Employer Expenses List window, from which you can select and edit (or
add New) Employer Expenses categories.

When you click Record, M.Y.O.B. will create some default Wages, Deductions, and Employer Expenses 
categories.    In general, these default categories are not complete.    If you plan to use any of our default 
categories, you should review and edit them to match the actual circumstances of your company.



Load Tax Tables

You must load the M.Y.O.B. Payroll tax tables into the program when you first set up M.Y.O.B. Payroll.    
Load Tax Tables is also used to load updated tax tables received from Best!Ware (if you subscribe to our 
tax update service).    To load, click Load Tax Tables.



 General Payroll Information

The Current Payroll Year is the year for which you want to begin M.Y.O.B. Payroll.

Number of Hours in a Full-Time Work Week is the default number of hours entered in each hourly 
employee's paycheck.    This figure is also used for salaried employees if you use any hourly based Wage
categories for that employee (such as sick-pay).

Federal Tax ID Number is your EIN (Employer's ID Number).    This gets printed on several reports and 
the W-2s.

FUTA (Federal Unemployment) Tax Rate is your FUTA rate.    

Two letter State abbreviation is the US Postal Service two-letter abbreviation (i.e., NJ=New Jersey, 
ME=Maine, TX=Texas, VA=Virginia) for your company's "Home State".

State Payroll Tax ID is the Tax ID you use for payroll reporting for your company's "Home State".

SUTA (State Unemployment) Tax Rate for your company's "Home State".    If you have more than one 
state SUTA (or SDI), you are able to enter additional State Tax IDs and SUTA rates for other states in 
Employer Expenses.

When you click Record, M.Y.O.B. Payroll will create some default Wages, Deductions, and Employer 
Expenses categories.    



Wages List
You may add, edit or delete Wages categories (except for Base Salary and Base Hourly which may be 
renamed, but may not be deleted). 

To enter a new Wages category click New at the bottom of the list.

To edit a Wages category, click on the arrow next to the Wages Name to go to the Wages Information 
window.

To delete a Wages category, click on the arrow next to the Wages Name, and from the Wages Information
window, choose Delete Wage Category  from the Edit menu.



 Wages Information

Wages Name    
Enter the name of the Wages category. 

Type of Wages
Select either Hourly or Salary to specify whether the computation will be based upon the hours worked or 
an amount per pay period/month/year.

Pay Rate Multiplier
This line appears only for Hourly-type Wages.    For example:    2 for "double-time" or 1.5 for "time and a 
half".

Non-Cash Wages 
Non-Cash Wages is taxable income to the employee which is not included in the employee's check.    
Include taxable fringe benefits which must have taxes withheld, but for which the employee receives no 
payment and Tips (for Federal tax reporting purposes).    If you've selected Non-Cash Wages, you are 
given a further choice:

Reported Tips (specific to the Restaurant/Hospitality industry)
Allocated Tips (specific to the Restaurant/Hospitality industry)
Other Non-Cash Wages 



Deductions List
We've given a list of some basic employee Deductions.    You may add or delete Deductions. By clicking 
the arrow next to the category, the Deduction Information window appears.



Deduction Information

Deduction Name    
Enter the name of the Deduction category.

Linked Payable Account    
This is the General Ledger account (usually a Liability Account) to which all the deducted money will be 
accrued.

Type of Deduction

User-Entered Amount per Pay Period is used if you wish to manually enter a specific amount for 
each employee each pay period.

__ Percent of [    ] allows you to enter a percentage of any of the Wages    categories.    

__ Dollars per [    ] allows you to deduct the specified amount per pay period, per month, or per year.

Deduction Limits
No Limit signifies no limit on the amount of money that will be deducted from the Employee's 
paycheck for this category.

__ Percent of [    ].    The maximum deduction is a percentage of a Wages category; for example, a 
deduction might be    $50 per week up to a maximum of    50% of the Employee's Base Salary.

__ Dollars per [    ].    The maximum amount is a fixed dollar amount per pay period, per month, or per
year;    for example, a deduction might be 10% of the Employee's Gross Wages up to $1500 per year.



Employer Expenses List

Weve given a list of some basic Employer Expenses.    You may add or delete Employer Expense 
categories.      By clicking the arrow next to the Deduction Name, the Employer Expense Information 
window appears.

To add an Employer Expense, click the New button at the bottom of the Deductions List.

To delete an Employer Expense, click the arrow next to the Deduction Name to zoom to the Employer 
Expense Information window, then select Delete Employer Expense  from the Edit menu.    You cannot 
delete FICA and FUTA Employer Expenses.



Employer Expense Information

Deduction Name    
Enter the name of the Deduction category.

Linked Payable Account    
This is the General Ledger account (usually a Liability Account) to which all the deducted money will be 
accrued.

Type of Deduction
User-Entered Amount per Pay Period is used if you wish to manually enter a specific amount for 
each employee each pay period.

__ Percent of [    ] allows you to enter a percentage of any of the Wages    categories.    

__ Dollars per [    ] allows you to deduct the specified amount per pay period, per month, or per year.

Deduction Limits
No Limit signifies no limit on the amount of money that will be deducted from the employee's 
paycheck for this category.    

__ Percent of [    ].    The maximum deduction is a percentage of a Wages category; for example, a 
deduction might be    $50 per week up to a maximum of    50% of the employee's Base Salary.

__ Dollars per [    ].    The maximum amount is a fixed dollar amount per pay period, per month, or 
per year;    for example, a deduction might be 10% of the Employee's Gross Wages up to $1500 per 
year.



Linked Employees

By clicking on this icon, you can select the employees who qualify for this Deductions category (i.e., the 
deduction selected automatically appear on the employees paycheck screen).



Deduction Exemptions

Exemptions lets you make the Deductions from the employee's Wages prior to the computation of the 
taxes (in other words, a pre-tax Deduction).    Be careful before you exempt any Deductions from taxes.    
Remember that the IRS may be looking over your shoulder!!



Employer Expense Exemptions

By clicking Exemptions, you can exempt any Wages Category from the Employer Expenses calculations.
Click the Exempt column to select the Wages Category exempt from the Employer Expense.



Wages Exemptions

Pressing the Exemptions button lets you exempt any Wages category from the listed taxes and 
deductions.



Write Paychecks

Select Account
In the upper left of the Write Paychecks window is a pop-up menu containing all accounts with checking 
privileges. 
 
Balance
Balance is the current balance of the selected checking account.    Click the arrow to zoom to the Account 
Transaction Detail window to see all the activity in this account.

Handwritten
If the paycheck is not going to be printed by M.Y.O.B. Payroll, check Handwritten.    M.Y.O.B. Payroll then
considers the check as having already been printed.    When you print your checks, select All Unprinted 
Checks and the "handwritten" check is not included.

Check Number
M.Y.O.B. Payroll provides a default Check # using the Last Check Number field from the account 
information entered in Chart of Accounts.    If you change the check number, it resets the Last Check 
Number field.

Date
All checks are sorted by Date.    You may not enter a date prior to the conversion month or in a prior fiscal 
year.    If you enter a future date, M.Y.O.B. Payroll accepts it, but warns you that the date is probably in 
error.

Payee
Enter the Employee's name here.    When you do, the Address field is automatically filled in (if youve 
entered that information on the Employee's Card).    Click the arrow to zoom to the Employee's Card.

Memo
Enter whatever youd like.    The Memo can be up to 255 characters, but because of report display 
limitations, it is most useful to limit your memos to 40 or 50 characters.    If you change the default, we 
suggest you include the word "Paycheck" in the memo to remind you of the nature of the transaction.

Net Pay
The Net Pay for the employee is calculated by M.Y.O.B. Payroll from the information entered in the 
Paycheck Detail.      

Paycheck Detail
All of the Wages, Deductions, Employer Expenses, and Taxes youve selected for this Employee are 
listed. 

Description gives the name of each Wages, Deduction, Employer Expenses, or Taxes category.

Hours lets you enter the number of hours for the category (if applicable).

Amount.    If youve entered amounts when you set up your categories, M.Y.O.B. Payroll will 
perform the necessary calculations.    You can override the amount on any line.    If you change 
Amounts, Taxes, Deductions, or Employer Expenses (if dependent upon the changed amount) 
will be recalculated.
    
Job
For each line of the Paycheck Detail allocated to a P&L account, you can assign the amount to a 
Job.      Type the Job number and press Tab.    If youre unsure of the job number, press Control-L 
to see the Jobs list.    Select a job from the Jobs list or click New Job to create a new one.



Recurring Check Transactions
You can save this Paycheck as a Recurring Transaction.    When you save a check as recurring, M.Y.O.B. 
Payroll puts a copy of it in a separate list of Recurring Transactions.    Anytime you need to write the 
paycheck for this Employee, just click Use Recurring.

Save as Recurring.    
Every Recurring check needs a name.    We suggest the name be something like "Paycheck: [Employee's
Name]", up to 30 characters. 

If    you specify the frequency of the transaction (weekly, bi-weekly, semi-monthly, or monthly) M.Y.O.B. 
Payroll includes a reminder in your To Do List and adjusts for it on your Cash Flow Worksheet.    

Journal Icon
The Wages, Deductions and Taxes from Payroll checks, and their linked accrual amounts, are recorded in
the M.Y.O.B. Accounting Cash Disbursements Journal (as are all other checks written in M.Y.O.B. 
Accounting).

Employer Expenses and their allocation accounts are recorded in the General Journal.    

By clicking the Journal icon, you can see all portions of the Paycheck transaction by switching the Source
Journals.

The date range defaults to the current month.    All transactions between (and including) the Dated From 
and To dates are displayed.    All paycheck transactions have an arrow to their left.    Click the arrow to 
display the check.



Analyze Payroll

Analyze Payroll gives you valuable information about the pay of each employee, his/her deductions, 
taxes withheld, your Employer Expenses, and the actual direct costs (salary plus Employer Expenses) of 
that employee.

Employee 
Choose the employee whose payroll you wish to analyze from the drop-down box.

Pay Period 
Choose a single month, year-to-date, quarter, or last paycheck from the drop-down box.

Payroll Detail 
The Payroll Detail window lists all the Wages, Deductions, Taxes and Employer Expenses for which the 
employee has been paid, or which have been recorded on his/her paycheck, together with the total of that
category for the pay period selected.

Payroll Summary
The Payroll Summary window displays the following items for the pay period selected:

Gross Wages    (the total of all Wages categories for the employee).

Non-Cash Wages (if any) for the employee.

Total Wages = Gross Wages    Non-Cash Wages.

Total Taxes Withheld from the employee's paycheck(s).

Total Deductions from the employee's paycheck(s).

Net Wages  [the net amount of the employee's paycheck(s)    (Total Wages    Taxes Withheld - Total 
Deductions)].

Employer Expenses    the total of the Employer Expenses for the employee for the pay period 
selected.

Total Direct Payroll Costs = Total Wages + Employer Expenses.



Tax Table List
You can use the View Tax Tables window to make sure you have the current tax tables, to change the 
Linked Payables Account for that tax, or to review the tables themselves.

You can View Tax Tables in three different ways:
1.    Choose View Tax Tables from the Command Centers    Payroll pull-down menu.    The Tax 
Table List shows all the federal, state and local taxes available to the Smart Tax Engine.    Click the 
arrow next to the tax you wish to view.

To view individual Tax Table Information:
2.    Click the arrow next to the tax you wish to view from the Analyze Payroll screen.
3.    Click the arrow next to the tax you wish to view from the Pay History window (from the 
Employee Payroll Information window of the Employee's Card.



Tax Table Info

Tax Table Information for each tax category is shown on this screen.    By clicking the buttons for "All 
Statuses", "Married", "Single", "Head of Household", and "Other" you will be shown the tax table, base 
amounts, and exemptions (if applicable) for the selected tax.    If your selected tax doesnt have some of 
the button choices, they will not display.

You can enter a Linked Payables Account for this tax (different from the default Linked Payables 
account you entered when you set up M.Y.O.B. Payroll).



Print W-2s

The Name, Address, Zip, and Fed Employer ID# fields are filled in by M.Y.O.B. Payroll from the 
Company Information you entered when you Set Up M.Y.O.B. or Set Up Payroll.    You can change them 
here.

On the left side of the Set Up W-2 window, weve listed those boxes which have flexible reporting 
requirements.    You should refer to the IRS publication Instructions for Form W-2 for information on which 
Wages and/or Deductions should be included in these boxes.

To link the W-2 boxes with your categories, click the W-2 box on the left to highlight it.    A list of all your 
Wages and Deductions will appear on the right.    Click the Select column, and the total of those Wages or
Deductions categories for each employee will be entered into the appropriate W-2 box.

When you click OK, you are taken to the W-2 Forms Selection window.

Click either Continuous Feed or Laser W-2s.    You may    Print Alignment W-2, or click OK to go to the 
next step. 

From this window, you can review which employees will have W-2 forms printed and click Print, or click 
the arrow to zoom to the W-2 Employee Information Screen. 

The information on the W-2 Employee Information Screen is from the Employee Card, and M.Y.O.B. 
Payrolls Smart Tax Engine.    You can change the information to be printed on the employee's W-2 by 
clicking on the field and entering the new data.

If you need to report any of the items in Form W-2's Box 15, you must click on the checkbox in the
W-2 Employee Information screen for that employee.



How to Find Reports

You can find reports under the Reports menu.    The first selection is the Index to Reports.    The Index to 
Reports is a scrollable list of all the reports in M.Y.O.B. Accounting, sorted by Command Center. In the 
Reports menu, after Index to Reports, is a list of all the reports for the active Command Center.    When 
you select another Command Center, the list of reports changes.    These reports, as well as those from 
all the other command centers, are also available in the Index to Reports.    You may select a report 
directly from the Reports menu or from the Index to Reports.    To select a report from the Index to 
Reports, double-click it or single click it and click OK.    A list of M.Y.O.B. Accounting's reports together 
with a brief description of each report can be found in A List of Reports in Chapter 10 of your User's 
Guide.
See Also

How to Generate Reports
Customizing Reports
Screen Reports



How to Generate Reports

After you select a report, you are presented with the selection criteria dialog.    The dialog is separated 
into three sections.    The top and middle sections contain    criteria specific to the selected report.    Some 
reports have a great deal of selection criteria - date range, level, rounding, etc.    Most have just two or 
three selections.    A couple have no selections in the top and middle sections.    The bottom section is the 
same for every report.    It contains: 

Include Company Name
Check this and your company name and address (from Company Information in Set Up M.Y.O.B.) is 
printed at the top of the first page.    The company name (without the address) is printed at the top of 
every succeeding page. 

Include Report Date
Check this selection to have the current date printed at the top left of every page. 

Screen
M.Y.O.B. Accounting displays the selected report on the screen similar to the way it will appear on your 
printer. 

Note:    Your Page Setup selections affect the screen display.    If, for example, you have landscape 
(sideways) orientation selected in Page Setup, your reports screen display is approximately 11 inches 
wide. If your Page Setup orientation is portrait, the display is approximately 8 inches wide.    Use the 
horizontal scroll bar to view the right side of the report.    Unlike the Printer option, you are not warned if 
the selected report does not fit in the screen display. 
Note:    M.Y.O.B. Accounting has a single screen report window.    If you generate two screen reports, the 
second report will replace the first report. 

Printer
Choose Printer to send the selected report to your printer.    All M.Y.O.B. Accounting reports are designed 
to fit in portrait mode on a continuous-feed printer.    If the selected report will not fit, you are alerted.    To 
make the report fit, you must either change your Page Setup or customize the report.    See the next 
section for customization instructions.

Disk (Tabs)
Select Disk (Tabs) to save the report to a disk file in tab-delimited format.    Tab delimited format means 
that M.Y.O.B. Accounting puts tabs between the fields of the report.    Tab-delimited text files can be 
imported into most spreadsheets, database programs, and word processors.    Use the standard file dialog
to choose where to save the report. 

Disk (Text)
Select Disk (Text) to save the report to a disk file in text format.    Text format means that M.Y.O.B. 
Accounting puts spaces between the fields.    Text files can be imported by most word processors.    Use 
the standard file dialog to choose where to save the report. 

Note:    With text files, there's a good chance that the columns of a report, once moved to your word 
processor, will not be properly aligned.    If this happens, try using a fixed-width font like Courier, or try 
saving the report in tab-delimited format. 

See Also
How to Find Reports
Customizing Reports
Screen Reports



Customizing Reports

From the report selection criteria dialog, click the Customize button.    The report format dialog lets you 
redesign the "look" of M.Y.O.B. Accounting's screen and printed reports.    The left side of the report 
format dialog has seven sections that correspond to the seven sections of a M.Y.O.B. Accounting report.   
Simply click on the section to select it.    Once selected you can change the font, font size and font style 
for the section.    In addition to customizing the report sections, you can set the top and left margins of the 
report.

Report
This is the name of the report.    It appears at the top of every page. 

Company
This is your company's name.    M.Y.O.B. Accounting takes it from your Company Information (in Set Up 
M.Y.O.B.).    If you check Include Company Name in the report selection criteria dialog, your company's 
name appears at the top of every page.

Address
This is your company's address.    M.Y.O.B. Accounting takes it from your Company Information (in Set Up
M.Y.O.B.).    If you check Include Company Name in the report selection criteria dialog, your company's 
address appears at the top of the first page. 

Headers
Header information usually appears at the top of every page and describes the information in the column 
beneath it. 

Subtitles
Whenever a M.Y.O.B. Accounting report involves groups of accounts, cards, jobs, etc., it usually includes 
subtitles at the beginning of the new group. 

Body
This is the detail - accounts, amounts, percents - of the report. 

Subtotals
Whenever a M.Y.O.B. Accounting report involves groups of accounts, cards, jobs, etc., it usually includes 
subtotals at the end of the group. 

Default fonts:    For each of the seven sections described above, M.Y.O.B. Accounting examines the list 
of available printer fonts and selects one which will best fit the text to be printed on the page.

Font    If you choose a system font for your report, it will appear as similar as possible on the screen and 
the printer.    If, however, you use a printer-specific font, M.Y.O.B. Accounting takes the characteristics of 
the chosen printer font and makes the the best match possible to an available screen font in order to 
display the report on the screen.    You may not get a WYSIWYG result.

Size
This is a pop-up of the font sizes.

Style
Use the check boxes to modify the font style.

Left Margin
Enter the left margin in inches.    M.Y.O.B. Accounting adds whatever you enter to the beginning of the 
printable area.    Some printers, for example, cannot print within a quarter inch of the paper's edge.    If you
enter a left margin of 1.5 inches, the report is printed on such a printer 1.75 inches from the left edge of 
the paper.    



Top Margin
Enter the top margin in inches.    M.Y.O.B. Accounting adds whatever you enter to the beginning of the 
printable area.    (See Left Margin.)

See Also
How to Find Reports
How to Generate Reports
Screen Reports



The Customize Window

The Customize window allows you to customize your forms printing.

Data Field.    This field is "filled in" by M.Y.O.B. Accounting    The name of the data field is shown in 
brackets.    The size of a data field is shown by a dotted box.    The name is supplied by M.Y.O.B. 
Accounting

All the available data fields are shown on the form.    You may not delete or change the name of a data 
field.    If you do not want the field printed, you must make it "Inactive."    To make a data field inactive, 
double-click it.    The field information dialog is displayed.      Click the radio button labeled Inactive.    The 
name of the inactive data field is grayed.

Text Field.    This field is controlled by the user.    You may change a text field (double-click it and enter the
new text), or delete a text field (select it and press the Delete key.)

To add a new text field, click on the text tool (the letter A in the palette at the lower left).    Then click on the
form.    A text field is created with the words "Text Field" as the default text.    Doubleclick on the text field 
to change the text.

At any time, you may change the text and/or its font, size or style.    To delete a text field, select it and 
press the Delete key.

Picture Field.    This is a graphic supplied by the user.    Use it, for example, to put your company's logo 
on your forms.    

Before adding a new picture field, be sure to "copy" the desired picture into your computer's memory and 
"paste" it into your Clipboard.

To add a picture field, click on the picture tool (the small picture frame in the box at the lower left).    Then 
click on the form.    A picture field is created with a picture frame as the default graphic.    Next, "copy" 
(from your Clipboard) the desired picture.    Doubleclick the picture field.    Press the Paste Picture button.

To change a picture field, doubleclick it and "paste" the new picture. To delete a picture field, select it and 
press the Delete key.

Line Field.    You may draw horizontal or vertical lines on your forms.    

To add a new line, click the line tool.    Move the mouse pointer to where you want the line to begin.    Then
click and drag the mouse (hold the mouse button down while moving the mouse) to where you want the 
line to end.    Release the mouse button.

You may change the thickness of a line.    Simply doubleclick the line and choose the desired line size in 
the field information dialog.

Rectangle Field.    You may draw rectangles on your forms.    

To add a new rectangle, click the rectangle tool.    Move the mouse pointer to where you want the upper 
lefthand corner of the rectangle.    Then click and drag the mouse (hold the mouse button down while 
moving the mouse) to the lower righthand corner of the rectangle.    Release the mouse button.

You may change the thickness of a rectangle.    Simply doubleclick the rectangle and choose the desired 
frame size in the field information dialog.

Selecting a Field.    Click the arrow tool and then click the desired field.    When the field is selected, it is 
outlined in a black box with a small black rectangle (called a "handle") at the lower righthand corner.



Note:    If a field overlaps another field, when you click, the field "in front" is selected.    If you want to 
select the field behind it, choose Send to Back from the Forms menu.    Then click again. 

Changing the Size of a Field.    When a field is selected, it is outlined with a black rectangle.    A handle 
(a small black box) is at the lower righthand corner of the rectangle (for lines, there's a handle at either 
end of the line).    Click and drag the handle to change the size of the field.

Another, more exact, way to change the size of a field is to double-click it and change its coordinates in 
the field information dialog.

Changing the Location of a Field.    Click in the middle of the field and hold the mouse button down.    
The pointer changes to a hand.    Drag the mouse while keeping the mouse button depressed.    An outline
of the field travels with the hand.    Release the mouse button when the field is at the desired location.

Another more exact way to change the location of a field is to doubleclick it and change its coordinates in 
the field information dialog.

Cutting, Copying, Pasting and Deleting Data Fields.
You can cut, copy and paste data fields within the same form.    You may also cut, copy and paste 
between related forms.    An example of related forms can be found in item invoices.    There are three 
related forms: preprinted, plain paper and customized.    You may cut, copy and paste between these 
three forms.    You may not, for example, copy a field from an item invoice and paste it into a check.

You may delete copies of data fields, unless it is the last copy of the field.    In that case it will not be 
deleted, it will be made inactive.

Changing Font, Size and Style of a Field.    Doubleclick a text or data field to display the field 
information dialog.    Change the font, size or style and click OK.

Note:    You can change the default font for every form by choosing Default Fonts from the File menu or by
clicking Fonts in the Customize M.Y.O.B. Accounting window.

Default Fonts.  You can change the font of every noncustomized form by choosing Default Fonts from 
the File menu or by clicking Fonts in the Customize M.Y.O.B. Accounting window.

The Form Menu.    The Form menu appears in the menu bar whenever you are customizing a form.

Forms Info.    The Form Information Dialog tells M.Y.O.B. Accounting:
How many copies of the form can fit on a single page
The appropriate Page Setup for this form
The top and left margins
The size of the form.

If you have continuous-feed forms, pay careful attention to the relationship between the number of forms 
per page, the requested page setup and the size of the form.    Consider the following formula:

(# forms per page    X    length of the form) =    Page Setup

Example #1:    You have a continuous-feed invoice for your printer that is 8.5" wide and 7" long.    Since 
the lengths in Page Setup can be only 11" (sometimes called Letter) or 14" (Legal), you would have 2 
forms per page and a requested Page Setup of 8.5" X 14". 

Example #2:    You have a single-sheet invoice for your Laser Printer that is 8.5" wide and 7" long.    After 
entering the form size, you would enter 1 form per page and request a Page Setup of 8.5" X 11".    



Remember, any information that falls below 7" will not be printed.

Example # 3:    You have continuous-feed checks for your printer that are 8.5" wide by 3.5" long.    But, 
your checks (unlike the M.Y.O.B. Accounting checks) do not have a stub.    After entering the form size, 
you would enter 4 forms per page and request a Page Setup of 8.5" X 14".    Remember, any information 
that falls below 3.5" will not be printed.

Note:    The Requested Page Setup selection only tells M.Y.O.B. Accounting what to expect when printing 
this form.    It does not change your Page Setup in the File menu.

The top margin and left margin tell M.Y.O.B. Accounting to move the entire printed area down or right (if 
you enter negative numbers, M.Y.O.B. Accounting moves the printing up and/or left).    For most forms, the
top and left margins are usually set to zero.    Mailing labels are the exception.    Since the labels usually 
begin at the very top edge of the page and end at the very bottom edge, most printers are incapable of 
printing the first or last row of labels.    M.Y.O.B. Accounting uses the margins to move the printing down to
the second row of labels.

Hide (Show) Inactive Fields.    Data fields cannot be deleted.    If you do not want a data field printed, you
must make it inactive.    To make a data field inactive, doubleclick it and select Inactive in the field 
information dialog.    The name of the inactive data field is greyed.    Since inactive fields can make your 
form layout visually confusing, you can choose Hide Inactive Fields from the Form Menu.    The inactive 
data fields are removed from the Customize window.    To see the inactive fields choose Show Inactive 
Fields from the Form menu.

Send to Back/Bring to Front.    If a field overlaps another field, when you click, the field "in front" is 
selected.    If you want to select the field behind it, choose Send to Back from the Form menu.    Then click
again.    Conversely, a field in back can be brought forward by selecting it and choosing Bring to Front.

Preview.    Before printing a customized form, it is a good idea to preview it.    To preview a form, click the 
Preview button.
The Preview window shows the form exactly as it will appear when printed.    Remember, anything that 
falls outside the dotted rectangle will not be printed.

Change Fonts.  This is a shortcut for changing the fonts on the current form.    You can change the font 
for all fields on the form or just selected fields.    To select multiple fields on a form, simply click them while
holding down the Shift key.

See Also
Forms Customization - Overview



Screen Reports

M.Y.O.B. Accounting displays the selected report on the screen exactly as it would appear on 
your printer.

Note:    Your Page Setup selections affect the screen display.    If, for example, you have landscape 
(sideways) orientation selected in Page Setup, your reports screen display is approximately 11 inches 
wide. If your Page Setup orientation is portrait, the display is approximately 8 inches wide.    Use the 
horizontal scroll bar to view the right side of the report.

To print a screen report, choose Print from the File menu.

Unlike the Printer option, you are not warned if the selected report does not fit in the screen display.    
Note the list of fonts in which you may print a report.    There are two types of fonts - System fonts and 
'device fonts' which are particular to your printer (or your third-party font software), and are provided by 
your printer driver (or font) software.    If you choose a System font for your report, it will appear as similar 
as possible on the screen and the printer.    If, however, you use a printer-specific font, M.Y.O.B. 
Accounting takes the characteristics of the chosen printer font and makes the best match possible to an 
available screen font in order to display the report on the screen.    You may not get a WYSIWYG result.

Note:    M.Y.O.B. Accounting has a single screen report window.    If you generate two screen reports, the 
second report will replace the first report.



Forms Customization - Overview

What is Customize Forms?
M.Y.O.B. Accounting's forms customization feature allows you to change the look and content of your 
printed checks, invoices, statements, purchase orders and mailing labels.    You can:

Change the size of any form
Change the number of forms on a single sheet of paper
Add text fields
Draw lines and boxes
Paste graphics anywhere on the form
Move fields
Change the size of fields
Select the font, size or style of any text or data field
Select the data fields you want to print on the form

See Also
Do You Need to Customize Your Forms Output?
Where to Find Customize Forms
How to Customize Forms
Customizing Checks
Customizing Invoices
Customizing Statements
Customizing Purchase Orders
Customizing Mailing Labels



Do You Need to Customize Your Forms Output?

If your forms (checks, invoices, statements, purchase orders, and mailing labels) are not the M.Y.O.B. 
Accounting compatible forms, use Customize Forms to make M.Y.O.B. Accounting's printed output match 
your form.

You can order checks, invoices (both service and item), purchase orders (both service and item), and 
mailing labels that are specially designed to work with M.Y.O.B. Accounting    An order form for M.Y.O.B. 
Accounting compatible forms is included in your M.Y.O.B. Accounting package.

If you use the M.Y.O.B. pre-printed forms, you are not required to customize your forms, but feel free to 
use it to personalize your forms output. 



Where to Find Customize Forms

When you select Print Checks, Print Invoices, Print Statements, Print Purchase Orders or Print Mailing 
Labels, you first see a selection dialog.    To customize the form, click the Customize button at the bottom 
of the selection dialog.

Note:    If there is more than one type of form (for example, service invoice vs. item invoice) the form type 
currently selected when you click customize is the form type you are customizing.



How to Customize Forms

This section describes, in general, how forms customization works.    It is followed by detailed instructions 
for customizing checks, invoices, statements, purchase orders, and mailing labels.

Selecting the Form to Customize.    When you select Print Checks, Print Invoices, Print Statements, 
Print Purchase Orders or Print Mailing Labels you first see a selection dialog.

In the selection dialog are two things that affect which form you are about to customize:
1. If there is more than one type of form (for example, service invoice vs. item invoice) the 

form type selected when you click Customize is the form type you are customizing.
2. There are radio buttons at the bottom of the print dialog.    They determine the format of 

the form you want to use as the basis for your customization.    When customizing 
invoices, for example, you have three choices: PrePrinted, M.Y.O.B. Accounting's Plain 
Paper and User Customized.    PrePrinted does not have lines or headers (they're on the 
form already).    Plain Paper includes lines and headers.    The first time you use M.Y.O.B. 
Accounting, User Customized is gray.    Choose the format (preprinted or plain paper) that
most closely matches yours and click Customize.    

Note:    Regardless of which format you choose as the basis for customization, once you customize a 
form, it is saved as the User Customized format, replacing any previously customized version of this form.
Therefore, you may have only one customized version of each form type.

Once you have chosen the desired form type and format, click the Customize button at the bottom of the 
selection dialog.

The Customize Window.    The selected form is displayed in the Customize window.

See The Customize Window



Customizing Checks

You may customize your checks.    Here's how:
1. Select Print Checks.
2. Choose the form (ContinuousFeed Check or Laser Check) that most closely matches 

your form.
3. Click Customize.

The check form has two parts: the check and the stub.    Depending upon the type of check, M.Y.O.B. 
Accounting prints three types of stubs: a regular stub, a payable stub and a refund check stub.    Regular 
stubs are used when printing checks entered in Write Checks.    Payable stubs are used when printing 
checks entered in Make a Payment.    And refund check stubs are used when printing checks entered in 
Settle Credits.

You may customize the check or any of the three stubs.    Choose which to customize from the Form 
menu.

Note:    When customizing a check stub, the check fields are displayed, but inaccessible.    You must 
choose Check Layout from the Form menu to customize the check fields.

Refer to the previous section How to Customize Forms for customization instructions.

Saving Your Customized Check.    When you click OK in the Customize window, the format you're 
working on is saved as the UserCustomized Check.    If you've saved a customized format previously, 
you're warned that this version will replace the previous version.

Note:    The ContinuousFeed Check format and the Laser format are not changed.    Regardless of which 
format you originally selected to customize, the customized format is always saved as the User-
Customized Check.



Sales & Receivables

Item Invoice
Write an item invoice when you want to sell something (a widget, a gadget or an hour of your time) from 
your items list.    Enter the detail of the item sale.    Enter also any payment made at the time of the sale.    
When recorded as an actual sale, the payment increases the balance of your linked checking account 
and the balance due is applied to your linked receivables account, creating an open receivable.

To write an item invoice, choose Invoice Sales.    Click the Item Invoice radio button.    

Service Invoice
A service invoice is a free-form invoice.    Write a service invoice when you want to use M.Y.O.B. 
Accounting's invoicing function to sell something not on your items list.    Enter the detail of the sale by 
typing the description, entering the sales account and amount.    Also enter any payment made at the time
of the sale.    When recorded as an actual sale, the payment increases the balance of your linked 
checking account and the balance due is applied to your linked receivables account, creating an open 
receivable.

To write a service invoice, choose Invoice Sales.    Click the Service Invoice radio button.    

Other Sales
Choose Other Sales to record a sale for which no invoice is needed.    Remember, if you prefer, M.Y.O.B. 
Accounting features service (non-inventory) invoices.

Enter the sales (and, if applicable, sales tax) accounts and amounts.    Enter also any payment made at 
the time of the sale.    The payment increases the balance of your linked checking account.    The balance 
due is applied to your linked receivables account, creating an open receivable.

Pending Invoice
Both Item and Service Invoices can be placed in the pending file.    Placing an invoice in the pending file 
does not record a sale.    It simply keeps the order on file for future delivery.    If an amount is entered in 
the Paid Today field, it is considered an advance deposit and increases (credits) your linked deposits 
account and puts the money in (debits) your linked checking account. 

To record additional deposits on a pending invoice, use Apply a Payment.

When the order is shipped, you must call up the pending invoice and convert it to an actual sale.    

Settle Credits
When something goes wrong with a recorded invoice (a return, adjustment, etc.), you must create a new 
adjusting invoice. If the new invoice has a negative balance due, it is called a "credit invoice."    Settle 
Credits lets you get these credit invoices off your books by applying the credit amount to another invoice, 
or by writing the customer a refund check.

Apply a Payment
When a customer pays their bill, use Apply a Payment to settle the open receivable.    If they send a 
deposit on a pending order, also use Apply a Payment.

Analyze Receivables
Analyze Receivables is a quick, powerful and interactive way to review who owes you money and how 
long they've owed it.

Analyze Sales
Analyze Sales is a quick, powerful and interactive way to review sales by item, customer or salesperson.

Print Invoices



M.Y.O.B. Accounting prints invoices on either    pre-printed forms or your own stationery.

Print Statements
M.Y.O.B. Accounting prints statements on either    pre-printed forms or your own stationery.



Invoice Sales

Customer
You must select a customer for this sale.    Customers are those card file entries you labeled "Customer".   
If you are pending sales on file for this customer, a dialog appears.    You may choose to process a 
pending invoice (see Pending Invoice) or create a new one. 

Ship To
This is the ship to address that is printed on the invoice.    The default is taken from the customer's card in 
the card file.    You may accept the default address or change it and press Tab.    There's a Card File icon 
next to the Ship To address.    Click it to choose an address from a card other than the selected 
customer's card.    Choose any card, regardless of card type.

Note:    If there is no ship to address on the customer's card, M.Y.O.B. Accounting uses the mailing 
address. 

Invoice Number
The Invoice Number identifies this transaction within the Sales & Receivables Journal.    M.Y.O.B. 
Accounting sorts Sales & Receivables Journal transactions by journal (invoice) number within date.    You 
may enter up to 8 characters, using any combination of numbers and letters.    M.Y.O.B. Accounting 
provides a default 8-digit invoice number.    M.Y.O.B. Accounting allows duplicate invoice numbers, 
however it is not recommended. 

Note: M.Y.O.B. Accounting will automatically increment a numeric invoice number.    M.Y.O.B. Accounting 
does not increment non-numeric invoice numbers.    If you must use a non-numeric format, M.Y.O.B. 
Accounting keeps incrementing and providing the next numeric invoice number as the default.    It is up to 
you to override it for every invoice. 

Date
All transactions within the Sales & Receivables Journal are sorted by transaction date.    You may not 
enter a date prior to the conversion date or in a prior fiscal year.    If you enter a future date, M.Y.O.B. 
Accounting accepts it, but only after warning you that the date is probably in error. 

Customer P.O. Number
This is optional.    If your customer sent you a purchase order and you wish to note it on the invoice, enter 
it here.    

Ship Via
Enter how you wish to ship these items.    The Ship Via field can be printed on the invoice.

Terms
The invoice displays the credit terms, if any, for this customer.    To change them, click the arrow next to 
the customer's name.    

Handwritten
If the invoice is not going to be printed by M.Y.O.B. Accounting, check Handwritten. M.Y.O.B. Accounting 
then considers the invoice as already printed.    When you print your invoices, select All Unprinted invoices
and the 'handwritten' invoice is not included.    

Item Invoice
Ship Quantity and Backorder Quantity
There are two quantity fields in M.Y.O.B. Accounting.    When you click Record, M.Y.O.B. Accounting 
records the sale for items with a Ship Quantity and creates a pending invoice for any quantities in the 
Backorder field.

Ship



Enter the shipping quantity of this item sold.    Enter up to three decimal places. Zero is a valid quantity.    
Use zero quantity for special items like freight (see Inventory). When you click Record, M.Y.O.B. 
Accounting records the sale for items with a Ship Quantity.

Backorder
Enter the shipping quantity of this item sold.    Enter up to three decimal places.    When you click Record, 
M.Y.O.B. Accounting creates a pending invoice for any quantities in the Backorder field.

Note:    The quantity is in selling units.    Say, for example, you said (when entering the item information) 
there are 6 inventory items per selling unit.    When you enter 1 as the quantity, 6 items are taken from 
inventory.

Note:    Use Tab to move to the Item Number field.    Pressing Return moves you to the next line.    When 
the Quantity field is empty, pressing Return jumps you to the Paid Today field.

Item Number
Enter the Item Number of the item youre selling and press Tab.    The item description is displayed and 
youre brought to the Price field.

Note:    Only items checked "I Sell this Item" in the Items List window can be sold (see Inventory.)

Note:    Item numbers beginning with a "\" (backslash) are not printed on the invoice.    Use backslash item
numbers to identify special items such as freight or handling charges or comments like, "Thank You for 
choosing Acme."    See Items List for a complete discussion of special items. 

Description
The Description defaults to the name given to the item in the Item Information window.    You may change 
it.    But remember, if you change it, the item information is not changed.    To change the item's name 
permanently, you must edit it via Items List in the Inventory Command Center.    To enter more than one 
line of description, use one of the following methods:

1. Just keep typing.    You can enter up to 255 characters for the description.    If the 
description does not fit on a single line on the printed invoice, M.Y.O.B. Accounting wraps 
the text onto the next line.

2. Create a special item for additional lines.    In your Items List, enter an item with a 
backslash as the first character of the item number.    Check "I sell this item".    Assign it to
any income account.    (Since you won't be assigning a price to this item, it won't affect 
your books.)    Make sure the price is $0.00, the Selling Unit of measure is blank, and you 
uncheck Track Sales History and Taxable When Sold.    Once this special item is 
recorded, you can use it anytime for a description.    Simply Tab past the Ship and 
Backorder fields, enter the item #, and type the description.    Press Return to move to the
next line.

Price
M.Y.O.B. Accounting defaults to the current price of the item (see Set Item Prices).    You may change it if 
you wish.    Enter a whole number followed by up to three decimal places.    M.Y.O.B. Accounting multiplies
the price by the quantity, subtracts the discount and then rounds the final amount to the nearest cent.

Discount
The discount is the percentage entered as the volume discount in the customer's card.    You may change 
it.    Discounts can range from -100% to 100%.    Enter 2.5% as "2.5", not ".025."

Note:    This is a discount for volume customers.    It is not the discount for early payment. 

Total
Total Amount is the Ship Quantity multiplied by the price, minus the discount.    Change it and M.Y.O.B. 
Accounting recalculates the discount. 



Service Invoice
Description
Enter whatever youd like.    For multi-line descriptions, press Return to move to the next line.    When 
youve completed the description, press Tab to enter an account.

Note:    To put a blank line between descriptions, type a space and press Return.

Account Number
Before you can enter an amount, you must select an account.    Since this is a Sales & Receivables 
Journal entry, it is usually an income account.    If you need to enter a new sales account, click the New 
Account button on the detail accounts dialog and M.Y.O.B. Accounting zooms to Chart of Accounts.    
Enter the account information and press Enter or click OK.    The window disappears and youre back at 
the Account Number field.    Type the new account number and press Tab.    The new account is selected, 
its name appears and you jump to the Amount field. 

Amount
Enter a dollar amount.    M.Y.O.B. Accounting allows you to type the dollar amount using numbers, 
commas, periods and dollar signs.    Improperly formed amounts are disallowed and decimal amounts are 
rounded to the nearest cent.    Since M.Y.O.B. Accounting balances positive amounts with a debit to your 
linked receivables account, any positive number entered is treated as a credit.    This is almost always 
correct, since whenever you add to an income account it is a credit.    If youre entering a return or sales 
adjustment, use a negative amount.    Negative amounts reduce (debit) the selected account.    If there is a
negative balance due, the linked receivables account is credited.

Note:    A negative balance due creates a credit sale.    Use Settle Credits to process a refund or apply the
money to another receivable.

Note:    An account without a dollar amount is kept on the invoice, but is not recorded as part of the 
journal entry.

Job
You can assign the amount to a job .    Type the job number and press Tab.    If you are unsure of the job 
number, press Ctrl-L to see the job list.    Select a job from the job list or click New Job to create a new 
one.    If you inventory this item, the sales revenue and the cost of sales are assigned to    the job.    If you 
do not inventory this item just the sales revenue is assigned to the    job. 

Note:    If you need to assign a single item to more than one job, enter the item    more than one time.    
Say, for example, youre invoicing 50 widgets and 30 are    for job 12 and 20 are for job 43.    Enter two 
lines for widget sales, one for 30    units and the other for 20 units. 

Tax
A checkmark in the Tax column means that the item is subject to sales tax.    The Tax column defaults to a 
checkmark if you checked "Taxable When Sold" in the    item information window.    Click the column to 
enter a checkmark.    Click a checkmark to remove it. 

Memo
Upon entering the complete sale, use the down arrow to jump to the Memo field.    This is a memo for the 
Sales & Receivables Journal transaction.    When printing    invoices, you may decide whether or not to 
print memos. 

Salesperson
M.Y.O.B. Accounting tracks sales by salesperson.    This is optional.    If you do not wish to    assign this 
sale to an employee leave the field blank.    Since this is an optional field, pressing Tab or Return does not
display your list    of employees.    To select a card, you must type a few letters of their last name, press 
Ctrl-L, or click the card file icon.



Note:    Before M.Y.O.B. Accounting can track sales by a salesperson, you must check the    "Track Sales"
History checkbox on the employee's card. 

Promised Date
If you are placing this invoice in the pending file, enter the date the order should    be delivered.    If you do,
a reminder is placed on your To Do List. 

Note:    Although you may enter a Promised Date for an actual sale, it is relevant    only if you place the 
invoice in the pending file. 

Comment
Enter a comment to be printed on the invoice.

Sales Tax Percent
Sales tax is calculated on all taxable items based upon the percentage entered. 

Note:    M.Y.O.B. Accounting defaults to the last sales tax percentage entered.    If the customer is tax-
exempt (See Also Card File Entry), the sales tax is    not calculated, and $0.00 appears in the Sales Tax 
field, regardless of the checkmarks in the Tax column. 

Journal Memo
This is a memo for the Sales & Receivables Journal transaction.    When printing invoices, you may 
decide whether or not to print journal memos.

Freight
Enter the shipping charges for this invoice.    You must have a linked freight account before you can use 
this field.

Paid Today
If this is a full or partial cash sale, enter the amount paid here.    This amount is recorded in the Cash 
Receipts Journal. 

Balance Due
This is the total of all lines, plus sales tax, minus the payment made.    This    amount is added to the 
customer's receivables balance when the invoice is    recorded as an actual sale.    If the amount is 
positive an open invoice is created.    If    it is zero, a closed invoice is created.    If it is negative, a credit 
invoice is created. 

Record
M.Y.O.B. Accounting records the quantity shipped.    If there are any backordered quantities, M.Y.O.B. 
Accounting creates a new pending invoice for the backorder amount.    (For further discussion see 
Backorder Quantity vs. Pending Button.)

If the shipped quantity is greater than your on-hand inventory you'll have the option to auto-build, auto-
buy or auto-backorder the item(s).



Backorder Quantity vs. Pending Button
Clicking Record on an invoice with a backorder quantity creates a pending invoice and clicking Pending 
File also creates a pending invoice.    So what's the difference?

Let's say you write an invoice with both Shipped and Backordered quantities.    If you click Pending File, 
M.Y.O.B. Accounting puts the entire invoice away in the pending file.    If you click Record, M.Y.O.B. 
Accounting records the shipped amount and creates a pending invoice for only the backordered amount.

See Also
Invoice Sales



Other Sales

Customer
You must select a customer for this sale.    Customers are those card file entries you labeled "Customer".   
See Also Navigating in M.Y.O.B...

Note:    If this is a cash sale and you do not track the sales activity for this    customer, create a new 
customer card called something like "Cash", or "MasterCard".    If this is a credit sale, youre better off 
adding this customer to your card file, so you can track the receivable balance. 

Sales Number
The sales number identifies this transaction within the Sales & Receivables Journal.    M.Y.O.B. 
Accounting sorts Sales & Receivables Journal transactions by number within date.    You may enter up to 
8 characters, using any combination of    numbers and letters.    M.Y.O.B. Accounting provides a default 
sales number with the prefix SJ    (for Sales & Receivables Journal) followed by a 6-digit number.    
M.Y.O.B. Accounting allows duplicate journal entry numbers, however it is not recommended. 

Date
All transactions within the Sales & Receivables Journal are sorted by    transaction date.    You may not 
enter a date prior to the conversion date or in a    prior fiscal year.    If you enter a future date, M.Y.O.B. 
Accounting accepts it, but only after    warning you that the date is probably in error.    See Also Navigating 
in M.Y.O.B..

Memo
Enter whatever youd like.    Memos can be up to 255 characters, but because of report display limitations, 
it is most useful to limit your memos to 40 or 50 characters. 

Account Number
You must select an account.    Since this is a Sales & Receivables Journal entry, it is usually an income 
account.    Any sales tax should be allocated to your sales tax    payable (liability-type) account.    To select 
an account, See Also Navigating in M.Y.O.B..    If you need to enter a new sales account, click the New 
Account button on the    detail accounts dialog and M.Y.O.B. zooms to Chart of Accounts.    Enter the 
account    information and press Enter or click OK.    The window disappears and youre back at the 
Account Number field.    Type the new account number and press Tab.    The new account is selected, its 
name appears and you jump to the Amount field. 

Amount
Enter a dollar amount.    M.Y.O.B. Accounting allows you to type the dollar amount using    numbers, 
commas, periods and dollar signs.    Improperly formed amounts are    disallowed and decimal amounts 
are rounded to the nearest cent.    Since M.Y.O.B. Accounting balances positive amounts with a debit to 
your linked receivables    account, any positive number entered is treated as a credit.    If youre entering a  
return or sales adjustment, use a negative amount.    Negative amounts reduce    (debit) the selected 
account.    If there is a negative balance due, the linked    receivables account is credited.    

Note:    A negative balance due creates a credit sale.    Use Settle Credits to process a refund or apply the
money to another receivable. 

Note:    An account without a dollar amount is not recorded as part of the journal    entry. 

Job
If the selected account is an income, expense, cost of sales, other income or    other expense account, 
you can assign the amount to a job (see Jobs List).    Type the job number and press Tab.    If you are 
unsure of the job number, press Ctrl-L to see the job list.    Select a job from the job list or click New Job to
create a new one. 

Note:    If you need to assign an amount from a single account to more than one job, enter the account 



more than one time.    Say, for example, you have $100 credit to widget sales and you need to assign $30 
to job 12 and $70 to job 43.    Enter two credits to widget sales, one for $30 and the other for $70. 

Note:    Upon entering the complete sale, use the down arrow to jump to the Paid    Today field. 

Paid Today
When you have    entered the details of the sale, use the down arrow to jump to the Paid Today field.    If 
this is a full or partial cash sale, enter the amount paid here.    This amount is deposited in your linked 
checking account and recorded in the Cash Receipts Journal.

Salesperson
M.Y.O.B. Accounting can assign this invoice to a salesperson.    This is optional.    If you do not    wish to 
assign this sale to an employee leave the field blank.    Since this is an optional field, pressing Tab or 
Return does not display your card    file list of employees.    To select a salesperson, you must type a few 
letters of their last name, press Ctrl-L, or click the card file icon.

Note:    If assigned, the salesperson's name appears on the invoice.    If you also    wish to compile the 
sales history of a salesperson, you must check the Track Sales History checkbox on the employee's card.

Balance Due
A positive balance due increases (debits) your linked receivables account.    A positive balance due also 
creates an open receivable.    When the customer pays all or part of this balance, use Apply a Payment to 
settle this receivable.    A return or adjustment usually creates a negative balance due.    A negative 
balance due decreases (credits) your linked receivables account.    The sale becomes a credit sale.    Use 
Settle Credits to process a refund or apply the money to an open receivable. 

Record
Positive amounts in the detail of the sale are recorded as credits to the named accounts.    Negative 
amounts are debits.    If there's a positive balance due, it's added to the receivable balance for this 
customer and a new open receivable is created.    When the customer pays their bill, use Apply a 
Payment to settle this receivable.

Note:    A negative balance due reduces (credits) the customer's receivable balance and creates a credit 
invoice.    Use Settle Credits to process a refund or apply the money to another receivable. If you entered 
an amount in Paid Today it is deposited in your linked checking account.



Pending Invoices

Recording a Pending Invoice as an Actual Sale
Select Invoice Sales and enter a customer.    A list of all pending invoices on file for this customer will 
appear.    Select the desired pending invoice.    Change anything youd like about the pending invoice, 
except the deposit amount.    To enter an additional deposit on a pending sale, use Apply a Payment.    
When youre ready, click Record as an Actual Sale.    The pending invoice is converted to an actual sale 
and recorded. 

Note:    If the date of the invoice is earlier than the current system date you will receive a warning. 

Note:    If you change any item information (linked accounts, quantities, etc.), when you recall the pending
item invoice, the new item information is used. 

Note:    When you record a pending invoice with a deposit as an actual sale, M.Y.O.B. Accounting moves 
the money from your deposits accounts to your linked receivables account.    Your linked deposits account
is reduced (debited) by the amount of the deposit and the linked receivables account is credited.



Settle Credits

Apply to Open Invoice
All invoices for this customer are displayed.    Open invoices are displayed first, followed by pending 
invoices and then by closed invoices. 

ID Number
The ID Number identifies this transaction within the Sales & Receivables Journal.    M.Y.O.B. Accounting 
sorts Sales & Receivables Journal transactions by journal ID number within date.    You may enter up to 8 
characters, using any combination of numbers and letters.    M.Y.O.B. Accounting provides a default ID 
number with the prefix SJ (for Sales & Receivables Journal) followed by a 6-digit number.    M.Y.O.B. 
Accounting allows duplicate ID numbers, however it is not recommended.

Date
All transactions within the Sales & Receivables Journal are sorted by transaction date.    You may not 
enter a date prior to the conversion date or in a prior fiscal year.    If you enter a future date, M.Y.O.B. 
Accounting accepts it, but only after warning you that the date is probably in error.

Credit Amount
M.Y.O.B. Accounting displays the amount of the credit.    You may change it to a lesser amount. You may 
not increase it.    M.Y.O.B. Accounting allows you to type the dollar amount using numbers, commas, 
periods and dollar signs.    Improperly formed amounts are disallowed and decimal amounts are rounded 
to the nearest cent.

Memo
Enter whatever youd like.    Memos can be up to 255 characters, but because of report display limitations, 
it is most useful to limit your memos to 40 or 50 characters.

Invoice Number
This is the number of the previous sale to this customer.

Status
Invoices that have a positive balance are "open".    Invoices with a zero balance are "closed".    Invoices 
placed in the pending file are "pending".

Amount
This is the current amount due, net of previous payments or applied credits, on the invoice.

Discount
If the customer is entitled to an early payment discount (see "Tax & Credit Terms" in Card File Entry), a 
discount amount appears here. You may override the discount.    Note:    Discounts are recorded only 
when settling the entire balance due of an invoice.    Consider a $100 balance with a $2 discount.    The 
Total Due is $98.    Apply, say, $75 to this invoice.    When you record it, the $2 discount is ignored.    The 
next time you see this invoice, it will have a $25 (not $23) balance.

Amount Applied
M.Y.O.B. Accounting defaults to the Amount Due or the unapplied remainder of the Credit Amount, 
whichever is less.    You may apply the credit amount to more than one invoice.    Note:    Applying a credit 
to an open or closed invoice does not change the customer's receivable balance.    It simply re-assigns 
the money from a credit invoice to a regular invoice.    Applying a credit to a pending invoice does change 
the customer's balance, because the money is moved from receivables to your linked deposits liability 
account.    See Examples of Applied Credits.

Record
The transaction is recorded in the sales journal as an equal debit and credit.    Since neither the 
customer's balance nor your receivable balance has changed these entries are made for audit trail 



purposes.

Write a Refund Check
Verify the Check Number, Date, Amount, Payee and Memo of the check.    See Write Checks for more 
information about these fields.    You may reduce the amount of the refund, but you may not increase it 
above the credit amount.

Record
The transaction is recorded in the Cash Disbursements journal.    Your checking account is decreased 
(credited) by the amount of the check.    The receivable balance for this customer is increased (debited).



Examples of Applied Credits

In addition to a few closed (fully paid)    invoices, the customer has an open invoice for $125, and a $25 
credit from a previous return.    This yields a net receivable balance of $100.

Scenario A-Applying the credit to an open invoice.
You apply the $25 credit to the $125 open invoice.    The credit is settled and the open invoice has a new 
balance of $100.    There is no change in the customer's receivable balance.

Scenario B-Applying the credit to a closed invoice.
You apply the $25 credit to a closed (fully paid) invoice.    The old credit is settled and the closed invoice 
becomes a new $25 credit invoice.    There is no change in the customer's receivable balance.    This is a 
possible, but very improbable situation.

Scenario C-Applying the credit to a pending invoice.
The customer wants you to treat the $25 as a deposit and apply it against a pending invoice.    The credit 
is settled and the customer has a new receivable balance of $125 and a deposit on account for $25.      

Note:    You may not apply a payment to a pending invoice unless you have a linked deposits account.    
See Set Up Receivables in Chapter 3 of the Getting Started booklet.



Apply a Payment

Customer
You must identify the customer who made this payment.    Customers are those card file entries you 
labeled "Customer".    See Also Navigating in M.Y.O.B.

ID Number
The ID Number identifies this transaction within the Cash Receipts Journal.    M.Y.O.B. Accounting sorts 
Cash Receipts Journal transactions by journal ID number within date.    You may enter up to 8 characters, 
using any combination of numbers and letters.    M.Y.O.B. Accounting provides a default ID number with 
the prefix CR (for Cash Receipts) followed by a 6-digit number.    M.Y.O.B. Accounting allows duplicate ID 
numbers, however it is not recommended. 

Date
All transactions within the Cash Receipts Journal are sorted by transaction date.    You may not enter a 
date prior to the conversion date or in a prior fiscal year.    If you enter a future date, M.Y.O.B. Accounting 
accepts it, but only after warning you that the date is probably in error. 

Amount Received
Enter the amount of the payment.    M.Y.O.B. Accounting allows you to type the dollar amount using 
numbers, commas, periods and dollar signs.    Improperly formed amounts are disallowed and decimal 
amounts are rounded to the nearest cent. 

Memo
Enter whatever youd like.    Memos can be up to 255 characters, but because of report display limitations, 
it is most useful to limit your memos to 40 or 50 characters. 

Invoice Number
This is the number of the previous sale to this customer. 

Status
Invoices that have a positive balance are "open".    Invoices with a zero balance are "closed".    Invoices 
placed in the pending file are "pending".    

Amount
This is the current amount due on the invoice, net of previous payments, deposits or applied credits. 

Discount
If the customer is entitled to an early payment discount (see "Tax & Credit Terms" in Card File Entry), a 
discount amount appears here.    You may override the discount. 

Note:    Discounts are recorded only when settling the entire balance due of an    invoice.    Consider a 
$100 balance with a $2 discount.    The Total Due is $98.    Apply, say, $75 to this invoice.    When you 
record it, the $2 discount is ignored.    The next time you see this invoice, it will have a $25 (not $23) 
balance.      

Amount Applied
You may apply the payment to more than one invoice.    Invoices that have a positive balance are "open".  
Apply the payment to reduce the open balance.    If you apply more than the balance due, the open 
invoice becomes a    credit invoice.    When you apply a payment to an open invoice, the customer's    
receivable balance is reduced (credited) by the amount of the payment.    Invoices with a zero balance are
"closed".    Apply a payment to a closed invoice, and it becomes a credit invoice.    When you apply a 
payment to a closed invoice,    the customer's receivable balance is reduced (credited) by the amount of 
the    payment.    Invoices placed in the pending file are "pending".    Apply a payment to a pending invoice 
and it is treated as a deposit.    The customer's receivable balance remains unchanged and the deposits 
liability account is increased (credited). 



Note:    You may not apply a payment to a pending invoice unless you have a linked deposits account.    
See Set Up Receivables in Chapter 3 of the Getting Started booklet. 

Finance Charge
If the customer's check includes a finance charge payment, use the Finance Charge field to enter it.    The
balance of your charge account (see Set Up Receivables in Chapter 3 of the Getting Started booklet), will 
be increased (credited) by the amount of the charge. 

Record
The transaction is recorded in the Cash Receipts Journal.    Your checking account is increased (debited) 
by the amount of the check.    If applied to an open or closed invoice, the receivable balance for this 
customer is reduced (credited).    If applied to a pending invoice, the linked deposits account is increased 
(credited).



Analyze Receivables

Calculate Number of Days Since Invoice Date
Choose this to age your receivables based upon the invoice date.

Calculate Days Overdue Using Customer Terms
Choose this to age your receivables based upon when the invoice should be paid given the customer's 
credit terms. 

Age Receivables as of...
Enter a date, usually the current date.    M.Y.O.B. Accounting determines the age of your    receivables by 
calculating the number of days between the invoice date and this date. 

Display $0.00 Balance Invoices
This includes all closed invoices in the aging analysis.    Leave it unchecked unless you are looking for a 
particular invoice and are unsure whether or not it has been paid. 

Summary Analysis
All your receivables are displayed, totaled by customer.    The outstanding receivable balance for each 
customer is displayed in the Total column.    The total is broken down by age and displayed in the 
appropriate aging column.    Click the arrow to the left of a customer to see the customer receivable detail.

Customer Detail
Click the radio button for Customer Detail and select a customer.    All receivables for this customer are 
displayed in date order.    The balance due    for each invoice is displayed in the total column and again in 
the appropriate aging column.    Click the arrow to the left of the invoice number to see the invoice detail. 

Invoice Detail
Click the radio button for Invoice Detail and select an invoice.    This is the transaction trail for a single 
invoice.    Click the arrow to the left of the transaction to see it in its originating    window.



Analyze Sales

Selection Dialog
Choose to analyze sales by item, customer or salesperson.    Choose also to look at this year, last year or 
a comparison of this year to last year.    Click and drag to select the month(s) for analysis.    In the analysis
window you    may toggle between the selected period and year-to-date. 

Sales Analysis by Item
Note:    Sales analysis can be done only for items with "Track Sales History" checked.    See Items List.    
All items for which you track sales history are displayed.    Click an icon at the    bottom of the window to 
change the display.

The following icons are displayed for a sales analysis by item for "This Year Only" or "Last Year Only".    
Click on the icon in question for a description of the calculation that will be enacted:

The following icons are displayed for a sales analysis by item for "This Year vs. Last Year".    Click on the 
icon in question for a description of the calculation that will be enacted:

Sales Analysis by Customer
Note:    Sales analysis can be done only for customers with "Track Sales History" checked.    See Also 
Card File Entry.    All customers for whom you track sales history are displayed.    If you are analyzing this 
year or last year only, there is a single display.    It shows the dollar sales for each customer followed by 
the percent of total sales.    If you are comparing this year vs. last year you have two display choices.    
Click an icon at the bottom of the window to change the display.

The following icons are displayed for a sales analysis by customer for "This Year vs. Last Year".    Click on
the icon in question for a description of the calculation that will be enacted:

Sales Analysis by Salesperson
Note:    Sales analysis can be done only for employees with "Track Sales History" checked.    See Card 
File Entry.    All salespeople for whom you track sales history are displayed.    If you are analyzing this year
or last year only, there is a single display.    It shows the dollar sales for each salesperson followed by the 
percent of total sales.    If you are    comparing this year vs. last year you have two display choices.    Click 
an icon at the bottom of the window to change the display.

The following icons are displayed for a sales analysis by Salesperson for "This Year vs. Last Year".    Click
on the icon in question for a description of the calculation that will be enacted:



Sales - Cost of Sales



((Sales - Cost of Sales) / Sales) * 100



Cost of Sales / Units Sold



Item sales as a percentage of total sales



Item profit as a percentage of total profit



This Year Sales - Last Year Sales



((This Year Sales - Last Year Sales) / Last Year Sales) * 100



This Year Units - Last Year Units



((This Year Units - Last Year Units) / Last Year Units) * 100



This Year Profits - Last Year Profits



((This Year Profits - Last Year Profits) / Last Year Profits) * 100



This Year Margin Percentage - Last Year Margin Percentage



This Year Sales - Last Year Sales



((This Year Sales - Last Year Sales) / Last Year Sales) * 100



Verify Printing

This window is used to review a list of customers, vendors, invoices or orders prior to printing. 

Review Invoices
A list of invoices matching your selection criteria is displayed.      They are all checked.    If you do not wish 
to print one, click the checkmark    to de-select it.    If you wish to see the invoice, click the arrow.    After 
youve reviewed the list, click Print.    For instructions on selecting invoices for printing, see Printing 
Invoices. 

Review Statements
A list of customers matching your selection criteria is displayed.    They are all checked.    If you do not 
wish to send a statement to one, click    the checkmark to de-select it.    After youve reviewed the list, click 
Print.    For instructions on selecting statements for printing, see Printing Invoices. 

Review Purchase Orders
A list of Purchase Orders matching your selection criteria is displayed.    They are all checked.    If you do 
not wish to print one, click the checkmark    to de-select it.    If you wish to see the purchase order, click the
arrow.    After youve reviewed the list, click Print.    For instructions on selecting purchase orders, see 
Printing Purchase Orders. 

Review Mailing Labels
M.Y.O.B. Accounting displays the cards that match your selection criteria in the Review Cards window.    
(See Card File).    You have an opportunity to delete specific cards from the mailing label list by clicking 
their checkmark.    The checked cards will have labels printed for them. 

Review Personalized Letters
M.Y.O.B. Accounting displays the cards that match your selection criteria in the Review Cards Before 
Exporting window.    (See Card File).    You have an opportunity to delete specific cards from the merge file
by clicking their checkmark.    When you click Export you get the standard file dialog and the checked 
cards will be exported.



Printing Invoices

Select Print Invoices to print service invoices, item invoices or packing slips.

You may order compatible invoices and envelopes an order form is included with your M.Y.O.B. 
Accounting package) or customize the invoice printing to fit your existing forms.

Invoice Type
Choose the type of invoice - item, service, packing slip, or shipping label - you want to print.

Invoice Status
You may print all invoices or limit your selection to open invoices (most common), closed invoices, credit 
invoices, or pending invoices.

Unprinted Invoices Only
Check this selection to print only those invoices (matching all your other selection criteria) not previously 
printed.

Invoices Dated...
Check this selection and enter a date range.    M.Y.O.B. Accounting prints only those invoices between 
(and including) the From and To Dates.

Invoice Numbers...
Check this selection and enter an invoice number range.    M.Y.O.B. Accounting prints only those invoices 
between (and including) the beginning and ending invoice numbers.

Print Packing Slips Immediately After Invoices
This selection appears in Review Invoices Before Printing window.    Check this selection and (right after 
printing invoices) M.Y.O.B. Accounting prompts you for printing the corresponding packing slips.

Print Shipping Labels Immediately After Invoices
This selection appears in Review Invoices Before Printing window.    Check this selection and (right after 
printing invoices) M.Y.O.B. Accounting prompts you for printing the corresponding shipping labels.

Customizing Packing Slips
To customize your packing slip, choose Packing Slip as the Invoice Type.    Then Choose the invoice 
format ( Pre-Printed or M.Y.O.B. Accountings Plain Paper) that most closely matches your form, and click 
Customize.

Customizing Shipping Labels
To customize your shipping label, choose Shipping Label as the Invoice Type.    Then Choose the label 
size that most closely matches your labels, and click Customize.

Backorder Invoices
M.Y.O.B. Accounting first prints the shipped goods, then skips a line and lists the backordered goods.    
Shipped goods have a completed amount field, backordered goods leave the amount field blank.

Note:    To print a separate backorder invoice, just choose to print the pending invoice.

Note:    If you do not want the backorder information printed on the actual invoice, do not use the 
Backorder field on the invoice.    .

Form Currently Used for...
Ordering information for invoices designed exclusively for M.Y.O.B. Accounting users is included with your
M.Y.O.B. Accounting package.



There are three formats for each type (service, item or packing slip) of invoice:    pre-printed, plain paper 
and user-customized.    Pre-printed invoices already have the lines and headers on the form, so M.Y.O.B. 
Accounting does not print them.    Plain-paper invoices do not have lines and column headers, so 
M.Y.O.B. Accounting draws them when printing the invoice.    

The third format (user-customized) is of your own design.    This selection is gray until you customize an 
invoice format.    To customize an invoice, choose the invoice format ( Pre-Printed Invoice or M.Y.O.B. 
Accounting's Plain Paper Invoice) that most closely matches your form.

Click Customize.    See Customizing Invoices.

Print Alignment Invoice

Click this button to print a sample invoice.    Once it is printed, check the alignment, adjust your printer and
reset the top of form.    (For continuous feed printers, set the top of form by turning it off and then on.)

See Also
Customizing Invoices



Customizing Invoices

There are three types of invoices in M.Y.O.B. Accounting:    item invoices, service invoices and packing 
slips.    You may make a customized version of each type.    Here's how:

1. Select Print Invoices
2. Choose the appropriate Invoice Type (Service, Item or Packing Slip)
3. Choose the invoice format ( Pre-Printed Invoice or M.Y.O.B. Accounting's Plain Paper 

Invoice) that most closely matches your form.    The pre-printed invoice format does not 
have lines or column headers (they are already printed on the form), the plain paper 
invoice includes lines and headers.

4. Click Customize.

See Also Customizing Reports

Saving Your Customized Invoice.    When you click OK in the Customize window, the format you're 
working on is saved as the User-Customized (Service or Item) Invoice.    If you've saved a customized 
format previously, you're warned that this version will replace the previous version.

Note:    The    Pre-Printed format and the Plain Paper format are not changed.    Regardless of which 
format you originally selected to customize, the customized format is always saved as the 
UserCustomized Invoice.

Review Invoices Before Printing
When you click OK, a list of invoices matching your selection criteria is displayed.    They are all checked.  
If you do not wish to print one, click the checkmark to de-select it.

If you wish to see an invoice on the list, click the arrow.

After you've reviewed the list, click Print.

See Also
Printing Invoices



Printing Statements

Statement Type
There are two types of statement formats, Invoice or Activity.    An invoice statement lists all open invoices 
with their current balance due.    An activity statement lists all sales journal transactions (sales, payments, 
returns, etc.) involving this customer since a selected date.    

Activity Since...
If you choose to print an activity statement, M.Y.O.B. Accounting prints a line for each purchase, payment,
discount or charge recorded after the date that you specify.

All or Selected Customers
Use the radio buttons to choose between printing statements for all customers or printing a statement for 
a single customer.

Identifiers
Check this to limit your customers by identifier.    You may enter up to 26 identifiers.    Only those 
customers with every identifier are included.    If, for example, you enter "AB" as your identifiers, only 
those customers assigned both A and B are included.

Note:    If you send statements to the same subset of customers every month, assign them a unique 
identifier and use this identifier option to select them.

Include Customers With Zero Balances
Check this selection and statements are printed for all selected customers, regardless of activity for the 
period.    

Leave it unchecked, and statements are printed for only those selected customers with activity for the 
period.

You can enter any prior date, but it is most useful to print the activity since the last time you sent this 
customer a statement.

Add Finance Charges to Amount Due
At the bottom of the statement M.Y.O.B. Accounting prints the current amount due.    Check this selection 
if you want the finance charges added to the total amount due.

Finance charges are not recorded.    They are merely printed on the statement.    If the customer pays a 
finance charge, there is a field for it in the Apply a Payment window.

Note:    Even if you add the finance charges to the amount due, they are not recorded.    They are merely 
included in the statement balance.    If the customer pays a finance charge, there is a field for it in the 
Apply a Payment window.

How Finance Charges are Calculated
M.Y.O.B. Accounting looks at all open invoices and calculates their due dates (using the credit terms 
entered in the customer's card).    It then multiplies the overdue balance by 1/30th of the monthly finance 
charge interest rate (also entered in the customer's card) for each day it is overdue.

If, during the overdue period, the customer made a partial payment, M.Y.O.B. Accounting adjust the 
finance charge accordingly-its calculation is based upon the daily overdue balance for every open invoice.

Note:    M.Y.O.B. Accounting does not know if the customer previously paid a finance charge without 
paying the balance due on an invoice.    Therefore, when it calculates the finance charge on the (still 
open) invoice, it does not subtract any finance charges already paid.



Likewise, if you send your customers an invoice for the finance charge, M.Y.O.B. Accounting does not 
connect the two events and cannot adjust it's finance charge calculations. 

Alignment Statement(s)
Click this button to print a sample statement.    Once it is printed, check the alignment, adjust your printer 
and reset the top of form.    (For continuous feed printers, set the top of form by turning it off and then on.)

See Also
Customizing Statements



Customizing Statements

There are two types of statements in M.Y.O.B. Accounting:    invoice statements and activity statements.    
You may make a customized version of each type.    Here's how:

1. Select Print Statements
2. Choose the appropriate Statement Type (Invoice or Activity)
3. Choose the statement format ( Pre-Printed Statement or M.Y.O.B. Accounting's Plain 

Paper Statement) that most closely matches your form.    The pre-printed statement 
format does not have lines or column headers (they are already printed on the form), the 
plain paper statement includes lines and headers.

4. Click Customize.

See How to Customize Forms for customization instructions.

Saving Your Customized Statement.    When you click OK in the Customize window, the format you're 
working on is saved as the User-Customized (Invoice or Activity) Statement.    If you've saved a 
customized format previously, you're warned that this version will replace the previous version.

Note:    The    Pre-Printed format and the Plain Paper format are not changed.    Regardless of which 
format you originally selected to customize, the customized format is always saved as the User-
Customized Statement.

Review Statements Before Printing
When you click OK, a list of customers matching your selection criteria is displayed.    They are all 
checked.    If you do not wish to send a statement to a selected customer, click the checkmark to de-select
it.

After you've reviewed the list, click Print.

See Also
Printing Statements



Finding, Changing and Reversing Sales

Erasing a Sales & Receivables Journal Entry Before It's Recorded
Finding a Sales & Receivables Journal Entry
Changing or Deleting a Sales & Receivables Journal Entry
Reversing a Sales & Receivables Journal Entry



Erasing a Sales & Receivables Journal Entry Before It's Recorded
If, while entering a sale, you need to start over, choose Erase Sale from the Edit menu.

See Also
Finding, Changing, and Reversing Sales



Finding a Sales & Receivables Journal Entry

Select Analyze Receivables from the Sales & Receivables command center.    If the sale you're looking for
has been paid, be sure to check Include $0.00 Balance Sales.

A summary list of your customers is displayed.    Click the arrow to the left of the desired customer.    All 
sales to that customer are displayed.    Click the arrow next to the desired sale.    All transactions relating 
to that sale are displayed.    Click the arrow next to the invoice number and the original sale is displayed.    
(If you're in the middle of entering a new sale in the Other Sales window, you're asked to record or erase 
it before displaying a previous sale.)

See Also
Finding, Changing, and Reversing Sales



Changing or Deleting a Sales & Receivables Journal Entry

Note:    The following discussion applies to those users who have chosen to make their data file 
Unchangeable.    If your data file is Changeable, you may change or delete entries at any time.    See 
Customize M.Y.O.B. in for a discussion of Changeable versus Unchangeable.

Prior to saving, a sales entry may be changed or deleted (choose Delete from the edit menu).    If you 
have applied payments against the sale, you must delete the payments prior to deleting the sale.

Once you save your data, you may view it and automatically reverse it, but you may not change or delete 
it. 

See Also
Finding, Changing, and Reversing Sales
Reversing a Sales & Receivables Journal Entry



Reversing a Sales & Receivables Journal Entry

Note:    The following discussion applies to those users who have chosen to make their data file 
Unchangeable.    If your data file is Changeable, you may change or delete entries at any time.    See 
Customize M.Y.O.B. for a discussion of Changeable versus Unchangeable.

Follow the directions in Finding a Sales & Receivables Journal Entry.

Reversing an Unpaid Sale.    To reverse a displayed sale, choose Reverse Sale from the Edit menu, 
review the sales number and date, and click OK.    A new credit sale is created.    Use Settle Credits to 
apply this credit to the original sale.

Note:    If there have been any payments on this sale, when the sale is reversed, the payments are not 
reversed.    For examples, see the following sections, "Reversing a Completely Paid Sale," or "Reversing 
a Partially Paid Sale."

Note:    You may not change the accounts and amounts in a reversing sale.    

Note:    Be aware of the recording date of a reversing sale.    If you use the current date when you reverse 
a sale from a prior month, the month-end financials for the prior month will not reflect the reversing sale.    
If you use the original date for the reversing sale, your prior month financials should be reprinted.

Reversing a Completely Paid Sale.    Reversing a paid in full sale (also called a "closed invoice") creates
a new credit sale, but does not reverse the payments.    Use Settle Credits to write a refund check or 
apply the payment to an open receivable.

Example:    You enter a sale for $25 that is paid in full.    The sale is returned the next day.
1. Locate the sale in Analyze Receivables and click the gray arrow to display it.
2. Select Reverse Sale from the Edit menu.
3. Verify the date and journal number and click OK.    Now you have yesterday's $25 sale 

with a $25 payment, and today's credit sale for ($25).
4. Select Settle Credits.    A list of the credit sales is displayed.    Choose the $25 credit sale 

just entered.
5. You may:
6. Write a Refund Check.    Verify the payee, check number, memo and date.    Click 

Record.
7. Apply to an Open Invoice.    Enter the $25 next to the
8. desired open invoice and press Tab.    Click Record.

Reversing a Partially Paid Sale.    If there were any payments made on this sale, reversing the sale 
creates a new credit sale, but does not reverse the payments.    You must do two things:

1. Use Settle Credits to wipe out the outstanding receivable of the original sale.
2. Use Settle Credits to handle the partial payment by either writing a refund check or 

applying it to another open receivable.

Example:    You enter a sale for $100 with $25 paid today.    The sale is returned the next day.
1. Locate the sale in Analyze Receivables and click the gray arrow to display it.
2. Select Reverse Sale from the Edit menu.
3. Verify the date and sales number and click OK.    Now you have yesterday's $100 sale 

with a $25 payment (leaving a $75 open receivable) and today's credit sale of ($100).
4. Select Settle Credits.    A list of the credit sales is displayed.    Choose the $100 credit sale

just entered and click Apply to Open Invoice.
5. At this point you have three options:
6. Apply $75 of this credit to the open $75 receivable.    Apply the remaining $25 to another 

open receivable.    Click Record.



7. Change the credit amount from $100 to $75.    Enter $75 next    to the open invoice and 
press Tab.    Click Record. (Remember, the customer still has a $25 credit.)

8. Apply $75 of this credit to the open $75 receivable.    Reselect Settle Credits.    Select the 
remaining $25 credit and click Write a Refund Check.    Verify the payee, check number, 
memo and date.    Click Record.

See Also
Finding, Changing, and Reversing Sales



Finding, Changing, and Reversing Invoices

Erasing an Item Invoice Before It's Recorded
Finding an Item Invoice
Changing or Deleting an Item Invoice
Reversing an Item Invoice
Erasing an Service Invoice Before It's Recorded
Finding an Service Invoice
Changing or Deleting a Service Invoice
Reversing a Service Invoice



Erasing an Item Invoice Before It's Recorded
If, while entering an invoice you need to start over, choose Erase Invoice from the Edit menu.

See Also
Finding, Changing, and Reversing Invoices



Finding an Item Invoice

Select Analyze Receivables from the Sales & Receivables command center.    If the sale you're looking for
has been paid, be sure to check Include $0.00 Balance Sales.

A summary list of your customers is displayed.    Click the arrow to the left of the desired customer.    All 
sales to that customer are displayed.    Click the arrow next to the desired sale.    All transactions relating 
to that sale are displayed.    Click the arrow next to the invoice number and the original sale is displayed. 
(If you're in the middle of entering a new invoice, you're asked to record or erase it before displaying a 
previous invoice.)

See Also
Finding, Changing, and Reversing Invoices



Changing or Deleting an Item Invoice

Note:    The following discussion applies to those users who have chosen to make their data file 
Unchangeable.    If your data file is Changeable, you may change or delete entries at any time.    See 
Customize M.Y.O.B. for a discussion of Changeable versus Unchangeable.

Prior to saving, an invoice may be changed or deleted (choose Delete Invoice from the edit menu).    If 
you have applied payments against the invoice, you must delete the payments prior to deleting the 
invoice.

Once you save your data, you may view it and automatically reverse it, but you may not change or delete 
it.

See Also
Finding, Changing, and Reversing Invoices
Reversing an Item Invoice



Reversing an Item Invoice

Note:    The following discussion applies to those users who have chosen to make their data file 
Unchangeable.    If your data file is Changeable, you may change or delete entries at any time.    See 
Customize M.Y.O.B. for a discussion of Changeable versus Unchangeable.

If you've saved your data, you can no longer change or delete an invoice.    You must either reverse the 
entire invoice or generate a new invoice with negative quantities.

The following includes instructions for:

Returns on an unpaid invoice
Returns on a completely paid invoice
Returns on a partially paid invoice
Item Invoice adjustments

Returns on an Unpaid Invoice.    If the customer returns all the items on an invoice, choose Reverse 
Invoice from the Edit menu.    A new credit invoice is created.    Use Settle Credits to apply the negative 
balance of the credit invoice against the open balance of the original invoice.

If the customer returns just some of the items on an invoice, create a new item invoice with negative 
quantities.    In addition to correcting your inventory, this creates an invoice with a negative balance due.    
This is called a "credit invoice."    Remember to use Settle Credits to apply the balance of the credit 
invoice against the original invoice.    If you don't, the balance due from the original invoice will remain in 
your receivables file.

Example:    You sell 50 widgets, and they are returned the next day.

1. 1.Call up the original invoice and choose Reverse Invoice from the Edit menu.    When 
you record the reversal, a credit invoice is created.

2. 2.Select Settle Credits.    Select the new credit invoice.    Apply the credit amount to the 
original order.    Both the original invoice and the credit invoice are now closed.

Returns on a Completely Paid Invoice.    Follow the instructions for processing a return in the preceding
section.    If the customer has paid the original invoice, use Settle Credits to write a refund check or apply 
the payment to an open receivable.

Example:    You enter a sale for $25 that is paid in full.    The sale is returned the next day.
1. Create a $25 credit invoice (by either reversing the original or creating a new credit 

invoice).
2. Select Settle Credits.    A list of credit sales is displayed.    Choose the $25 credit invoice 

just created.
3.You may:

a. Write a Refund Check.    Verify the payee, check number, memo and date.    Click 
Record.

b. Apply to an Open Invoice.    Enter the $25 next to the desired open invoice and 
press Tab.    Click Record.    

Returns on a Partially Paid Invoice.    Follow the instructions for processing a return.    If the customer 
has made a partial payment of the original invoice, use Settle Credits to write a refund check or apply the 
payment to an open receivable.

Example:    You enter a sale for $100 with $25 paid today.    The sale is returned the next day.
1. Create a $100 credit invoice (by either reversing the original or creating a new credit 

invoice).



2. Select Settle Credits.    A list of credit sales is displayed.    Choose the $100 credit sale 
just created and click 

Apply to Open Invoice.
3. At this point you have three options:

a. Apply $75 of this credit to the open $75 receivable.    Apply the remaining $25 to 
another open receivable.    Click Record.

b. Change the credit amount from $100 to $75.    Enter $75 next to the open invoice 
and press Tab.    Click Record.    (Remember, the customer still has a $25 credit.)

c. Write a refund check.    Reselect Settle Credits.    Select the remaining $25 credit 
and click Write a Refund Check.    Verify the payee, check number, memo and 
date.    Click Record.

Item Invoice Adjustments.    An adjustment is needed when items are not returned, but the price or 
sales tax on the invoice is incorrect.    To process an adjustment, you must write a new invoice.    There 
are two ways to process an adjustment:

1. The method that gives you the best record of the adjustment is to return the item by 
entering a negative quantity with the original price, discount, job, and sales tax 
checkmark.    On the next line re-sell the item by entering a positive quantity with the 
adjusted price, discount, job, or sales tax checkmark.

2. A faster, but less desirable method is to calculate the adjusting amount and write a 
service invoice for it.

If the new invoice has a positive balance due, it becomes a new receivable.    If it has a negative balance 
due, it becomes a credit invoice.    Use Settle Credits to apply the balance of the credit invoice against the 
original invoice.

See Also
Finding, Changing, and Reversing Invoices



Erasing a Service Invoice Before It's Recorded

If, while entering an invoice, you need to start over, choose Erase Invoice from the Edit menu.

See Also
Finding, Changing, and Reversing Invoices



Finding a Service Invoice
Select Analyze Receivables from the Sales & Receivables command center.    If the sale you're looking for
has been paid, be sure to check Include $0.00 Balance Sales.

A summary list of your customers is displayed.    Click the arrow to the left of the desired customer.    All 
sales to that customer are displayed.    Click the arrow next to the desired sale.    All transactions relating 
to that sale are displayed.    Click the arrow next to the invoice number and the original sale is displayed.    
(If you're in the middle of entering a new invoice, you're asked to record or erase it before displaying a 
previous invoice.)

See Also
Finding, Changing, and Reversing Invoices



Changing or Deleting a Service Invoice

Note:    The following discussion applies to those users who have chosen to make their data file 
Unchangeable.    If your data file is Changeable, you may change or delete entries at any time.    See 
Customize M.Y.O.B. for a discussion of Changeable versus Unchangeable.

Prior to saving, an invoice may be changed or deleted (choose Delete Invoice from the edit menu).    If 
you have applied payments against the invoice, you must delete the payments prior to deleting the 
invoice.

Once you save your data, you may view it and automatically reverse it, but you may not change or delete 
it.

See Also
Finding, Changing, and Reversing Invoices
Reversing a Service Invoice



Reversing a Service Invoice

Note:    The following discussion applies to those users who have chosen to make their data file 
Unchangeable.    If your data file is Changeable, you may change or delete entries at any time.    See 
Customize M.Y.O.B. for a discussion of Changeable versus Unchangeable.

If you've saved your data, you can no longer change or delete an invoice.    You must either reverse the 
entire invoice or generate a new invoice with negative amounts.
The following includes instructions for:

Correcting an unpaid invoice
Correcting a completely paid invoice
Correcting a partially paid invoice

Correcting an Unpaid Invoice.    Call up the invoice (see Finding a Service Invoice) and choose Reverse
Invoice from the Edit menu.    A new credit invoice is created.    Use Settle Credits to apply the negative 
balance of the credit invoice against the open balance of the original invoice.

Correcting a Completely Paid Invoice.    Call up the invoice (see Finding a Service Invoice) and choose 
Reverse Invoice from the Edit menu.        A new credit invoice is created.    Use Settle Credits to write a 
refund check or apply the payment to an open receivable.

Example:    You enter a sale for $25 that is paid in full.    The sale is canceled the next day.
1. Reverse the original $25 invoice.
2. Select Settle Credits.    A list of credit sales is displayed.    Choose the $25 credit invoice 

just created.
3. You may:

a. Write a Refund Check.    Verify the payee, check number, memo and date.    Click 
Record.

b. Apply to an Open Invoice.    Enter the $25 next to the desired open invoice and 
press Tab.    Click Record.    

Correcting a Partially Paid Sale.    Call up the invoice (see Finding a Service Invoice) and choose 
Reverse Invoice from the Edit menu.    A new credit invoice is created.    Use Settle Credits to write a 
refund check or apply the payment to an open receivable.

Example:    You enter a sale for $100 with $25 paid today.    The sale is canceled the next day.
1. Reverse the original $100 invoice.
2. Select Settle Credits.    A list of credit sales is displayed.    Choose the $100 credit sale 

just created and click Apply to Open Invoice.
3. At this point you have three options:

a. Apply $75 of this credit to the open $75 receivable.    Apply the remaining $25 to 
another open receivable.    Click Record.

b. Change the credit amount from $100 to $75.    Enter $75 next to the open invoice 
and press Tab.    Click Record. (Remember, the customer still has a $25 credit.)

c. Change the credit amount from $100 to $75.    Reselect Settle Credits.    Select 
the remaining $25 credit and click Write a Refund Check.    Verify the payee, 
check number, memo and date.    Click Record.

See Also
Finding, Changing, and Reversing Invoices



Finding a Pending Invoice

Select Invoice Sales and enter a customer.    A dialog listing all pending invoices for this customer will 
appear.    Select the desired invoice.

See Also
Finding, Changing, and Reversing Invoices



Changing or Deleting a Pending Invoice

There are two type of pending invoices: those without deposits and those with deposits.

Pending Invoices Without Deposits.    Since a pending invoice without a deposit does not create a cash
or inventory transaction, you may change or delete it at any time. Once it is displayed, delete it by 
choosing Delete Pending Sale from the Edit menu.    Or change it and then put it back by clicking Pending
File.

Pending Sales With Deposits.    A pending invoice with a deposit may not be deleted unless the deposit 
is deleted.    Once you save your data, you cannot delete the deposit.

To remove a pending invoice with an "undeletable" deposit, you must erase the detail of the invoice 
(change all quantities to zero or change the type of invoice) and record it as an actual sale.    This creates 
an invoice with a negative balance due, also known as a credit invoice.    Use Settle Credits to apply the 
credit to an open receivable.

Note:    When you record a pending invoice with a deposit as an actual sale, M.Y.O.B. Accounting moves 
the money from your deposits accounts to your linked receivables account.    Your linked deposits account
is reduced (debited) by the amount of the deposit and the linked receivables account is credited.    

See Also
Finding, Changing, and Reversing Invoices



Finding, Deleting, & Reversing Customer Payments

Erasing a Customer Payment Before It's Recorded
Finding a Customer Payment
Reversing a Customer Payment
Changing or Deleting a Customer Payment



Erasing a Customer Payment Before It's Recorded
If, while entering a transaction, you need to start over, choose Erase Payment from the Edit menu.

See Also
Finding, Deleting, & Reversing Customer Payments



Finding a Customer Payment

From the Inquiry menu, choose Search by Card.    Select the desired customer.    All transactions for the 
selected customer (within the specified date range) are displayed.    Any payments made were recorded in
the Cash Receipts journal, so "CR" is noted under source journal. Locate the payment and click the arrow
to its left.    The original payment is displayed.      (If you're in the middle of applying a payment, you're 
asked to record or erase it before displaying a previous transaction.)

See Also
Finding, Deleting, & Reversing Customer Payments



Changing or Deleting a Customer Payment

Note:    The following discussion applies to those users who have chosen to make their data file 
Unchangeable.    If your data file is Changeable, you may change or delete entries at any time.    See 
Customize M.Y.O.B. for a discussion of Changeable versus Unchangeable.

Prior to saving, a payment may be deleted.    Choose Delete Payment from the Edit menu.    Once you 
save your data, you may no longer delete a payment.    You may only reverse it.    See Reversing a 
Customer Payment.

See Also
Finding, Deleting, & Reversing Customer Payments



Reversing a Customer Payment

Note:    The following discussion applies to those users who have chosen to make their data file 
Unchangeable.    If your data file is Changeable, you may change or delete entries at any time.    See 
Customize M.Y.O.B. for a discussion of Changeable versus Unchangeable.

Follow the directions in Finding a Customer Payment.

To reverse a Customer Payment, choose Reverse Payment from the Edit menu, review the ID number 
and date, and click OK.    Your checkbook balance is decreased and the payment is "unapplied."    That is,
the open invoice is recreated.

Note:    You may not change the accounts and amounts in a reversing transaction.    

Note:    Be aware of the recording date of a reversing transaction.    If you use the current date when you 
reverse a transaction from a prior month, the month-end financials for the prior month will not reflect the 
reversing transaction.    If you use the original date for the reversing transaction, your prior month 
financials should be reprinted.

Note:    Be aware that if a discount for early payment was given for a payment you are reversing you will 
have to reverse the discount.    M.Y.O.B. Accounting will alert you to this via a dialog box.    The original 
discount transaction is in the Sales Journal.    Find it and click the arrow to its left.      When the discount 
transaction is displayed, reverse it.

See Also
Finding, Deleting, & Reversing Customer Payments



Finding, Deleting, & Reversing Credits

Finding an Applied Credit Transaction
Deleting an Applied Credit
Reversing an Applied Credit
Erasing a Refund Check Before It's Recorded
Finding a Refund Check
Changing or Deleting a Refund Check
Reversing a Refund Check



Erasing a Credit Before It's Recorded

If, while entering a transaction, you need to start over, choose Erase Credit from the Edit menu.

See Also
Finding, Deleting, & Reversing Credits



Finding an Applied Credit Transaction

An applied credit is recorded in the Sales & Receivables Journal.    When you settle a credit invoice by 
applying it against an open invoice (the most common situation), the cash transaction contains two entries
to your linked receivables account.    The first is a debit to receivables which settles the credit invoice.    
The second entry is a credit to receivables which reduces the balance due of the applied invoice.

Click the Sales & Receivables Journal Icon in the Sales & Receivables command center to zoom to the 
Sales & Receivables Journal display.

The date range defaults to the current month.    All Sales & Receivables Journal transactions between 
(and including) the From and To dates are displayed.    Every transaction has a small arrow to its left.    
Click the arrow to display the transaction.    (If you're in the middle of applying a credit, you're asked to 
record or erase it before displaying a previous transaction.)

See Also
Finding, Deleting, & Reversing Credits



Deleting an Applied Credit

Note:    The following discussion applies to those users who have chosen to make their data file 
Unchangeable.    If your data file is Changeable, you may change or delete entries at any time.    See 
Customize M.Y.O.B. for a discussion of Changeable versus Unchangeable.

Prior to saving, an applied credit may be deleted.    Choose Delete Credit from the Edit menu.    Once you 
save your data, you may no longer delete an applied credit.    You may only reverse it.

See Also
Finding, Deleting, & Reversing Credits
Reversing an Applied Credit



Reversing an Applied Credit

Note:    The following discussion applies to those users who have chosen to make their data file 
Unchangeable.    If your data file is Changeable, you may change or delete entries at any time.    See 
Customize M.Y.O.B. for a discussion of Changeable versus Unchangeable.

Follow the directions in Finding an Applied Credit Transaction.    To reverse an applied credit, choose 
Reverse Credit from the Edit menu, review the ID number and date, and click Record.    The credit is 
"unapplied."    That is, the credit invoice is recreated and the balance due of the applied invoice is 
increased. 

Note:    You may not change the accounts and amounts in a reversing transaction.    

Note:    Be aware of the recording date of a reversing transaction.    If you use the current date when you 
reverse a transaction from a prior month, the month-end financials for the prior month will not reflect the 
reversing transaction.    If you use the original date for the reversing transaction, your prior month 
financials should be reprinted.

See Also
Finding, Deleting, & Reversing Credits



Erasing a Refund Check Before It's Recorded

If, while entering a transaction, you need to start over, choose Erase Credit from the Edit menu.

See Also
Finding, Deleting, & Reversing Credits



Finding a Refund Check - Credit

Click the Cash Disbursements journal icon in the Checkbook command center to zoom to the Cash 
Disbursements display.    This shows all entries - for all cash accounts - in the Cash Disbursements 
journal. 

The date range defaults to the current month.    All transactions between (and including) the From and To 
dates are displayed.    All check transactions have a small arrow to their left.    A refund check is a debit to 
your linked receivables account, balanced by a credit to your checking account. 

Click the arrow to display the refund check transaction.    (If you're in the middle of writing a refund check, 
you're asked to record or erase it before displaying a previous transaction.)

See Also
Finding, Deleting, & Reversing Credits



Changing or Deleting a Refund Check - Credit

Note:    The following discussion applies to those users who have chosen to make their data file 
Unchangeable.    If your data file is Changeable, you may change or delete entries at any time.    See 
Customize M.Y.O.B. for a discussion of Changeable versus Unchangeable.

Prior to saving, a refund check may be deleted.    Choose Delete Credit from the Edit menu.    Once you 
save your data, you may no longer delete a refund check.    You may only reverse it

See Also
Finding, Deleting, & Reversing Credits
Reversing a Refund Check.



Reversing a Refund Check - Credit

Note:    The following discussion applies to those users who have chosen to make their data file 
Unchangeable.    If your data file is Changeable, you may change or delete entries at any time.    See 
Customize M.Y.O.B. for a discussion of Changeable versus Unchangeable.

Follow the directions in Finding a Refund Check.

To reverse a refund check, choose Reverse Credit from the Edit menu, review the ID number and date, 
and click Record.    Your checkbook balance is increased and the credit is "unapplied."    That is, the credit
invoice is recreated.

Note:    When you reverse a refund check, the reversing entry is not a check and does not show up when 
you print checks. 

Note:    You may not change the accounts and amounts in a reversing transaction.    

Note:    Be aware of the recording date of a reversing transaction.    If you use the current date when you 
reverse a transaction from a prior month, the month-end financials for the prior month will not reflect the 
reversing transaction.    If you use the original date for the reversing transaction, your prior month 
financials should be reprinted.

See Also
Finding, Deleting, & Reversing Credits



Invoice Comments

Field Name
Description of field.



Shipping Methods

Field Name
Description of field.




